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2 Version Highlights 

Version 3.20R04 brings a range of new and updated features together with 17 

new devices and 4 updated devices. 

Feature / Improvements Description 

Editing  

 Select Range of Parameter 

Addresses 

You can now select DMX addresses for selected 

parameters by using 

[FIXTURE, #, Parameter selection, DIM]. 

 Spot key for Channel Wing The key SPOT was added to the Channel Wing 

 Toggle functions in Effect Engine On Violet consoles it is now available to toggle 
between the wheels function with a press on 
the wheel. 

Playback  

 Input patch to Q-Key Input patch to Q-Key is now available 

 Group Deselect Fixtures can now be deselected by pressing on 

an assigned PB key or Q-Key. 

System Settings  

 Choose Subnet for Artnet The option to select Subnet for Artnet protocol 
is back with the choice whether to use it or not. 

 Controlling Network from Editor 

Toolbar 

Network settings can now be controlled from 
the Editor Toolbar without the need to open the 

settings dialog. 

 Japanese language support The Japanese language was added to the 
language pack. 
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3 Bug Fixes V3.20R04 

 Reduced sync time for Master-Slave and Master-Node connections. Reported 

by Steven Plotkin (Canada). 

 Master-Slave and Master-Node reliability has been improved. Reported by 

Steven Plotkin (Canada). 

 "Editor Toolbar" and "Wheels Assignments" views could not be assigned with 

BOLD font (Ronen Ben Harosh, Israel). 

 Fixtures on TOPO did not update their text after [FIXTURE, #, TEXT] (Jerry 

Roberto Romani, Italy). 

 Loading a layout with TOPO from previous version caused CRASH (Norbert 

Pobiegly, Poland). 

 Loading a show from previous version with empty TOPO created TOPO 

number 0. 

 ACN & ArtNet indicators were not showing whether these protocols are ON 

or OFF (Steven Plotkin, Canada). 

 Playback keys definition list was bigger than screen (Ronen Ben Harosh, 

Israel). 

 Loading a show that was made prior to 3.20.R02 was enabling port #17 on 

VCs (Steven Plotkin, Canada). 

 Import TOPO in partial load was not possible (Steven Plotkin, Canada). 

 Vector Violet did not transmit output after warm data unless applying a 

change on settings (Brad Wagg, Canada and Jaime Marcos, Spain). 

 Warm data did not load Matrix and TOPO if they were both in the same show 

(Steven Plotkin, Canada). 

 Master-Slave, editor values was fade off when Master disconnected (Andy 

Stone, England). 

 Master-Slave\Master-Node is not syncing in random cases. Sometimes it 

does and sometimes it doesn’t (Steven Plotkin, Canada). 

 Green Vector was outputting ArtNet only on port #1 (David Bishop, 

England). 

 European value input did not take effect on Channel Wing (Andy Stone, 

England). 

 When there was a connection of Master-Slave\Master-Node and a wing was 

attached to the Slave or the Node and the wing was not on the same page 

as the Slave or the Node then there was a delay on the wing (Steven 

Plotkin, Canada). 
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 Master-Slave\Master-Node was sometimes disconnecting during the transfer 

of patch changes and this caused the data not to be transferred completely 

(Brad Wagg, Canada). 

 Master-Node was sometimes delaying fader movements when Master and 

Node were not on the same page (Ronen Ben Harosh, Israel). 

 Master-Slave\Master-Node were disconnecting after 10-15 minutes when not 

touching the consoles (Filip Weisner, Czech Republic). 

 Layout was not saved when closing the Vector PC from the "X" button. 

Reported by Moshiko Peer (Israel). 

 GC Crashed when added irrelevant headers to the Macro Editing view. 

Reported by Tomer Shoshan (Israel). 

 Wrong password on Protect showed a wrong message. Reported by Matthias 

Schoffmann (Austria). 

 If a range of fixtures with a gap were dragged into the TOPO then some of 

them did not load. Reported by Tomer Shoshan (Israel). 

 PARK did not save the right value when selecting the value from a picker. 

Reported by Moshiko Peer (Israel). 
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4 Text Conventions 

The following text conventions exist in this document: 

 The actual keys on the console panel are referred to as KEYS. Panel KEYS 

are in BOLD CAPS. 

 The keys on the touch screens are referred to as BUTTONS. Touch screen 

BUTTONS are BOLD ITALICIZED CAPS. 

 Dialog boxes, Window titles and field names appear in this font. 

 Sequences appear like this; [SEQUENCE, SEQUENCE]. 

 The word “Click” also refers to “tap”. This depends if you are using the 

mouse to “click” or “tapping” on the touch screen. 
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5 Select Range of Parameter Addresses 

By using the key DIM after a parameter selection, the addresses of the selected 

parameters will be selected and shown on the echo line. 

Example of selecting parameter addresses 

Patched are 10 spots that have 5 parameters: 

Dimmer, Pan, Tilt, Color wheel and Shutter (by this order). 

In order to change these 10 fixtures' Shutter curve we will select the addresses 

of the Shutter parameter and then proceed with the dimmer manipulation. 

So the sequence [SPOT, 1  10, SHUTTER, DIM] will result in showing on the 

echo line "DIMMER 5+10+15+20+25" and then we can proceed to changing the 

curve. 
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6 Spot key for Channel Wing 

On the Channel Wing remote panel there was an empty key beside the 

CHANNEL key. In order to be the same as on the consoles panels the SPOT 

key was added to the same location as on a regular panel and it is now 

supported via the Channel wing. 

 

 

The new SPOT key  
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7 Toggle functions in Effect Engine 

Note: This feature is for Vector Violet only. 

By using the encoder wheels press option it is possible to toggle between the 

options in the effects engine. 

Example 

After opening the effect dialog we get this situation on the wheels:  

 

By pressing the most left wheel for the first time we will get the Offset all 

selected: 

 

By pressing the most left wheel again we will get the Offset fan selected: 

 

 

The second wheel will control the Size, the third will control the Rate and the 

fourth will control the Duty Cycle. 
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8 Input patch to Q-Key 

It is now possible to patch an input dimmer to a Q-Key under the same 

conditions as the input patch for PB. 

Terms 

1. The input value will control the "Intensity limit" of the Q-Key. 

2. When the input value is reaching 0, the behavior will be according to the 

"Release on bottom" of this Q-Key. 

3. When the input value is exiting the 0, the behavior will be according to the 

"Intensity behavior" combo box (Intensity only, Go+Jump parameters, 

Go+Fade parameters). 

 

To patch Q-Key input 

1. Press DIM. 

2. Select the DMX address. A range can also be selected. 

3. Tap INPUT PATCH TO. 

4. Press the Select key of the desired Q-Key. 

5. Press STORE. 
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9 Group Deselect 

Fixtures can now be deselected by pressing on an assigned PB key or Q-Key. A 

key can be assigned as a Group Deselect key. Content can be deselected 

whether the PB fader is active or not. 

Group Deselect will deselect all content (Channels, Spots, etc.) on a cue or 

temp cue. 

In order to use Group Deselect; Cues, Temp cues etc. should be first created on 

a PB or a Q-Key.  

 

Example of Group Deselect 

PB 1 is a Sub-master for Channels 15. 

PB 2 is a Sub-master for Channels 610. 

Both PBs middle key functions are Group Deselect. 

Channels 110 are now selected: 
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Now if we press the middle key of PB 1 then Channels 15 will be removed 

from the selection: 

 

 

Assigning Group Deselect to a Key 

Assigning Group Deselect to a PB key or Q-Key is done from the PB Key 

behavior list. The behavior list can be accessed by selecting a PB key or Q-Key 

from the Settings ► Playback tab or the Playback Definitions tab in Qlist Properties. 

The key text will change according to the function selected. 

Group Deselect can be assigned only to a PB key on-the-fly from the Qlist 

properties in which case the text GrpDsl will be displayed in the PB wing. 

Assigning it from the System Settings will only apply to new assignments. 

 

Group Deselect in the PB Keys 
Behavior list  

Example of an assigned 
PB Key  

Example of GrpSel and 
GrpRel  text in the PB wing 

 

 

 

GrpDsl = Group Deselect 

 

Group deselect function 

is assigned  
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To assign Group Deselect from System Settings 

1. From the Menu bar select Tools ► Settings ► Playback tab. 

2. Select the Default PB Definitions option: 

 

The PB Key options will become active. 

3. Select a PB key to assign. 

 

 

 

4. From the PB Keys Behavior list select Group Deselect. 

The new function will be applied to the key and the text name will change. 

5. Click Apply to save the change. 

Select a PB key or 

Q-Key to assign 

Group Deselect. 
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To assign Group Deselect from Qlist Properties 

1. Press [SETUP, PB SELECT#]. 

The Qlist Properties dialog will open. 

2. Select the Playback Definitions tab: 

 

3. Select a PB key to assign. 

4. From the PB Key behaviour list select Group Deselect. 

The new function will be applied to the key and the text name will change. 

5. Click OK to close the Qlist Properties dialog. 

 

Select a PB key to assign 

Group Deselect. 
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10 Choose Subnet for Artnet 

On the previous version the option to select a Subnet to the Artnet output has 

been removed. According to requests from some users the option is back and 

with it the option whether to use it or not. 

On the previous version when selecting for example AN #3, the Vector 

automatically translated the value into Subnet 0 and Universe 3 (universe 3 on 

Artnet is actually 4 because Artnet count starts from 0), on the Artnet protocol 

without the need to enter the subnet manually. 

Same happened when user chose AN #18. The vector translated it to Subnet 1 

and Universe 2, again without the user need to calculate. 

Now there is a new button named "Use subnet". This button tells if to use the 

user input of the subnet or auto calculate the subnet. 

If this button is disabled then everything will work the same as in version 

3.20.R03. 

If this button is enabled then the Vector will add the subnet value to the auto-

calculated subnet number according to the selected universe. 

Example for using subnet 

Port 1 is configured to output Artnet on AN #0. This means that the Vector will 

automatically understand that it should be transmitted to Subnet 0 and 

Universe 0. 

Option 1 

If the option is enabled and the Subnet entered is 0 then there will be no 

change since in the auto calculation the result was 0 and the number entered is 

0 then 0+0=0. 

Option 2 

If the option is enabled and the Subnet entered is 1 then the output will go to 

Subnet 1 and universe 0 since in the auto calculation the result for the subnet 

was 0 but the entered value is 1 then 0+1=1. 
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To Change the Use Subnet settings 

1. From the Manu bar click on Tools ► Settings. 

The System Settings dialog opens. 

2. Click on the DMX Protocols tab: 

  

3. Activate one of the Artnet universes: 

 

The ArtNet and the Use Subnet buttons will now be clickable. 

4. Change the Artnet and the Use Subnet to be enabled and write your desired 

subnet value: 
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11 Controlling Network from Editor 

Toolbar 

A new "Network" Soft Key option has been added to the Setup Toolbar. 

This is accessed by pressing the SETUP key on the actual panel. 

 

By pressing the NETWORK soft key a new Network toolbar will be opened. 

This toolbar is a reflection of the actual Network tab in the system settings 

dialog. If an option is already ON then the color of the button will be orange. 

 

 

Tip! You can create a Macro to trigger the options in the NETWORK 

toolbar. 

 

The NETWORK new buttons 

The following is a list of the new NETWORK buttons with their functions: 

Button Settings button Function 

Slave of # Slave Toggles the option of Slave. The 

Master console ID is the number written 

in the button. This number can be 

changed only via the System settings 

dialog in the "Master Console ID" field. 

Node of # Node Toggles the option of Node. The Master 

console ID is the number written in the 

button. This number can be changed 

only via the System settings dialog in 

the "Master Console ID" field. 

Remote Apps Remote Control Application's Toggles the option of Remote apps. 
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Using the Network Toolbar 

1. Press SETUP. 

2. Tap the NETWORK soft key on the Editor Toolbar. 

3. Toggle the desired option. For example tap on the Remote Apps soft key. 

4. Press STORE. 

Your change is saved if the echo line is showing "Assigned". 
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12 Japanese language support 

In addition to the supported languages: German, Spanish, Hebrew and Chinese, 

the Japanese language was added to the Vector language support. 

Language changes will be applied to the Menu bar, drop down menus, dialogs, 

title bars and warning messages. 

Japanese language installation 

A Japanese language patch needs to be installed in order to view Japanese on 

the Vector console. The Patch can be found in a folder called “Japanese” located 

in the Updates folder in the Compulite program files. 

To install Japanese language patch 

1. Navigate to the Updates ► Japanese folder: 

Vector Console–D:\Program files\Compulite Vector\Config\Updates\Japanese 

Vector PC – C:\Program files\Compulite\Vector PC\Config\Updates\Japanese 

2. Click on the Japanese Folder 

3. Double click on the file JAPANRC.BAT. 

4. A Black Screen will pop up for a second. Once the screen will disappear it 

means that the installation was completed. 

5. Once the Japanese language patch has been installed, navigate to Regional 

and Language Options in the Control Panel. See Changing Language 

6. From the Advanced tab click in the drop down language menu and change 

the language to Japanese. 

7. Reboot the system  

8. After Rebooting the System, start the Vector Software and Select Japanese 

language; Help ► Languages ► Japanese. 

 

Changing Language 

The Windows OS language needs to be changed first in order for the console to 

display a selected language other than English. Windows language is changed 

from the Control Panel. 

To change Windows language 

1. From the Windows Start menu select Control Panel. 

2. From the Control Panel double click on Regional and Language Options. 
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The Regional and Language Options dialog opens: 

 

3. Select the Advanced tab and then click on the language drop down menu 

under Language for non-Unicode programs. 

 

4. From the drop down menu select the required language. 

5. Click Apply. 

6. If a warning message appears click Yes or OK. 

7. Click Yes to restart your computer. 
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To change vector language 

1. From the Vector menu bar click on Help ► Language. 

2. Select the desired language. 

 

3. Note the following: 

 If you are changing the language on a Vector PC you will be prompted 

with a warning message and required to restart Vector. 

 

Click OK to verify the language change. Vector will shut down.  

 If you are changing the language on a Vector console you will not be 

prompted with a warning message and Vector will automatically shut 

down. 

 In both the above cases, Vector will need to be started 

manually after shutdown. 
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Troubleshooting Language Change 

If you have changed the Language on Vector and now have question marks 

(???) in place of text, it means that the required language has not been 

selected in the Regional and Language Options in the Windows Control Panel. 

See: Changing Language 
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2 Version Highlights 

Version 3.20R03 brings a range of new and updated features together with 49 

new devices and 14 updated devices. 

Feature / Improvements Description 

Display  

 PB Live View Enhancements The Fader/Level can now be separated into two 
fields. 

 Block Cue Enhancement A new option called Block Cue Indication has 
been added which enables you to easily view 

blocked cues in the Cue sheet. 

Editing  

 Toggle Bank Keys Layout You can now toggle the layout between the 
wheel bank group of keys and the group of 
keys under the Dimmer Wheel. 

 Shift Selection Selected fixtures can be shifted forwards or 
backwards by using [SHIFT+NEXT or PREV]. 

 Change Beat Key to Next Key The BEAT key can now be used to function as 
the NEXT key. 

 Delete External Parameters Patch An external parameter patch can now be 
deleted separately from a Fixtures Patch. 

 New Parameter Fade Profiles 3 new parameter fade profiles were added to 
profile options on the Editor Tool bar in Vector. 

 Topo Feature Improvements More than one Topo can now be created. 

 Topo Enhancements 6 new enhancements were added to Topo. 

 Macro Editing Previously recorded Macros can now be edited 
and new macros can be created offline. 

Playback  

 Freeze All Freeze All is a new playback control feature 

that enables you to instantly freeze running 
effects or chasers on a fader. 

System Settings  

 DMX Protocols Enhancements You are now able to define which Ethernet 
Protocol Port Address you want to send a 

Universe Port to. 
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Pandora’s Box Integration 

 
Vector is now fully compatible with Coolux Pandora Box media server. 

See: Pandora’s Box Integration 
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3 Bug Fixes V3.20R03 

 A show layout that was saved with soft keys on a certain page did not load 

correctly. Reported by Greg Shipley (US). 

 An external parameter patch from the Patch Manager was not stored. 

Reported by Orit Freedman (Holland/Netherlands). 

 There was a delay on the live view when Active on Stage was activated. 

Reported by Steven Plotkin (US), Pawel Jarzabek (Poland) and Alon Cohen 

(Israel). 

 Interactive selection was incorrect when Active on Stage was activated. 

Reported by Pawel Jarzabek (Poland). 

 Changing from Slave to Node and vice versa caused syncing errors. 

 When not downloading thumbs the File/Folder picker did not open. Reported 

by Norbert Pobiegly (Poland). 

 Import device caused a warning message in some languages. Reported by 

Isias Garcia (Spain). 

 Starting a New Show caused a blank message pop up in some languages. 

Reported by Ernst Taubinger (Austria). 

 The View Properties dialog was incomplete in some languages. Reported by 

Matthias Schoffmann (Austria). 

 Removing and re-attaching fixtures to stage elements in TOPO caused a 

crash. 

 Virtual dimmer did not affect all color layers if there was more than 1 layer. 

Reported by Alon Cohen (Israel). 

 Fixture text did not work in Enter mode. Reported by Steven Plotkin (US). 

 All sub master values dropped to zero during Patch changes. Reported by 

Tomer Shushan (Israel). 

 The Shift button on the PC Wing did not affect the Macro button LED’s. 

Reported by Moshiko Peer (Israel). 

 An absolute dimmer value above 512 could not be entered. Reported by 

Meirson (Israel). 

 Re-selection did not work after Storing/Updating records. Reported by Ronen 

Ben Harosh (Israel). 

 User Defined dimmer curves did not load correctly from warm data. 

Reported by Gerhard Fiener (Germany). 

 The Grand Master LED had syncing problems with the PC Wing. Reported by 

Matthias Schoffmann (Austria). 



Vector Release Notes 3.20R03  

7 | 
 

 Deleting a link between cues caused a system delay. Reported by Alon 

Cohen (Israel). 

 Qkey mode on the Master node between 2 Violets did not separate the 

playbacks. Reported by Tomer Shushan (Israel). 

 Fade out cue faded in cut time when first using the X-Fader. Reported by 

Pawel Jarzabek (Poland). 

 A Block cue recorded all values on all patched fixtures. Reported by Matthias 

kern (Switzerland). 

 Fade profiles was not applied to all system times, such as; Editor Fade in 

time, Editor Fade out time, Library time etc. Reported Shay Bonder (Israel). 

 Next/Prev did not function after storing a group. Reported by Matthias 

Scoffmann (Austria). 

 Reset rate did not move the fader to its actual position if the fader behavior 

was Rate Master. Reported by Matthias Schoffmann (Austria). 

 Look ahead did not function correctly when the dimmer level was set at 1%. 

Reported by Pawel Jarzabek (Poland). 

 The Flash button of joined playbacks did not work correctly after the system 

was booted from warm data. Reported by Ei Osawa (Japan). 

 The Editor Toolbar did not show data of more than 1 row. 
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4 Text Conventions 

The following text conventions exist in this document: 

 The actual keys on the console panel are referred to as KEYS. Panel KEYS 

are in BOLD CAPS. 

 The keys on the touch screens are referred to as BUTTONS. Touch screen 

BUTTONS are BOLD ITALICIZED CAPS. 

 Dialog boxes, Window titles and field names appear in this font. 

 Sequences appear like this; [SEQUENCE, SEQUENCE]. 

 The word “Click” also refers to “tap”. This depends if you are using the 

mouse to “click” or “tapping” on the touch screen. 
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5 Toggle Bank Keys Layout 

Note: This feature is for Vector Violet only.  

By using the RT window you can now toggle the layout between the wheel bank 

group of keys and the group of keys under the Dimmer Wheel. Once you have 

toggled the layout, the wheel bank group of keys will replace the bottom group 

and visa-versa: 

 

 

To toggle layout 

1. From the Windows Task bar double click on the RT icon : 

 

The Vector RT window opens: 

 

The wheel bank group of keys can be 

toggled with the bottom group keys and 

visa-versa. 
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2. From the RT window click on the Toggle Layout button: 

 

Confirmation of the layout change can be seen by an LED change of the 

active key on the console. Example; the INTENSITY LED will now move to 

the LOLIGHT/HILIGHT key –OR- if the POSITION key is active, the LED 

will move to the FAN key etc. 
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6 Freeze All 

Freeze All is a new playback control feature that enables you to instantly freeze 

running effects or chasers on a fader. Freeze All can be assigned to either a PB 

key or Q-key. 

Note: Freeze All only works with effects and chasers. 

Assigning Freeze All to a Key 

Assigning Freeze All to a PB key or Q-Key is done by selecting the option from 

the PB Keys Behavior list. The behavior list is accessed by selecting a PB key 

from the Settings ► Playback tab or the Playback Definitions tab in Qlist properties. 

The PB key text will change to Freeze All once assigned. 

Freeze All can be assigned on-the-fly only via the Qlist properties, in which case 

the text FrzAll will appear in the PB wing view. Assigning Freeze All via the 

System Settings will only be applied to new assignments. 

 

Freeze All in the PB Keys 
Behavior list 

Example of a PB 
Key assigned to 
Freeze All 

Example of FrzAll text on 
the PB wing 
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To assign Freeze All from System Settings 

1. From the Menu bar select Tools ► Settings ► Playback tab. 

2. Select the DEFAULT PB DEFINITIONS option to activate the PB key options: 

 

The PB key options become active. 

3. Select a PB key to assign Freeze All: 

 

4. From the PB keys behavior list select Freeze All. 

Freeze All is now assigned and the selected key option text changes to Freeze 

All. 

5. Click Apply to save the change. 

Select a PB fader key or Q-Key to 

assign Freeze All. 
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To assign Freeze All from the Qlist Properties 

1. Press [SETUP, PB SELECT#]. 

The Qlist Properties dialog opens. 

2. Select the Playback Definitions tab: 

 

3. Select a playback key to assign Freeze All. 

4. From the Playback key behavior list select Freeze All. 

Freeze All is now assigned and the selected key option text changes to Freeze 

All. 

5. Click OK to apply the change and close the Qlist Properties dialog. 

 

 

 

 

 

 

Select a PB fader key to assign 

Freeze All. 
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7 Shift Selection 

By using [SHIFT+NEXT or PREV], selected fixtures can be shifted forwards or 

backwards according to the selection sequence. 

Examples of Using [SHIFT+NEXT] 

Example 1 

If Channels 1 ►3 are selected: 

 

By using [SHIFT+NEXT] will move the selection forward to Channels 4 ►6: 

 

Example 2  

If Channels 1, 3 and 5 are selected: 

 

By using [SHIFT+NEXT] will move the selection forward to Channels 2, 4 and 6: 
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Examples of Using [SHIFT+PREV] 

Example 1 

If Channels 8, 9 and 10 are selected: 

 

By using [SHIFT+PREV], the selection will move backwards to Channels 5, 6 and 

7: 

 

Example 2 

If Channels 5, 7 and 9 are selected: 

 

By using [SHIFT+PREV], the selection will move backwards to Channels 4, 6 and 

8: 
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8 Change Beat Key to Next Key 

The BEAT key can now be used to function as the NEXT key.  

By using a simple 4 digit code, you can change the BEAT key to function in the 

exact same way as the NEXT key.  

This option is available on all Vector consoles.  

To Change BEAT Key to NEXT Key 

1. On the console press and hold SHIFT. 

2. While holding down SHIFT, key in the numbers 1111. 

3. Release the SHIFT key and press ENTER. 

To Change Back to BEAT Key 

Repeat the sequence above to revert back to the BEAT key. 
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9 Delete External Parameters Patch 

An external parameter patch can now be deleted separately from a Fixtures 

Patch by using the External Parameter soft key from the editor toolbar. 

Before deleting external patch: 

 

After deleting external patch: 

 

To Delete External Patch 

1. Select Fixture and Fixture number. 

[CHANNEL / SPOT, #] 

2. Press [DIM]. 

3. From the Editor Toolbar select the External Parameter soft key: 

 

The Command line displays the text “External Parameter” 

4. Press [DELETE]. 

The Clear Dimmer Patch dialog box appears: 

External parameter patch  

External parameter patch 

deleted 
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5. Select Delete to clear the patch. 

After the Patch is deleted the Command line displays the text “Released”: 

 

ATTENTION! There is NO UNDO for External Patch delete. 
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10 DMX Protocols Enhancements 

You are now able to define which Ethernet Protocol Port Address you want to 

send a Universe Port to. Each Ethernet Protocol now has a drop down menu for 

easy selection. An Auto Config and Clear All button has been added to each 

Ethernet Protocol.  

Auto Config will automatically configure an Ethernet Protocol range according to 

the Max number of ports available. 

Clear All will clear an Ethernet Protocol range to None. 

 

 

 

 

 

 

 

Universe Ports 

Ethernet Protocols 

Drop down menu with 

Ethernet Protocol Port 

Addresses 

New Auto Config and 

Clear All buttons 
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Limitations 

The following limitations exist when using the DMX Protocol enhancements: 

 Two Universe Ports cannot be sent to the same Ethernet Protocol Port 

Address. Doing so will produce an error message. 

For example: Universe Port 1 and 2 are both being sent to VC#1. 

 

Once the settings have been applied the following error message will 

appear: 

 

 The maximum number of Universe Ports that can be sent to Art-Net and/or 

ACN depends on the Max Universe Ports number. Any Universe Port can be 

used as long as it in the Max ports range.  

The Max Universe Port number is located on the bottom right hand side of 

the DMX Protocol dialog: 

 

If the number of Universe Ports used exceeds the Max Universe Port 

number, an error message will appear: 

 

Port 1 and 2 are sent to 

VC1 
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Example: 

Your Max Universe Ports is 1, with Universe Port 1 being sent to Art-Net 

Ethernet Protocol Port 1 and ACN Ethernet Protocol Port 2: 

 

 

If you try and send another Universe Port to another Ethernet Protocol Port; 

For example, Universe Port 2 to Art-Net AN#1 an error message will 

immediately be displayed: 

 

 

 

 

 

 

 

Max Universe Ports is 1. 

Universe Port 1 is being 

sent to AN#1 and ACN#2 
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To Define an Ethernet Protocol to a Universe Port 

1. From the Menu bar click on Tools ► Settings. 

The System Settings dialog opens. 

2. Click on the DMX Protocols tab: 

 

3. Select an Ethernet Protocol according to the Universe Port that is being 

used. From the drop down menu select the Ethernet Protocol Port address: 

 

4. Activate the Ethernet Protocol that has been selected in the step above by 

clicking on the correct DMX-On-Ethernet button: 

  

5. Click Apply then click OK. 
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11 PB Live View Enhancements 

The Fader/Level field on the PB live view can now be separated into two fields; 

Fader Level and Fader Behavior: 

 Fader Level displays the fader level output in percentage. 

 Fader Behavior displays the behavior of the fader as set in Playback 

Definitions, for example; Intensity Master, Rate Master Etc.  

Separating the fields is done in the Grid Properties dialog via View Properties. 

 

Fader/Level Combined Fader/Level Fields Separated 

  

 

To Separate Fader/Level Fields 

1. Click on the View Properties icon on the grid view title bar: 

 

-OR- 

Right click and select View Properties. 

-OR- 

From the Menu bar click View and select View Properties. 

The Grid Properties dialog appears: 
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2. From the Grid Properties dialog select Fader/Level from the right hand side 

fields box and click Remove: 

 

Fader/Level is now moved to the Available fields’ box on the left hand side. 

3. From the Available fields box click on either Fader Level or Fader Behavior and 

click Add: 
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The added field now shows in the right hand side field’s box: 

 

4. Click Apply then click OK to close the Grid Properties dialog. 
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12 New Parameter Fade Profiles 

3 new parameter fade profiles were added to Profile Options on the Editor Tool 

bar in Vector. The new fade profiles can also be applied via device builder. 

The New Fade Profile Options in Vector 

The following are the new fade profile option buttons: 

 

The New Fade Profile Options in Device Builder 

The following are the new fade profile options in the Profile drop down menu in 

Device Builder: 

 

The New Fade Profile Descriptions 

The following are the 3 new fade profiles graphs and there descriptions: 

Profile What happens on the fade 

Smooth Start 

 

On go, the parameter will fade slowly and end linear. 

Smooth End 

 

On go, the parameter will start linear and fade slowly. 

Smooth 

 

On go, the parameter will start slowly to linear and fade slowly 
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13 Topo Feature Improvements 

More than one Topo can now be created. Topo’s are created in the Patch 

Manager using the Create icon located on the Patch Tool bar. 

 

 

 

All created Topo’s will now be visible in the Workspace Tree under the heading 

Topo List and the Patch Topo List window: 

 

NOTE THE FOLLOWING: 

The Topo Tab from the System Settings dialog has been removed. This is due to 

the fact that more than one Topo can be now created. Each time a Topo is 

added from the Patch Manager, you will be presented with an Add Topo dialog.  

The Add Topo dialog enables you to add the following Topo information: 

 Topo Data; Topo Name and any Topo notes. 

 Stage Measurement Data 

 Fixture Display Set Type 

 

Create icon on the 

Patch Tool bar. 

Patch Topo List 

window 
Workspace Tree 

Topo List 
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Adding, Editing and Deleting a Topo 

The following section describes how to add, view, edit, rename and delete a 

Topo.  

To Add a Topo 

1. From the Menu bar select Tools ► Patch Manager. 

The Patch Manager window opens. 

2. From the Workspace Tree in the Patch Manager scroll down and select Topo 

List: 

 

3. From the Patch Tool bar select the Create icon: 

 

The Add Topo dialog opens: 
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4. Enter a Topo name into the Name field and add any notes if needed: 

 

5. Enter Stage Measurements and Fixture Display data: 

 

6. Click OK to apply the new Topo. 

The new Topo now appears under the Topo List in the Workspace Tree and the 

Patch Topo List window: 

 

7. Repeat the steps to add another Topo to the list. 
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To View a Topo 

1. From Menu bar select Tools ► Patch Manager. 

2. From the Workspace Tree and under Topo List click on the Topo name to view 

the Topo: 

 

To Edit a Topo 

1. From the Menu bar select Tools ► Patch Manager. 

2. From the Workspace Tree select Topo List: 

 

3. From the Patch Topo List window, place the mouse over the Topo to edit, 

Right click and select Properties. 

-OR- 

Select the Properties icon on the Patch Tool bar: 

 

-OR- 

From the Workspace Tree select the Topo to edit, then from the Topo title bar 

select the View Properties icon: 
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The Add Topo dialog opens: 

 

4. Edit the Topo as desired and then click OK. 

To Rename a Topo 

1. From the Menu bar select Tools ► Patch Manager. 

2. From the Workspace Tree select Topo List: 

 

3. From the Patch Topo List window double click on the name field to rename a 

Topo: 

 

-OR- 
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Place the mouse over the Topo to rename, right click and select Properties: 

 

-OR- 

Select the Properties icon on the Patch Tool bar: 

 

The Add Topo dialog opens. 

In the Name field enter the new Topo name then click OK. 

 

After renaming, the Topo name appears in the Patch Topo List window under 

the Topo List in the Workspace Tree. 
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To Delete a Topo 

1. From the Menu bar select Tools ► Patch Manager. 

2. From the Workspace Tree Select Topo List: 

 

3. Place the mouse over the Topo to delete, right click and select Delete: 
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14 Topo Enhancements 

The following Topo enhancements were added: 

 A Zoom slider was added to the Live Topo List title bar: 

 

 New Layers Tool bar: 

 

See: Using the New Topo Layers Toolbar 

 Objects can be added to a User Defined Layer, locked, displayed or hidden. 

See: Adding Objects to a User Defined Layer 

 Objects can now be aligned using the Aligned icons available on the Topo 

Tool bar or by Right clicking and selecting an Align option. 

 

See: Aligning Objects 

 Multiple objects can be selected using the Ctrl key on the Keyboard. 

 A new range of Fixture icon images: 

 

See: New Topo Fixture Images 
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Using the New Topo Layers Toolbar 

The new Topo layers tool bar enables you to do the following: 

 Lock, display or hide objects 

 Add objects to User Defined Layers 

A Layers Toolbar button will only become active once a relevant object is added 

to the Topo. 

 

Topo Layers Toolbar: 

 

  

 

 

 

The Topo Layers Toolbar Options 

The following is an explanation of the Topo Layers Toolbar options: 

Toolbar Option What it does… 

 

This option will show or hide stage elements in the Topo window. 

 

This option will show or hide Channel objects in the Topo window. 

 

This option will show or hide Spot objects in the Topo window. 

 

This option will show or hide Matrix objects in the Topo window. 

 

This option will show or hide Media Server objects in the Topo window. 

 

These are User Defined Layers. When a layer is locked you will not be 

able to select or manipulate the objects. 

 
This option will show or hide all objects that are not defined in a layer. 

Stage 

Elements 

Layer 

Channels 

Layer 

Spots 

Layer 

Matrix 

Layer 

Media 

Server 

Layer 

User Defined Layers with Lock Layers Show / Hide 

objects 
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How to Display the Topo Layers Toolbar 

The Topo Layers Toolbar can be displayed from the Topo live view and from the 

Patch Manager. 

To Display Topo Layers Toolbar from Topo Live View 

1. From the Workspace Tree select a Topo. 

2. From the Topo List title bar click on the Layers Toolbar icon to display the 

Topo Layers Toolbar. 

 

To Display Topo Layers Toolbar from Patch Manager 

1. From the Menu bar select Tools ► Patch Manager. 

2. From the Workspace Tree select a Topo. 

3. From the Topo List title bar click on the Layers Toolbar icon to display the 

Topo Layers Toolbar: 
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Adding Objects to a User Defined Layer 

There are 5 User Defined Layers. Any object can be added to a layer. 

To Add Objects to a User Defined Layer 

1. Select the objects to add. 

2. Right click. 

3. From the User Defined Layers list select a layer from 1-5: 

 

The corresponding User Defined Layer button on the Layers Toolbar will 

become active: 

 

To Hide Objects in a Layer 

 Click on the active User Defined Layer button number: 

 

To Lock Objects in a Layer 

 Click on the Lock button: 
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To Remove Objects from a User Defined Layer 

1. Make sure the layer is unlocked. 

2. Select the objects to remove. 

3. Right click and from the User Defined Layers list select Layers None: 

 

Aligning Objects 

Objects in the Topo window can be aligned by using the Align icons on the Topo 

Toolbar or by Right clicking the Mouse and selecting an Align option. 

 

The Topo Toolbar Align Icons: 

 

 

Right Click Align Options: 

 

Left 

Align 

Right 

Align 

Top 

Align 

Bottom 

Align 

Right click mouse Align 

options 
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How to Align Objects 

The Align options become active once 2 or more objects are selected. The 

selected objects will be aligned to the last selected object which is identified by 

a blue border. 

 

 

To Align an Object 

Method 1  

1. Press and hold Ctrl on the Keyboard then Left click the Mouse and select the 

objects. 

The Align options become active and the selected objects will be contained 

within a white border, with the last selected object surrounded by a blue 

border. 

Example image: 

  

2. Select an Align option from either the Topo Toolbar or Right click the Mouse 

and select an Align option. 

The selected objects will be aligned to the object with the blue border. 

 

 

White border of selected objects 

Blue border indicates the last 

selected object 

White border of selected 

objects 

Last selected object with blue 

border 
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Method 2 

1. Select the objects, excluding the object you want to align with, by drawing 

a box around the objects using Left mouse click hold.  

The selected objects will be contained within a white border. 

Example image: 

 

2. Press and hold Ctrl on the Keyboard then Left click the Mouse and select the 

object to align with. This object must be outside of the selected objects. 

The Align with object becomes part of the selected objects with a blue 

border. 

Example image: 

 

3. Select an Align option from either the Topo Toolbar or Right click the Mouse 

and select an align option.  

The selected objects will be aligned to the object with the blue border. 

 

 

 

 

 

 

 

Selected objects excluding 

the align with object  

The Align with object outside 

the selected objects 

Selected objects including the 

Align with object 
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New Topo Fixture Images 

A new range of Topo Fixture icon images have been added. There are now a 

total of 13 images which can be selected via Stage Fixture Properties. 

Topo Fixture images can only be changed from the Patch Manager. 

  

The following is a list of all the available Fixture icon images and their 

meanings: 

Icon Meaning 

 

Bar 

 

Blinder 

 

Fresnel 

 

Laser 

 

Media Server 
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Panorama 

 

Moving Head 

 

Par LED 

 

Par 

 

Scanner 

 

Profile 

 

Smoke 

 

Wash 

To Change Topo Fixture Icons 

1. Select a Fixture from the Patch Manager Topo List. 

2. Right click and select Change Icon. 

The Select Topo Image dialog opens. 

3. Select a Topo image. 

-OR- 

1. Select a Fixture from the Patch Manager Topo List. 

2. Right click and select Properties. 

3. From the Stage Fixture Properties dialog select the browse icon: 
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15 Pandora’s Box Integration 

Vector is now fully compatible with Coolux Pandora Box media server. Vector 

controls the Pandora Box media server using the VC Ethernet Protocol. New 

Pandora Box server devices have also been added in this release. 

Media server Thumbnails are downloaded in real time on Vector which are 

viewed via the Media Server tab. 

NOTE: Pandora Box must have the same Subnet Mask IP as the Vector console. 

Thumbnails from Pandora’s Box as Viewed in Vector 

 

Getting Started with Pandora’s Box and Vector 

The following section describes how to do the following: 

 How to Start and Save a new project in Pandora’s box 

 How to Select device types  

 How to add the Compulite tab 

 How to enable Compulite VC Input 

 How to add files to a Pandora’s Box project 

 

 

Pandora Box media server thumbnails viewed in 

Vector on the Media Server tab.  
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To Start and Save a New Project in Pandora’s Box 

1. Start Pandora’s Box. 

2. From the Menu bar click File ► New Project and select either Standard or 

Lighting Console: 

 

The Save As dialog opens. 

3. Enter a project name in the Save As File name field: 

 

4. Click Save. 
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To Select Device Types in Pandora’s Box 

1. From Pandora’s Box main screen click on the Device Types tab: 

 

2. From the Device Types tab double click on either the Pandora’s Box PLAYER 

file or the Pandora’s Box SERVER file: 

 

The selected file list appears: 
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3. From the selected file device list select any device and drag it down to the 

Devices tab: 

 

 

 

 

 

 

 

Drag a device down to the Devices 

tab. 
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To Add the Compulite Tab 

1. From the Pandora’s Box menu bar click Tabs ► Extensions ► Compulite: 

 

The Compulite tab appears on the lower left hand corner: 

 

 



Pandora’s Box Integration  

| 48 

To Enable Compulite VC Input in Pandora’s Box 

1. From the Compulite tab click on the Enabled button under the heading VC 

Input: 

 

2. Click on the Listen to Console drop down list and select the Vector IP of the 

console that will be controlling Pandora’s Box: 

 

To Add Files to a Project 

1. Click on the Assets tab located in the middle window: 

 

2. Double click on the local IP. 
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The local IP file list appears: 

 

3. From the local IP file list locate the files you want in the project and drag 

and drop them to the Project folder: 

  

 

 

Drag and Drop files to the 

Project folder. 
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How to Sync Vector to Pandora’s Box 

The following procedure will guide you through the process of syncing Vector to 

Pandora’s Box. 

Please make sure that Pandora Box is installed on a separate PC. 

To Patch a Coolux Device in Vector 

1. From the Vector menu bar select Tools ► Patch Manager. 

The Patch Manager window opens. 

2. From the Patch Manager tool bar click on the Create and Patch icon: 

 

The Create and Patch Fixtures dialog opens. 

3. In the Name field of the Create and Patch Fixtures dialog enter the name of the 

PC or IP of the System that contains Pandora’s Box: 

 

4. Click on Import Device. 

The Import Device list dialog opens. 
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5. Scroll down the device list and click on Coolux: 

 

6. From the Coolux device list select a device according to the following: 

NOTE: Only V5 devices should be selected. 

If you created a Standard Pandora Box project then select any PB V5 

device with the ending “Standard”. 

If you created a Lighting Console Pandora Box project then select any PB 

V5 device with the ending “Lighting”. 

See Getting Started with Pandora’s Box and Vector 

7. Apply the device to the Patch. 

8. Enable VC from the System Settings► DMX Protocols tab. 

9. Activate the Media Server by using the following sequence: 

[Media Server, #] 

10. From the Editor Tool bar tap on the Download Thumbs soft key. Use the arrow 

keys to scroll left or right if the Download Thumbs soft key is not visible. 
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16 Block Cue Enhancement 

A new option has been added to the Tools ► Settings ► Playback tab called Block 

Cue Indications, which enables you to easily view Blocked cues in the Cue Sheet 

window. 

Once Block Cue Indication is activated, the blocked cue will change to an orange 

color. Block Cue Indications can be activated on-the-fly. 

By default the Block Cue Indications setting is off unless the setting has been 

changed and saved as default.  

 

 

 

 

 

 

New Block Cue 

Indications option 

Orange color 

indicates a Block 

cue. 
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To Activate Block Cue Indications 

1. From the Menu bar select Tools ► Settings ► Playback tab. 

2. From the Playback tab and under Block Cue Options select Block Cue Indications: 

 

3. Click Apply then click OK to close the System Settings dialog. 
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17 Macro Editing 

Previously recorded Macros can now be edited and new Macros can be created 

offline. 

The Macro Editing Toolbar 

Macros are edited from the Macro editing window using the Macro editing 

toolbar: 

 

Macro Editing Toolbar Options 

The following is a description of each option on the Macro editing toolbar: 

Option Description 

 

Add command before selected command. 

This option activates Select Command mode. Use this option to insert a new 
Macro command before the selected command. 

 

Add command after selected command. 

This option activates Select Command mode. Use this option to insert a new 
Macro command after the selected command. 

 

Edit command. 

This option activates Select Command mode. Use this option to edit a selected 
command. 

 

Delete command. 

This option will delete a selected command. 

 

Rename Macro. 

Use this option to rename a Macro. 

 

Save Macro. 

Use this option to save changes. 

 

Discard changes. 

This option will discard any changes that have been made. 

Note: This option will not discard any changes to the Macro name. 
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How to Edit a Macro Offline 

The following process will guide you through editing a Macro offline.  

To Edit a Macro Offline 

1. Select the Macro to edit by using one of the following methods: 

 [MACRO,#,EXAM] 

 [MACRO,EXAM] then double click on the Macro number from the Macro list. 

 Select the Macro from the Workspace Tree. 

Either way opens the Macro Exam window: 

 

2. From the Macro Exam window click on the Edit Current Macro icon : 

 

The Macro editing window opens. 

Example: 

 

3. From the Macro editing window select a row to edit. 

The Macro editing toolbar options become active and the selected row blue. 

Example: 

 

Active Macro editing options 

Selected blue row 
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4. Edit the Macro using the Macro editing toolbar options. 

See: Macro Editing Toolbar Options 

The selected row becomes green if Add new Macro before, Add new Macro after 

or Edit current Macro option is selected. This indicates that the System has 

entered Select Command mode. 

Example of Select Command mode: 

 

The Command line color also changes to green with the text [SELECT 

COMMAND]: 

 

Note the following when Select Command mode is active: 

 All Macro editing options will be disabled except the selected option. 

Select the selected Macro editing option to exit the current mode. 

 The Editor Toolbar will become active with all the existing system Toolbar 

commands. 

 Panel Keys, Soft Keys and Editor Toolbar options can be used to insert 

commands. 

 Each single input command will create a new row. 

5. From the Macro editing toolbar select the activated editing option.  

The System exits Select Command mode. The selected row changes from 

green to blue. 

6. Select the Save option to save the edited Macro or select another editing 

option to carry on editing 

 

 

 

 

 

Green selected row 

Green Command line 
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How to Create a New Macro Offline 

The following process will guide you through creating a new Macro offline. 

To Create a New Macro 

1. From the Workspace Tree select Macros. 

The Macro list window opens: 

 

2. From the Macro list window select the Create New Macro icon : 

 

The Create Macro dialog opens with the New option selected: 

 

3. In the New Macro number field enter the new Macro number. 

4. In the New Macro Name filed enter the new Macro name: 
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5. Click OK. 

The Macro editing window appears with Select Command mode active: 

 

Note the following when Select Command mode is active: 

 All Macro editing options will be disabled except the selected option. 

Select the selected Macro editing option to exit the current mode. 

 The Editor Toolbar will become active with all the existing system Toolbar 

commands. 

 Panel Keys, Soft Keys and Editor Toolbar options can be used to insert 

commands. 

 Each single input command will create a new row. 

6. The new Macro can now be edited using the Macro editing toolbar options. 

See: Macro Editing Toolbar Options and How to Edit a Macro Offline 

 

 

Green row indicates Select Command 

mode is active 
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How to Create a Macro from an Existing Macro 

A new Macro can be created using an existing Macro. This is done by selecting 

the Copy of Existing option from the Create Macro dialog. 

To Create Macro from Existing Macro 

1. Select the Macro to copy by doing either of the following: 

 Select the Macro from the Workspace tree. 

 [MACRO,#,EXAM] 

 [MACRO,EXAM] then double click on the Macro number from the Macro 

list. 

2. From the Macro Exam window select the Create New Macro icon: 

 

The Create Macro dialog opens with the Copy of Existing option selected: 

 

3. Make sure that the Macro you intend to copy is selected from the existing 

Macro drop down list: 
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4. Enter the new Macro number in the New Macro number field. 

5. Enter the name of the new Macro in the New Macro Name field: 

 

6. Click OK. 

The Macro editing window opens containing the copied Macro. 

The Macro can be edited using the Macro editing toolbar options. 

See: Macro Editing Toolbar Options 

See: How to Edit a Macro Offline 

 

Macro Time Editing 

Macro time is the “waiting time” between key presses, for example: 

The following image shows a 5 sec “waiting time” between key presses. The 

system will wait for 5 seconds before the key SPOT is pressed. 5 seconds later 

key 1 is pressed and after another 5 seconds the SPOT 1 will be at FULL: 

 

Macro time is edited in the Macro editing window. Time can entered in seconds 

and milliseconds. 

 

 

 

 

5 second waiting time before 

each key press 
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To Edit Macro Time 

1. Select a Macro by doing either of the following: 

 Select the Macro from the Workspace Tree. 

 [MACRO,#,EXAM] 

 [MACRO,EXAM] then click on the Macro number from the Macro list. 

2. From the Macro Exam window select the Edit Current Macro icon: 

 

3. From the Macro Editing window double click in the Time cell: 

 

4. Edit the Macro time. 

5. Click on the Save Macro option to save the new Macro time: 
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2 Version Highlights 

Version 3.20R02 brings a range of new and updated features together with 33 

new devices and 12 updated devices. 

Feature / Improvements Description 

Display  

 Empty Soft-Key Text Color 
Font color can be changed for empty soft-
keys. 

Editing  

 Edit Fixture Names 
Fixture names can be changed. Edited names 

can include or exclude index numbers. 

 Re-Select Group Selection 
There is now a faster method to re-select a 
group or selection.  

 Link Enhancement  Cues in-between linked cues can now be 

greyed out. 

 The Back button can now be used to go 

BACK while bypassing the cues in-

between the linked cues. 

Playback  

 Default Settings for A/B Playback 
Changes have been made to the default 
settings of the A/B Playback.  

The A/B will now have the following default 
settings: 

 Prevent From Paging will be OFF 

 Prevent Snap Override will be ON 

 Default Settings for Submaster 
Changes have been made to the default 

Submaster settings of a fader. 

The new Submaster settings are as follows: 

 Top button will now be Group Selection 

instead of GO 

 Middle button will now be Group Release 

instead of HOLD/BACK 

 Bottom button will remain as Flash 

 Flash To Black 
You are now able to instantly bring a dimmer 
value of a PB to zero (Blacken) using the new 
Flash To Black feature. 
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System Settings  

 Local DMX Output Selection 
You can now define which universe will be 
transmitted from a local DMX output located 
at the back of the console. 

 Monitor DMX Outputs  
You are now able to view and monitor DMX 

data and values that are being transmitted 
out of the console. 

 Increased Ports 
The amount of DMX ports transmitted from 
the console has been increased. 

 Multi-Language Support 
Vector now supports the following languages; 

German, Spanish, Hebrew and Chinese. 

 New Warning Message 
A new system warning message has been 
added to prevent console data from being 
deleted by mistake. 

External Hardware  

 New Vector PC Wing 
The new Vector PC Wing can be used as a 
hardware attachment to a Vector PC or as a 
Remote Wing with a console. 

A getting started guide for connecting the 
new Vector PC wing has been included in this 

document. 

Note: There has been a change in some 
hardware keycaps for the new Vector PC 
Wing. See Vector PC Wing Keycap Changes.  

FIRMWARE UPDATE: 

Please install the latest Firmware T025V030. 

The Firmware file and Release notes can be 

downloaded from the Compulite Downloads 
page; (Vector PC Wing Firmware Update 
July2012). 

 

http://www.compulite.com/index.php?page_id=14
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3 Bug Fixes V3.20R02 

 A Submaster with a mixed selection of RGB (with no dimmer devices) and 

devices with dimmers did not work correctly. This issue has been fixed. 

Reported by Matthias Schoffman. 

 A 50%value or 128 decimal value of a 16 bit parameter was incorrect. This 

issue has been fixed. Reported by Christof Leuba. 

 When the “Release at bottom” option was enabled, release Qlist time was 

ignored. Problem has been fixed. Reported by David Hall. 

 When a Cue was stored in the Blind editor while the Multi Editors option was 

enabled with Blind being the active editor, the system would exit the Blind 

mode. This issue has been fixed. Reported by Filip Wiesner. 

 Faders that were attached did not work correctly from warm data. The Snap 

had to be activated in-order for them to work. Problem has been fixed. 

Reported by Matthias Schoffman. 

 STEP>> did not work from the last Cue to the first Cue. This issue has been 

fixed. Reported by Matthias Schoffman. 

 If STEP was applied to a PB and BACK was used, the system used BACK 

TIME instead of CUT time. This problem has been fixed. Reported by 

Matthias Schoffman. 

 If a PB was moved from the last fader on a page to another fader in the 

middle of a page, then it was not possible to attach more faders to it. This 

issue has been fixed. Matthias Schoffman. 

 Copying a parameter from a spot in a library to another spot in the same 

library failed. This issue has been fixed. Reported by Orit Freedman. 

 If a range of Cues was updated and one of the Cues in the range had a 

private cell time, then the system would set all the Cues from the private 

cell time Cue onwards using the private cell time attribute. This problem has 

been fixed. Reported by Filip, Opera Prague. 

 ACTIVE did not work with RGB devices. This problem has been fixed. 

Reported by Matthias Schoffman.  

 LED Desk light worked only on the editor panel (main screen).This issue has 

been fixed. Reported by Gerhard Feiner.  

 When saving settings as default the console would change the settings 

instead of saving the new default settings. This problem has been fixed. 

Reported by Matthias Schoffman. 

 Images could not be loaded to a Matrix built of Channels. This has been 

fixed. Reported by Matthias Kern. 
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 If the Patch manager was open and Dimmer patch operations were made, 

then the Patch manager and show data were out of sync. This issue has 

been fixed. Reported by Orit Freedman. 

 When exporting a Channel display to Excel, caused one of the columns from 

the grid to be deleted. This problem has been fixed. Reported by Filip, Opera 

Prague. 

 After turning off “Jump to Fixture\Parameter” and updating a patch, caused 

“Jump to Fixture\Parameter” to turn ON. This problem has been fixed. 

Reported by Filip, Opera Prague. 
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4 Text Conventions 

The following text conventions exist in this document: 

 The actual keys on the console panel are referred to as KEYS. Panel KEYS 

are in BOLD CAPS. 

 The keys on the touch screens are referred to as BUTTONS. Touch screen 

BUTTONS are BOLD ITALICIZED CAPS. 

 Dialog boxes, Window titles and field names appear in this font. 

 Sequences appear like this; [SEQUENCE, SEQUENCE]. 

 The word “Click” also refers to “tap”. This depends if you are using the 

mouse to “click” or “tapping” on the touch screen. 
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5 Empty Soft-Key Text Color 

You are now able to set a different font color for an empty Soft-Key. This 

enables you to see the difference between empty and occupied Soft-Keys. 

The font color is set by using a new drop-down menu called “Empty Sk Font” 

located in the SK Editor. 

 

 

 

 

 

 

 

 

 

Occupied Soft-Keys with 

white font 

Empty Soft-Keys with 

grey font 

New Empty SK Font 

drop down menu 
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To change empty soft-key font 

1. From the Soft-Key menu pane click on the View Properties icon. 

 

-OR- 

From the Soft-Key menu pane right click and select View Properties. 

The SK Editor window will open. 

2. From the SK Editor window select the Empty SK Font drop down menu and 

select a font color. 

 

3. Click OK to apply the font color to the active soft-key set, or click Apply to All 

to apply the font to ALL soft-key sets. 

A confirmation dialog will open if Apply to All is selected. Select Yes or No to 

apply the font to all Soft-Key sets: 
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6 Edit Fixture Names 

Fixture names can now be edited. This feature will work with all Fixture sets 

(Channel, Spot, Matrix and Media Server). Edited names that are the same can 

include or exclude index numbers.  

Editing Fixture names is done via the consoles panel. 

 

 

 

 

How to Edit Fixture Names 

When editing Fixture names, you can either edit each name separately or in a 

range. A selected range of the same Fixture name can have index numbers 

added by adding a “Space” or an “Underscore” after the name. 

To edit Fixture names without index numbers 

1. Select Fixture and Fixture number. 

[CHANNEL, #] 

2. Select [TEXT]. 

The Fixture Name dialog text box will open. 

Fixture names and index 

numbers automatically given by 

the system 

Fixture names edited without 

index numbers  

Fixture names that are the same 

with index numbers  
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3. In the text box enter a Fixture name. 

4. Click OK to apply the Fixture name, or Cancel to cancel the operation. 

To name a Fixture range without adding index numbers 

1. Select a Fixture range. 

[CHANNEL, #  #] 

2. Select [TEXT]. 

The Fixture Name dialog text box will open. 

 

3. In the text box enter a Fixture name for the range. 

4. Click OK to apply the name to the Fixture range, or Cancel to cancel the 

operation. 

To name a Fixture range and adding index numbers 

1. Select a Fixture range. 

[CHANNEL, #  #] 

2. Select [TEXT]. 

The Fixture Name dialog text box will open. 
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3. In the text box enter a Fixture name for the range and either add a “Space” 

or “Underscore” after the name. 

For Example: 

 

 

4. Click OK to apply the name with index numbers to the Fixture range, or 

Cancel to cancel the operation. 

 

 

 

 

 

Space after Fixture name 

Underscore after Fixture name 
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Sequences Examples to Edit Fixture Names 

The following is list of sequences examples that can be used to edit Fixture 

names. 

Note: You can use SPOT instead of CHANNEL 

Sequence Result 

[CHANNEL, #, TEXT, enter name, OK] A Single Fixture name will 
be edited. 

[CHANNEL, #  #, TEXT, enter name, OK] A range of Fixture names 
will be edited without index 

numbers. 

[CHANNEL, #, +, #, +, #, TEXT, enter name, OK] A non-sequential range of 
Fixtures names will edited 
without index numbers. 

[CHANNEL, #, , #, +, SPOT, #, , #, +, MEDIA, #, 

+, MATRIX, #, +, MATRIX, #, TEXT, enter name, OK] 

A mixed group of Fixture 
sets and ranges will be 

named without index 
numbers. 

[CHANNEL, #, , #, TEXT, enter name 1, OK] A range of Fixture names 
will be edited with index 
numbering starting at 1. 

[CHANNEL, #, ,#, TEXT, enter name 5, OK] A range of Fixture names 
will be edited with index 
numbering starting at 5. 

[CHANNEL, #, , #, +, SPOT, #, , #, +, MEDIA, #, 

+, MATRIX, #, +, MATRIX, #, TEXT, enter name_101, 
OK] 

A mixed group of Fixture 
sets and ranges will be 

named with index 
numbering starting at 101. 
The index numbers will be 
applied to all selected 
Fixtures even if they are 
taken from different Fixture 

sets. 
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7 Re-Select Group Selection 

A faster method has been added to re-select a group or a selection after 

modifying its parameters.  

Once a groups parameters have been modified the  key can be used to re-

select the original selection. 

Example: 

 

Modifying the group’s parameters 

 

Using the  key to re-select the original group selection 

 

Spot 1-5 belongs to 

group 1 (Alpha FOH) 

The groups parameters have been modified 

using Next, Prev and Every. Spot 5 is now the 

only Fixture selected. 

Using the / key will re-select the original group 

selection. 
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8 Link Enhancement 

Link has been enhanced to enable you to grey out cues in-between linked cues. 

This enables you to easily view cues that are in-between linked cues. You are 

also able to use the BACK key to go back while bypassing the cues in-between 

the linked cues. 

For example 

Cue 5 is Linked to Cue 10 

Greyed out cues in-between the linked cues 5 and 10: 

 

Cue 5 is linked to Cue 10.  

Using the BACK key to fade from Cue 10 to Cue 5 will bypass the cues in-

between: 

 

 

 

 

 

 

Cue 5 is linked to Cue 10 

Cue 6 to Cue 9 are between the 

linked cues, therefore they are 

greyed out. 

Using the Back button will 

bypass the cues between the 

linked cues. 
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Link enhancement includes the addition of two new buttons called LINK ON 

BACK and LINK INDICATIONS. These have been added to the System Settings 

Playback tab under Link Options; Tools ► System Settings ► Playback tab. 

  

 

Using Link Options 

By default the Link Options settings are off unless the settings have been 

changed and saved as default. Link Options can be activated on-the-fly if 

needed. 

Link On BACK 

The LINK ON BACK option enables you to use the Back button to bypass cues 

in-between linked while going backwards. 

Link Indications 

The LINK INDICATIONS option enables you to grey out cues in-between linked 

cues. 
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To activate Link Options 

1. From the Menu bar select Tools ► Settings ► Playback tab. 

2. From the Playback tab and under Link Options select a link option. 

 

3. Click OK to accept the new setting. 

Link Options Rules and Conditions 

The following rules and conditions should be noted while using Link Options.  

Cues with two or more links 

If the option LINK ON BACK is activated and a cue has two or more links to it, 

then pressing on the BACK key will go back to the first linked cue in the 

backwards order. 

For example: 

Cue 5 and Cue 7 are linked to Cue 10. Pressing on the BACK key from Cue 10 

will fade to Cue 7. (The first linked Cue in the backwards order) 

 

 

 

 

 

 

 

 

 

 

 

 

Cue 5 Linked to Cue 10 Cue 7 Linked to Cue 10 Cue 10 

Pressing on the Back key from Cue 10 will 

fade to the first linked cue in the 

backwards order. In this case Cue 7. 
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If the option LINK ON BACK is activated and two Cues are linked to the same 

Cue, then pressing on the BACK key from the linked Cue will fade to the first 

linked Cue the backwards order. 

For example: 

Cue 2 and Cue 8 are linked to Cue 5. Pressing on the BACK key from Cue 5 will 

fade to Cue 8. (The first linked Cue in the backwards order) 

 

 

 

 

 

 

 

When Cues in-between linked Cues will NOT be greyed-out 

When the option LINK INDICATIONS is activated, Cues in-between linked Cues 

will not be greyed out in the following instances: 

 If a Cue is linked to a Cue less than its Cue number. 

For example: 

If Cue 10 is linked to Cue 5 (Less than Cue 10) the Cues in-between will not 

be greyed out. 

 

 If a link exists after programming a loop, the Cues in-between will not be 

greyed out. 

 

Cue 2 Linked to Cue 5 Cue 8 Linked to Cue 5 Cue 5 

Pressing on the Back key from Cue 5 will 

fade to the first linked cue in the 

backwards order. In this case Cue 2. 

Cue 10 linked to Cue 5 

Cues in-between the linked 

Cues are not greyed out. 
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Overlapping link ranges 

When the option LINK INDICATIONS is activated and there is an overlapping link 

range, only the first range will be greyed-out. 

For example: 

If Cue 2 is linked to Cue 7 and Cue 4 is linked to Cue 10, then the first range 

which is from Cue 2 to Cue 7 will be greyed-out. 

 

 

First linked range is greyed-out 
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9 Default Settings for A/B Playback 

Changes have been made to the default settings of the A/B Playback [SETUP ► 

A/B SELECT, Playback Definitions tab]. The new default settings will be 

saved with Snap data.  

When starting a new show the A/B will now have the following default settings: 

 PREVENT SNAP OVERRIDE will be ON 

This option locks a Cue list on the AB fader during a show. 

 

 

To change A/B playback settings 

Use the following sequence to change the A/B playback settings: 

1. [SETUP ► A/B SELECT] 

The Playback A/B Properties dialog will open. 

2. From the Playback Definitions tab and in the Properties section click on 

PREVENT SNAP OVERRIDE to change the settings. 

3. Click OK to apply the settings. 
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10 Default Settings for Submaster 

Changes have been made to the default Submaster settings of a fader. [SETUP 

► SELECT #, Playback Definitions tab] The new Submaster settings are as 

follows: 

 Top button will now be GROUP SELECTION instead of GO 

 Middle button will now be GROUP RELEASE instead of HOLD/BACK 

 Bottom button will remain as FLASH 

The default settings will be saved with Snap data. 

 

 

 

Note: From now on, Default PB Definition settings; Tools ► Settings ► Playback 

tab, will not affect Submaster settings. 
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11 Flash To Black 

Flash To Black is a new playback control feature that enables you to instantly 

bring the dimmer value of a playback to zero (Blacken). Flash To Black can be 

assigned to either a PB key or Q-Key. 

Assigning Flash To Black to a Key 

Assigning Flash To Black to a PB key or Q-Key is done by selecting the option 

from the PB Keys Behavior list. The behavior list is accessed by selecting a PB 

key from the Settings ► Playback tab or the Playback Definitions tab in Qlist 

properties. The PB key text will change to Flash To Black once assigned. 

Flash To Black can be assigned on-the-fly only via the Qlist properties, in which 

case the text FlshBO will appear in the PB wing. Assigning Flash To Black via the 

System Settings will only be applied to new assignments. 

 

Flash To Black in the PB Keys 
Behavior list 

Example of a PB 
Key assigned to 
Flash To Black 

Example of FlshBO text 
on the PB wing 
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To assign Flash To Black from System Settings 

1. From the Menu bar select Tools ► Settings ► Playback tab. 

2. Select the DEFAULT PB DEFINITIONS option to activate the PB key options: 

 

The PB key options will become active. 

3. Select a PB key to assign Flash To Black: 

 

4. From the PB keys behavior list select Flash To Black. 

Flash To Black will be assigned and the selected key option text will change to 

Flash To Black. 

5. Click Apply to save the change. 

Select a PB fader key or Q-Key to 

assign Flash To Black. 



Vector Release Notes 3.20R02  

25 | 
 

To assign Flash To Black from Qlist Properties 

1. Press [SETUP, PB SELECT#]. 

The Qlist Properties dialog will open. 

2. Select the Playback Definitions tab: 

 

3. Select a playback key to assign Flash To Black. 

4. From the Playback key behavior list select Flash To Black. 

Flash To Black will now be assigned and the selected key option text will 

change to Flash To Black. 

5. Click OK to apply the change and close the Qlist Properties dialog. 

 

 

 

 

 

 

Select a PB fader key to assign 

Flash To Black. 
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12 The New Vector PC Wing 

The Vector PC Wing can be used as a hardware attachment for Vector PC or as 

a Remote Wing with a console. Vector PC Wing is not a standalone wing, panel 

or console, and can only be used as a parallel hardware attachment, as it draws 

its processing power from a Vector PC or Vector Console. 

Note: Minimum software requirement is Vector Software 3.20R02 

 

Connecting Vector PC Wing 

The Vector PC Wing needs to be connected to a Vector system using a RJ-45 

network cable. Connection can either be via an Ethernet hub or direct.  

Note: If more than one system exists in the network, the Vector PC Wing will 

connect to the first recognized system in the network. (You may need to 

disconnect one of the systems in order for the PC Wing to recognize the correct 

one). 

 

 

 

 

 

 

http://www.compulite.com/index.php?page_id=497
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LED connection indications 

During connection the Vector PC Wing LED’s will indicate the connection status. 

The following are the LED indications: 

Action LED indication 

Powering Up All LED’s will blink for a split second. 

Scanning the network Green LED's 

All Playback LED’s will run in a 

progress bar fashion from left to right. 

During connection All LED’s will remain ON until 

connection is complete. 

Connection established  All LED’s will blink for a split second. 

NO Network Red LED's 

All Playback LED’s will run in a 

progress bar fashion from left to right. 

To connect Vector PC Wing 

1. Make sure Vector software is running. 

2. Using the supplied power cable connect the Vector PC Wing to a 110-220V 

power output. 

Do NOT turn wing ON. 

3. Using a RJ-45 network cable, connect one end to the Ethernet port on the 

Vector PC Wing and the other end to either of the following: 

 Vector console data port 

 Ethernet hub 

 Vector PC Ethernet port 

Note: If an Ethernet network hub is used, then make sure the Vector 

system is connected to the same Network hub. 
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4. Turn ON the Vector PC Wing. 

The Vector PC Wing should now connect to the system. See LED connection 

indications. 

Note the following: 

 The PC or console IP MUST be different than 127.0.0.1. For example; 

90.10.XX.1 or 91.10.XX.1. 

 The PC or console Subnet mask MUST be 255.0.0.0 

 Vector PC Wings with built in ePorts are controlled via C-Net Manager. 

Please make sure the ePort IP is the same as the Subnet of the PC. 

Vector PC Wing Operation 

The Vector PC Wing can only be used as a Parallel hardware attachment and not 

a standalone unit. 

Parallel Behavior 

The following applies to the Wing behavior in parallel mode: 

 Changing the fader mode on the Vector console changes it on the Wing and 

visa-versa. 

 Master playback can be changed on either the Wing or Vector console. 

 Editor functions on the PC Wing work together with the editor functions on 

the console. 
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Paging 

The following explains how Vector PC Wing paging works when using either a 10 

playback console or a 20 playback console: 

10 Playback Console 

 Paging on the PC Wing will also page on the console and visa-versa. 

 The 10 Playbacks on the console will affect the 10 Playbacks on the PC Wing 

and visa-versa, for example; Playback 1 on the console will affect Playback 1 

on the PC Wing and visa-versa. 

20 Playback Console 

 Paging on the PC Wing will also page on the console and visa-versa. 

 The first 10 Playbacks on a page of the console will affect the 10 

Playbacks on the PC Wing and visa-versa. 

For example 

Console PC Wing 

Page 1 (Playbacks 1- 20) Will affect Playbacks 1-10 

Page 2 (Playbacks 21-40) Will affect Playbacks 21-30 

 

Vector PC Wing Firmware Update 

There is a new Firmware update for the Vector PC Wing. The file can be 

downloaded from the links below or from the Compulite Downloads page. 

Vector PC Wing Firmware Update Release Notes V0.30 

Vector PC Wing Firmware Update  

 

 

 

 

 

 

 

 

 

 

http://www.compulite.com/index.php?page_id=14#Consoles
http://www.compulite.com/downloads/Vector%20PC%20Wing%20Firmware%20Release%20Notes%20V030.pdf
http://www.compulite.com/index.php?page_id=14#Consoles
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Vector PC Wing Keycap Changes 

Due to client requests we have changed certain Keycaps on the Vector PC Wing. 

Please contact your local distributor. 

 

 

 

No. Old Keycap New Keycap 

1 Playback Free All / Free 

2 Rate PB Release  

3 Store+ Setup 

4 Blank Lo.Light / Hi.Light 

 

 

 

 

1 2 

3 

4 
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13 Local DMX Outputs Selection 

You are now able to define which universe will be transmitted from a local DMX 

output located at the back of the console. This is done by selecting a Universe 

port from a drop down menu in the Local DMX Outputs table in the DMX 

Protocols tab. (Tools ► System Settings ► DMX Protocols). 

 

 

To select a Universe port 

1. From the Menu bar select Tools ► System Settings ► DMX Protocols tab. 

2. From the Local DMX Output table click on a Universe Port. 

The Port drop down menu will open. 

 

Local DMX 

Outputs 
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3. From the drop down menu select a universe Port. 

4. Click OK or Apply to apply the settings. 

Note: The Default 1 to 1 button will return the Universe ports to their default 

settings (Out 1 ► Port 1, Out 2 ► Port2, etc.). 
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14 Monitor DMX Outputs 

The DMX monitor enables you to view and monitor DMX data and values that 

are being transmitted out of the console. A new tab has been added to the Ports 

view called Output. (Workspace Tree ► Patch ► DMX Out ► Port #) 

 

 

Note: Only one view pane of the Output monitor can be opened at any given 

time. If an attempt to open more than one view pane occurs then a warning 

message will be displayed: 

 

Enabling DMX Output Monitor 

VC outputs need to be enabled in order to view the DMX Output monitor. 

To enable VC output 

1. From the Menu bar select Tools ► Settings ► DMX Protocols. 

2. Select the desired Port VC’s. 

3. Click Apply, and then click OK. 

New Output tab 
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15 Increased Ports 

The amount of DMX ports transmitted from the console has been increased. The 

following table provides details on increased ports for each console: 

 

DMX Protocol VC’s Art-Net Streaming ACN 

E-Ports  N/R 0 1 2 3 4 8 0 1 2 3 4 8 

Consoles 
   

Red/Blue/Green 32 32 32 

Orange 16 4 8 12 16 4 8 12 16 

Violet/UltraViolet  12 12 12 

Vector Node  32 32 32 

Vector PC  32 1 4 8 12 16 32 1 4 8 12 16 32 

 

Note: Vector Violet and Ultra Violet ports increase was implemented in software 

version 3.20R01. 
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16 Multi-Language Support 

Vector now supports the following languages; German, Spanish, Hebrew and 

Chinese. Language changes will mainly be applied to the Menu bar, the Menu 

bar drop down menus, dialogs, title bars and warning messages. 

Note: For Chinese language see Chinese Language Installation. 

Changing Language 

The Windows software language needs to be changed first in order for the 

console to display a selected language other than English. Windows language is 

changed from the Control Panel. 

To change Windows language 

1. From the Windows Start menu select Control Panel. 

2. From the Control Panel double click on Regional and Language Options. 

The Regional and Language Options dialog opens: 

 

3. Select the Advanced tab and then click on the language drop down menu 

under Language for non-Unicode programs. 
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4. From the drop down menu select the required language. 

5. Click Apply. 

6. If a warning message appears click Yes or OK. 

7. Click Yes to restart your computer. 

To change vector language 

1. From the Vector menu bar click on Help ► Language. 

 

2. Select the desired language. 

3. Note the following: 

 If you are changing the language on a Vector PC you will be prompted 

with a warning message and required to restart Vector. 

 

Click OK to verify the language change. Vector will shut down.  
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 If you are changing the language on a Vector console you will not be 

prompted with a warning message and Vector will automatically shut 

down. 

 In both the above cases, Vector will need to be started 

manually after shutdown. 

Troubleshooting Language Change 

If you have changed the Language on Vector and now have question marks 

(???) in place of text, it means that the required language has not been 

selected in the Regional and Language Options in the Windows Control Panel. 

See: To change Windows language 

Chinese Language Installation 

A Chinese language patch needs to be installed in order to view Chinese on the 

Vector console. The patch can be found in a folder called “Chinese” located in 

the Updates folder in the Compulite program files. 

To install Chinese language patch 

1. Navigate to the Updates ► Chinese folder: 

Vector Console – D:\Program files\Compulite Vector\Config\Updates\Chinese 

Vector PC – C:\Program files\Compulite\Vector Pc\Config\Updates\Chinese 

2. Click on the Chinese folder. 

3. Double click on the file ie_zhc.exe. 

A Microsoft Chinese Language Support pop-up will appear: 

 

4. Click Yes. 

5. Click Yes to accept the License Agreement. 

The Install will begin. 

When the install is complete an Installation Complete pop-up will appear. 
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6. Once the Chinese language patch has been installed, navigate to Regional 

and Language Options in the Control Panel. See Changing Language 

7. From the Advanced tab click on the drop down language menu and change 

the language to Chinese (PRC). 

8. Reboot the System. 

9. After Rebooting the System, start the Vector Software and select Chinese 

language; Help ► Languages ► Chinese. 

See To change vector language 
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17 New Warning Message 

A new system warning message has been added to prevent console data from 

being deleted by mistake. 

If New Show is selected by mistake while working with a show the following 

warning message will appear: 
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Version Highlights 

1. Display  

1.1. Live Mode View 
Enhancement 

The Pan Title Bar will now display the selected 

Live Mode. 

1.2. Live Fixtures Display 
Enhancement 

An option has been added to view the Live 

Fixture display grid either horizontally or 

vertically. 

1.3. External Wing Display A dedicated display has been added to the 

Workspace Tree for an external wing. 

1.4. Navigation History Navigation history items can now be selected 

from drop down menus on the Back and 

Forward navigation buttons. 

2. Editing  

2.1. Shuffle 3 new shuffle options have been added; Shuffle 

Order, Shuffle Fixtures and Shuffle All Cells. 

2.2. User Defined Curves 8 User Defined curves have been added which 

can be edited accordingly.  

2.3. Invert Values Selected Fixtures and Parameters can now be 

inverted to an opposite value. 

2.4. Bypass Library Time A library fade-in time value can be bypassed, 

in which case CUT time will be used. 

3. Playback  

3.1. Enhanced Move Function Playbacks can now be moved to Playbacks on-

the-fly. 

3.2. New Snap Options  New snap options have been added which 

enable you to store a current master PB and/or 

current page number to a snap. 

3.3. Tap Beat Tap Beat enables you to set the Rate speeds by 

tapping on the BEAT button. 
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3.4. Go Reverse Go Reverse is a new playback control feature 

that enables you to go in a reverse direction 

when using cues. 

3.5. Group Selection and 
Release via PB 

Fixtures can now be selected and/or released 

by pressing on an assigned PB key or Q-Key. 

4. System Settings  

4.1. System Lock You are now able to lock the console using a 1 

to 10 digit code. 

** Vector Violet Improvements ** 

Vector Violet is now able to transmit up to 12 outputs from any protocol (VC’s, ArtNet and 

Streaming ACN) regardless of the amount of ePorts connected. 
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Important Bug Fixes – Vector Software 3.20R01 

 Snaps that were saved with running/off status did not come up as “Saved”. This has been 

fixed. Thanks to Stephen Plotkin, Canada. 

 Communication has been improved between Master console and Slave or Node.  Thanks 

to Bambi, Bonder and Vini, Israel. 

 A Macro with Freeze Effect did not unfreeze on the second pass. Now only one Macro 

can be used to freeze and unfreeze. Thanks to Moshiko Pe’er, Israel. 

 Assigning or storing a range of cues to a range of playbacks did not work properly; 

instead it was spreading the cues to Qkeys. This has been fixed. Thanks to Gerhard 

Feiner, Germany. 

 If the Autosave folder was moved or changed from the Vector Shows folder, an error 

message occurred. This has been fixed and now the system will auto create the Autosave 

folder again. Thanks to Eli Osawa, Tokyo. 

 Copying a fixture or parameter did not work properly especially when selecting groups. 

This has been fixed. Thanks Bill Peachment, UK. 

 When attempting to update a Library on a show that was saved on an older software 

version, produced an error message which was related to Mark-Cue. This has fixed. 

Thanks to Gino DeLeo, David Winnik, Ronen Ben-Harosh, Italia, Israel. 

 When assigning Delay In/Out times with a value smaller than 1 sec and using the decimal 

dot (.), the result was a wrong value. This has been fixed. Thanks to Uri Morag, Israel. 

 On some occasions, Vector did not download more than 180 thumbnails from Arkaos' 

Media-Master. This has been fixed. 

 On Vector orange, when loading a show that had DMX-In + Art-Net or DMX-In + ACN 

enabled, caused a windows crash. This has been fixed. Thanks to Orit Freedman, 

Holland. 

 There was a crash using the sequence [FIXTURE, #, VIRTUAL DIMMER, @, RED, 

Spin wheel] on a device that was using a virtual dimmer. This has been fixed. Thanks to 

Stephen Plotkin, Canada. 

 When loading a show from a previous version that had an infinite time setup to control 

parameter, caused the infinite time to be around 10 minutes. This has been fixed. Thanks 

to Pekka Rytilahti, Finland. 

 

 

 The Park sequence was always selecting the whole fixture. Now it is possible to select 

specific parameter/s that will be parked. This is done by the sequence:[FIXTURE, #, (→, 
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#), Move values, PARAM, PARAM,… (To select the parameters in RED), 

SHIFT+PARK, STORE]. This sequence will also work to release parameters from park. 

Thanks to Moshiko Peer and Speedy Cole, Israel & Matthias Kern, Switzerland. 

 When working in Multi-Editors mode with the option "Take Multi-Editors" activated, 

then updating objects did not take all the editors. Now when this flag is enabled, updating 

objects will use all editors. 

 When examining a PB after the key "PB/QKey Display" was pressed, the content of the 

exam was incorrect. This has been fixed. Thanks to Raphael from Crystal, France. 

 The Automatic Parameter Grouping flag from the Editing tab in the system settings was 

not applied after exiting the System Settings. This has been fixed. Thanks to Orit 

Freedman, Holland. 

 The sequence of releasing fixtures from Sub-Masters did not work on some occasions. 

This has been fixed. Thanks to Filip Wiesner, Austria. 

 Wheel assignments did not page correctly when there were spaces between the 

parameters on the wheels. Now paging will page exactly as stored in the device. Thanks 

to Bonder, Israel. 

 If a device had no Dimmer, Virtual Dimmer or RGB parameter patched, it caused odd 

behavior to the system. This has been fixed. Thanks to David Bishop, UK. 

 The sequence of [CUE, #, NEXT/PREV] did not work if the # (cue number) did not exist. 

Now when doing this sequence on a non-existing cue and pressing NEXT/PREV then it 

will give the nearest cue next/prev to the number that was entered. Thanks to Aviram 

Shahinu, Israel. 

 It was not possible to see 16 bit color parameters in the Matrix-List live view. This has 

been fixed. Thanks to Jerry Roberto Romani, Italy & David Bishop, UK. 
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Text Conventions 

The following text conventions exist in this document: 

 The actual keys on the console panel are referred to as KEYS. Panel KEYS are in BOLD 

CAPS. 

 The keys on the touch screens are referred to as BUTTONS. Touch screen BUTTONS are 

BOLD ITALICIZED CAPS. 

 Dialog boxes, Window titles and field names appear in this font. 

 Sequences appear like this; [SEQUENCE, SEQUENCE]. 

 The word “Click” also refers to “tap”. This depends if you are using the mouse to “click” 

or “tapping” on the touch screen. 
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Live Mode View Enhancement 

An option has been added to enable the selected “live mode” to be displayed on the live mode 

title bar.  This will only be visible if the title bar is not hidden; Show/Hide Pane Title 

Example: 

If you select Active In Editor from the Live Mode menu, the live mode title bar will display the 

text “Active In Editor” provided the Pane Title is not hidden. 
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Live Fixtures Columns Display Enhancement 

The Live Fixture display grid can now be viewed either horizontally or vertically for Live 

Channels, Spots, Matrix and Media Server: 

Vertical View 

 

Horizontal View 

 

 

A new option has been added to the Columns tab; View Properties ► Grid Properties, called 

Vertical View. When Vertical View is activated the grid style will be vertical and the number of 

columns can be defined. (Default No of Columns is 10). When Vertical View is OFF the grid 

style will be horizontal. 

  

Vertical View ON Vertical View OFF 
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To change columns display type 

1. Click on the VIEW PROPERTIES button in the grid view pane title bar. 

 

-OR- 

Right click and select View Properties: 

 

-OR- 

From the View menu select View Properties: 

Either way will open the Grid Properties dialog: 
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2. Select the Columns tab: 

 

3. Click on the Vertical View option under Display Type to activate vertical view and 

enter the amount of columns - if desired: 

 

 

 

Note: When Vertical View is OFF, the display grid type will be 
horizontal view. 

4. Click Apply to apply the change. 
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External Wing Display 

The External wing display is a dedicated display of external wings; Wing 10 and Wing 20. The 

external wings are selected from the Workspace Tree ► Playback ► External Wing. The display 

will enable you to view Wings and Qkeys. 

The display window will be blank if an external wing is not present in the network. 

 

 

 

 

 

 

To view external wing 

Before you can view an external wing, make sure the wing is connected and a connection has 

been established with a Vector console. 
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1. Open the Workspace Tree. 

2. From the Workspace Tree click on the Playback folder, then click on the External 

Wing folder. 

3. Select a Wing / Qkey to view. 

 

Exam Qkeys on Playback 20 Wing 

Examining Qkeys on Wing 20 can ONLY be done in Parallel mode. If the wing is NOT in 

parallel mode, then follow the instructions below: 

 

To select parallel mode on Wing 20 

1. On the Vector console press SETUP. 

The edit tool bar will now be in setup mode. 

2. From the Edit toolbar select REMOTES. 

3. Select the type of wing; REMOTE WING-20PB. 

The wings will be displayed on the toolbar. 

4. Select the specific wing. 

The operation mode dialog box opens and the current mode is displayed at the top of 

the dialog box. 

5. Select PARALLEL. 

The dialog box closes. 

 

To Exam Qkeys on Wing 20 

1. On the Vector console press EXAM. 

2. On the Wing 20 press QKEY MODE. 

The LED on the QKEY MODE key will turn ON (Red) 

3. On the Wing 20 press the PLAYBACK SELECT key twice. 

The LED on the PLAYBACK SELECT key will blink green 

You should now be able to exam a Qkey by pressing a SELECT key on the wing 20. 
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Navigation History 

Navigation history can now be viewed by selecting the desired view history from a drop down 

menu. The History drop down menu will display up to 10 history pages of the current active 

view. (The current active view has an orange border) Using the drop down menu is a faster way 

of selecting a history item.   

The Navigation history drop down menu has been added to the Back and Forward navigation 

buttons: 

 

 

Using Navigation History 

The Back  drop down menu will display only the history that you can go back to. The 

Forward  drop down menu will display only the history that you can go forward to. 

  

The following is an example of how to use navigation history: 

 

To use navigation history – Example 

1. From the Workspace Tree click on Libraries. 

The Libraries view window will become the active view. 

2. From the Workspace Tree and under the Libraries file, select Position, Color, Beam 

and Effect. (The last selected view ,Effect,  becomes the current view) 

3. From the Navigation bar click on the drop down menu arrow: 

 

 

 

History drop down 

menu 

Drop down menu arrows.  There 

will be no arrows if no history 

exists. 

Drop down menu arrow 



Navigation History 

  13 |  
 

The history drop down menu will appear: 

 

4. Select a history item to go back to, for example Libraries: 

 

After selecting a history item, another drop down menu arrow will appear next to the 

forward button. You can now use the drop down menus on both buttons to navigate to 

a history view: 

 

 

 

 

 

 

 

 

Use the drop down menus to navigate to 

a desired history view 
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Shuffle 

There are now 3 new options to shuffle a fixture selection order; Shuffle Order, Shuffle Fixtures 

and Shuffle All Cells. By using shuffle you are able to build effects and/or chaser steps without 

any thinking or creativity. 

Shuffling can be done via the following: 

 The Editor toolbar using a new button called; SHUFFLE ORDER 

-OR- 

 The Effects Editor which has two new shuffling buttons; SHUFFLE FIXTURES and 

SHUFFLE ALL CELLS 

 

USING SHUFFLE ORDER 

Shuffle Order will shuffle a selection in random order when using the Next / Prev buttons. 

The new Shuffle Order button is located on the Editor toolbar, and is only available once the 

“Every” button has been selected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tap on the EVERY 

button to access 

SHUFFLE ORDER  
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To shuffle order 

Example: Shuffle order of spot 1 -5 and assign a dim intensity value of 45%. 

1. Select Fixtures; [SPOT 1  5]  

2. From the Editor toolbar select EVERY. 

 

3. From the Editor toolbar select SHUFFLE ORDER. 

 

The Command line will display the following: 

 

4. Press on NEXT or PREV. 

5. Type; [@, 45] 

6. Press on NEXT or PREV to shuffle the order. 

 

Shuffle Order Sequence Examples 

 [FIXTURE, #  #, EVERY, SHUFFLE ORDER, NEXT / PREV, FULL, NEXT, NEXT, 

PREV, etc.] 

 [FIXTURE, #  #, EVERY, SHUFFLE ORDER, NEXT / PREV, @, ##, NEXT, NEXT, 

PREV, etc.] 

 [FIXTURE, #  #, @, ##, EVERY, SHUFFLE ORDER, NEXT / PREV, PAN / TILT, 

NEXT, NEXT, PREV, etc.] 
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Using Shuffle Fixtures with Effects 

Shuffle Fixtures will only shuffle the selected fixture rows in random order. All fixture 

attributes will be shuffled, except the Base value. (Base value is a parameter value that defines an 

effect’s starting point). For more information on Base, see Chapter 10, page 274 in the Vector 

Reference Guide. 

 

Example of shuffling fixture rows: 

 

 

The Shuffle Fixtures option is located in the Effects Editor ► Advanced tab: 

 

 

 

 

 

 

 

 

 

Selected fixtures 

1-5 

Fixtures 

rows will be 

shuffled in 

random 

order 
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To shuffle fixtures 

Example: In this example we will assign a circle and wave effect for spots 1-5, then use 

shuffle fixtures to shuffle the order. 

1. Select Fixtures; [SPOT 1  5]. 

2. Press EFFECT. 

The Effect Editor dialog will open 

3. From the Pre-Built tab select the Circle effect option. 

4. Now click on the Basic tab. 

5. From the Basic tab and under Wave Functions select the Wave option. 

6. Now click on the Advanced tab. 

7. From the Advanced tab select the Shuffle Fixtures option. 

The selected fixtures rows will now shuffle in a random order. 

 

TIP! You can re-shuffle the order by selecting the Shuffle Fixtures button 
again until you find a desired shuffle order or effect. 

 

 

Using Shuffle All Cells 

Shuffle All Cells will shuffle only the Offset values of the selected fixture cells in random order.  

Example 

Before using Shuffle All Cells: 

 

 

 

 

 

 

The Offset values remain 

unchanged. 

Selected 

Fixtures 1- 5 
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After using Shuffle All Cells: 

 

 

 

 

 

 

The Shuffle All Cells option is located in the Effects Editor ► Advanced tab: 

 

 

 

 

 

 

 

 

The Offset values are shuffled 

in random order. 
Selected 

Fixtures 1- 5 
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To shuffle all cells 

Example: In this example we will assign a circle and wave effect for spots 1-5, then use 

shuffle all cells to shuffle the order. 

1. Select Fixtures; [SPOT 1  5]. 

2. Press on EFFECT. 

The Effect Editor dialog will open. 

3. From the Pre-Built tab select the Circle effect option. 

4. Now click on the Basic tab. 

5. From the Basic tab and under Wave Functions select the Wave option. 

6. Now click on the Advanced tab. 

7. From the Advanced tab select the Shuffle All Cells option. 

The selected fixtures cells will now shuffle in a random order. 

 

TIP! You can re-shuffle the order by selecting the Shuffle All Cells button 
again until you find a desired shuffle order or effect. 
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User Defined Curves 

8 User Defined curves have been added which can be edited using the windows interface. User 

Defined curves can be applied to a dimmer the same way you apply the factory curves. See: 

Editing DMX channel properties on page 76 in the Vector Reference Guide. 

A new folder called “Curves” has been added to the Patch folder in the Workspace tree. The 

folder contains factory and user defined curves. Clicking on the Curves folder in the Workspace 

Tree will also display the curves in a grid window, and will indicate which curves can be edited 

or not; (Yes / No). 

Editing of User Defined curves can only be done from the Patch Manager.  

 

 

 

 

 

 

 

 

 

 

 

No: 

Curves 

cannot 

be edited 

Yes: 

Curves 

can be 

edited 
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Editing User Defined Curves 

Curve names and points can be edited and saved to a show. Curves can contain up to 255 curve 

points (Min is 2 points). Factory curves can also be copied and pasted into user defined curve 

and then edited. 

Curves are edited by adding and moving active points. Active points are white and non-active 

points are blue: 

 

 

Graph Editing Controls 

The following is list of graph editing controls and what they do: 

Controls What it does… 

 

These controls are used to move the active point to the next or previous point 

on the graph. 

 

These shows the Input and Output points of the curve. 

 

 

Active Point 

is white 

Non Active Point 

is blue 
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Controls What it does…(Cont.) 

 

 

 

This will add a point to the left of the active point. The point will be added in 

the middle of the two points: 

Example:  

 

 

 

 

 

 

This will delete an active point only. Click on a point to make it an active 

point and then press the delete button. 

 

This will add a point to the right of the active point. The point will be added 

in the middle of the two points: 

Example:  

 

 

 

 

 

 

Hide or show grid icon. 

 

Copy From enables you to copy a curve from either Factory curves or User 

defined curves and automatically pastes it to the current open User defined 

window. 

 

 

 

 

 

 

 

Point 2 

Active Point 

Point 1 Point 3 

The new point will be added in the middle of point 1 and point 2. (To the left 

of point 2 – Active point) 

Note the 

light 

shade  

Point 2 

Active Point 

Point 1 Point 3 

The new point will be added in the middle of point 2 and point 3. (To the 

right of point 2 – Active point) 

Note 

the 

light 

shade  
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To edit a user defined curve 

1. Open the Patch Manager; Tools ► Patch Manager. 

2. Open the Workspace Tree. 

3. From the Workspace Tree click on the Patch folder to display the Patch list. 

4. Scroll down the list until you reach the Curves folder. 

5. From the Curves folder select a User defined curve to edit. 

 

 

 

 

Select a User 

Defined curve to 

edit. 



User Defined Curves  

     | 24 

The User Defined curve window will open. 

Example: 

User Define1 was selected: 

 

6. Add points to the graph using the plus button;  or . 

For example; one point was added using the right plus button: 

 

Point was added in 

the middle of point 

1 and point 2  

Point 1 

Point 2 

Active point (White Point) 
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TIP! You can add a point by double clicking the mouse on the graph line. 

 

7. Using the mouse, left click and hold on the active point and drag the point to the 

desired location: 

Example: 

 

 

TIP! You can use the arrow keys on the keyboard for moving the point to a 
more accurate value: 

Using the mouse, left click on the point to move, and then use the keyboard 

arrow keys to move the point.  

8. To add more points go back to step 6.  

9. Save the curve by clicking on the tick button on the Patch Manager toolbar: 

 

Press to 

save curve 
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To name a curve 

1. Open the Patch Manager; Tools ► Patch Manager. 

2. Open the Workspace Tree. 

3. From the workspace tree click on the Patch folder to display the Patch list. 

4. Scroll down the list until you reach the Curves folder. 

5. Select the Curves folder. 

A window will appear with all the curves in a grid form: 

 

6. Double click on the User Define curve you want to name. 

Example: 

 

7. Type in the name of the curve. 

8. Save the curve name by clicking on the tick button on the Patch Manager toolbar: 

 

Double click to 

name curve 
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The curve name will be changed in the Workspace Tree and the Curve grid: 

Example: 

 

 

To copy a curve 

1. Open the Patch Manager; Tools ► Patch Manager. 

2. Open the Workspace Tree. 

3. From the Workspace Tree click on the Patch folder to display the Patch list. 

4. Scroll down the list until you reach the Curves folder. 

5. From the curves list select a User Defined curve that you want to copy a curve to. 

The User Defined curve window will open. 

6. From the Curve editing toolbar select the Copy From button. 

A Copy From drop down menu will be displayed: 
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7. From the Copy From drop down menu select where you want to copy the curve from; 

either Factory curves or User curves, then select the actual curve you want to copy. 

Example: In this example we will copy from Factory curves and select the S-Curve: 

 

Once you select the curve it will be immediately copied into the User Defined curve: 

Example: Factory curve; S-Curve was copied into User Define 1: 

 

8. The curve can now be edited and named; See To edit a user defined curve 

9. Save the curve by clicking on the tick button  on the Patch Manager toolbar.  

Factory Curve: S-Curve 
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Invert Values 

Selected Fixtures and Parameters can now be inverted to an opposite value by using a new option 

called INVERT VALUE, which has been added to the Editor toolbar.  

 

When using Invert Value, selected Fixtures that have parameter values highlighted in red will be 

inverted, whereas when selected fixtures have no specific values selected, all the fixture 

parameter values will be inverted. 

Below are examples of using Invert Value for fixtures with and without parameter values 

selected. 

Example: Fixtures with parameter values selected. 

[SPOT 1 → 5, @, 40] 

Spot 1 to 5 is selected with dimmer output value of 40%: 

 

INVERT VALUE is selected from the Editor Toolbar: 

 

Result: The dimmer output value has been inverted from 40% to 60%. 
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Example: Fixtures with no specific parameter values selected. 

[SPOT 1→ 5, INVERT VALUE] 

Spot 1 to 5 is selected with all parameter values inverted: 

 

 

Invert Value Sequences 

The following is a list of Invert Value sequence examples and what they do: 

Sequence What is does… 

[SPOT, #, INVERT VALUE] Inverts all the values of the selected fixture. 

[SPOT, #, →, #, INVERT VALUE] Inverts all the values of the selected fixtures. 

[SPOT, #, PARAM, INVERT VALUE] Inverts only the selected parameter.  

[SPOT, #, →, #, PARAM, INVERT VALUE] Inverts only the selected parameters of the 

selected fixtures. 

[SPOT, #, →, #, PARAM, PARAM, INVERT 

VALUE] 

Inverts only the selected parameters of the 

selected fixtures. 

 

 

TIP! Experiment using Invert with CMY and RGB parameters. You can also use Invert 
with Pan/Tilt parameters.   
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Bypass Library Time 

When entering a library value into the editor, library time can be bypassed in which case CUT 

time will be used. Library time can be bypassed by using the SHIFT key only if the default 

library time in System Settings ► Timing tab is NOT Cut time. 

Bypassing library time can be handy when inserting Gobo libs without a fade. 

 

Sequence Examples to Bypass Library Time 

 

 [SPOT, #, →, #, SHIFT + LIB] 

 [SPOT, #, →, #, LIB, #, SHIFT+ENTER] 

 [SHIFT+LIB, ENTER] 

 [LIB. #, SHIFT+ENTER] 
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Moving Playbacks to Playbacks 

The Move function has been enhanced to enable you to move a single playback to another 

playback or a range of playbacks to a range of playbacks on-the-fly. This is now achieved by 

using the SELECT key. Playback Definitions and fader position (if motorized) of a selected 

playback will also move to the new location. 

 

What Playbacks can be moved? 

Single, multiple or a range of PB’s can be selected and moved. All playbacks are movable; for 

example: 

 PB’s to PB’s and QK’s  

 QK’s to QK’s, PB’s  

 

 

Note the following:  

 Assignments cannot be moved to and from the A/B. 

 A mixed selection is not movable; for example, PB and QK. 

 

Example of moving PB’s  

4 PB’s have been setup with the following: 

 PB 2/1; Qlist 3 with Playback Definition defined as GoRev (Go Reverse) 

 PB 2/2; Chaser (Qlist 4) with Playback Definition defined as Rls (Release) 

 PB 2/3; Qlist 5 with Playback Definition defined as GoRev (Go Reverse) 

 PB 2/4; Temp Cue with Playback Definition defined as Hld/Bck (Hold/ Back)  

Move PB 2/2 and PB 2/3 to PB 2/6 and PB 2/7 which are empty: 
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Use the sequence: 

[SHIFT, MOVE, SELECT PB 2, SELECT PB 3, SELECT PB 6]  

 

The above sequence will move the selected PB’s (PB 2/2 and PB 2/3) to PB 2/6 and PB 2/7: 

 

 

In the above example, you can see that the Playback Definitions of the PB’s (Rls and GoRev) are 

also moved to the new PB location. 

 

Sequences to Move a Playback to an Empty Playback 

When using the following sequences, the last SELECT in the sequence is the destination PB: 

[SHIFT, MOVE, SELECT #, SELECT#] This will move a single PB.  

[SHIFT, MOVE, SELECT#, SELECT#, SELECT#, 

ETC.] 

This will move multiple PB’s.  

[SHIFT, MOVE, SELECT #, ,#, SELECT #] This will move a range of PB’s.  
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Moving a Playback to an occupied Playback 

Playbacks can also be moved to occupied playbacks by using the @ key. When a playback is 

occupied an “Occupied!” dialog will appear with options to; Overwrite All, Swap or Cancel. 

 Overwrite All – This will overwrite all the existing PB information with the new PB 

information. 

 Swap – This swap the PB information around. 

 Cancel – This will cancel the operation. 

 

 

Sequences to Move a Playback to an occupied Playback 

The @ key is used when moving a PB to an occupied PB. The last SELECT in the sequence is 

the occupied destination PB. 

[SHIFT, MOVE, SELECT#, @, SELECT#] This sequence will move a single PB 

to an occupied PB.  

[SHIFT, MOVE, SELECT#, SELECT#, SELECT#, @, 

SELECT#] 

This sequence will move multiple 

PB’s to an occupied PB.  

[SHIFT, MOVE, SELECT#, , #, @, SELECT#] This sequence will move a range of 

PB’s to an occupied PB.  
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Illegal Destination error 

When moving a range to a destination that overlaps the selected range, for example; moving 

1→5 to 3, an error message will appear in the command line “ILLEGAL DESTINATION” 

 

 

Destination Limit Exceeded error 

When moving a range to a destination that exceeds its limits, an error message will appear in the 

command line; “DESTINATION LIMIT EXCEEDED! SELECT A NEW DESTINATION”. The 

range will still be on the clipboard allowing you to select a new destination.  

 

Example: 

If you select a range of PB’s and move them to Channel 10 on page 10, the destination range will 

be exceeded as there is NO page 11. 

 

Moving Playbacks to Qkeys and visa-versa 

Playbacks can be moved to Qkeys and visa-versa by using the following sequences: 

[SHIFT, MOVE, SELECT PB#, QKEY#] This will move a single PB to a QK. 

[SHIFT, MOVE, SELECT PB#, SELECT PB#, 

SELECT PB#, QKEY#] 

This will move multiple PB’s to QK’s  

[SHIFT, MOVE, SELECT PB#, , SELECT PB#, 

QKEY#] 

This will move a range of PB’s to QK’s 
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New Snap Options 

New Snap options have been added called “Include Current Master PB” and “Include Current 

Page #” which enable you to store the current master PB and/or current page number when 

storing a snap. A new snap option toolbar has been added for this purpose which is activated 

every time the Snap key is pressed. 

The snap options have also been added to the Snap Options section in the System Settings 

(System Settings ► Playback tab), enabling you to set the snap option defaults for a show. The 

default snap option will then always be triggered when a Snap key is pressed.  

You can toggle between options on-the-fly by using the Snap Options toolbar without affecting 

the snap default settings.  

The Snap options will always be restored when a “New Show” is selected. 

 

New Snap Options Toolbar New Snap Options in Systems Settings 

 

 

 

 

 

 

 

 

Using the New Snap Options 

The following explains the storing and loading of snaps using the new snap options: 
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Snap Option Storing Loading 

INCLUDE CURRENT MASTER PB When this option is 

enabled, the current master 

PB will be stored in the 

snap. 

When this option is 

enabled, the stored master 

PB will be loaded to the 

snap. 

INCLUDE CURRENT PAGE # When this option is 

enabled, the current page 

number will be stored in 

the snap. 

When this option is 

enabled, the stored page 

number will be loaded to 

the snap. 

Both snap options can be enabled for storing and loading. 

 

Viewing the Stored Snap Information 

When the new snap options are enabled, the stored snap information can be viewed from the 

snap view window: 

  

 

 

 

 

Stored Master PB Number 

 

Stored Page Number 

 

If a snap is stored with a snap option off, the text “None” will appear in the 

relevant cell. 
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Default Snap Options 

Changing the default options will only be applied to new assignments. The Snap “Include” 

default settings also affect how a snap is loaded. 

 

To change default snap options 

1. From the menu bar select Tools ► Settings ► Playback tab. 

2. Under Snap Options enable or disable the desired “Include” option: 

 

3. Click Apply to apply the new default setting. 

4. Click OK to exit System Settings. 
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Storing Master PB and/or Page number in Snap 

Storing snaps using the “Include” options can be done on-the-fly or by using the “Include” 

options default settings. See: Default Snap Options 

 

Note: The sequences below use Action Mode. When using Enter Mode, end a 

sequence with ENTER.  

 

To store Master PB and/or Page number in a snap 

Use the following sequence to perform operations on-the-fly: 

1. Press SNAP. 

The snap toolbar will be displayed: 

 

2. Enter a number on the numeric keypad. 

3. Select a desired “Include” option to enable or disable. 

4. Press STORE. 

 

Use the following sequence to perform operations using the default snap settings: 

1. Press STORE. 

2. Select a number on the snap soft keys. 

The snap will be stored using the default “Include” options. See: To change default 

snap options. 
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Loading a Snap with Include Master PB and/or Page Number 

Loading snaps stored with Include Master PB and/or Page Number can be done on-the-fly or by 

using the “Include” default settings. See: Default Snap Options. 

 

To load a snap with Master PB and/or Page Number 

Use the following sequence to perform operations on-the-fly: 

1. Press SNAP. 

The snap toolbar will be displayed: 

 

2. Select a desired “Include” option. 

3. Select a stored snap from the soft keys. 

 

-OR- 

 

1. Press SNAP. 

The snap toolbar will be displayed: 

 

2. Enter a snap number on the numeric keypad. 

3. Select the desired “Include” option. 

4. Press ENTER. 

 

Use the following to perform operations using the default snap settings: 

 Select a stored snap from the soft keys. 

The snap will load according to the default “Include” snap options. 

See: To change default snap options. 
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Tap Beat 

The Tap Beat feature enables you to set the Rate/Speed of a Chaser, Q-List or Effect by tapping 

a beat. This is done by either tapping on the Beat key or defining a Tap Beat button to a Playback 

key from the Playback Definitions. Beat pace can be set for all or selected Playbacks. 

 

Using Tap Beat 

The number of beat taps can be set for 2 taps, 4 taps or 8 taps from setting options in the Rate 

toolbar. The Command line will also display the selected Tap Beat option. When you start 

tapping, the Command line will show the amount of beats tapped. 

 

 

 

 

The Tap Beat options 

The following is an explanation of each Tap Beat option: 

 

TAP BEAT 2; enables you to tap 2 beats. The first tap will be the first beat and the 

2
nd

 tap will be the last beat; for example; tap tap 

 

TAP BEAT 4; enables you to tap 4 beats. The first tap will be the first beat with 

the 4
th

 tap being the last; for example; tap tap tap tap 

 

TAP BEAT 8; enables you to tap 8 beats. The first tap will be the first beat with 

the 8
th

 tap being the last, for example; tap tap tap tap tap tap tap tap 

 

 

 

 

Setting the number of taps 

The number of taps can be set once. You can reset the number of taps at any time by accessing 

the Rate toolbar via the RATE key. 

Command line displaying the 

selected Tap Beat option 

Command line displaying the 

amount of beats tapped; 1 beat 

tapped out of 2 
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To set number of taps 

1. Press the RATE key. 

The Command line will display the following: 

 

2. From the Rate toolbar, select a TAP BEAT button; 2, 4 or 8 number of taps: 

 

The Command line will display the selected Tap Beat option, for example: 

 

The console will store the selected Tap Beat setting until a new Tap Beat option is 

chosen. 

 

Setting a Beat using the Beat key 

A beat can be set to; all, single, or multiple playbacks. The following sequences use the BEAT 

key to set a beat. 

Before setting a beat make sure you have some cues running such as an effect or chaser. 

 

To set a beat to all playbacks 

1. Press the RATE key. 

The Command line will display the following: 

 

2. Using the BEAT key tap to a beat to set the beat. 

The beat will be set to all playbacks. 

 

To set a beat to a single or multiple playbacks 

1. Press the RATE key. 

The Command line will display the following: 



Tap Beat 

  43 |  
 

 

2. Select a single or multiple of playbacks to set a beat: 

Single PB sequence [SELECT PB#] 

Multiple PB sequence [SELECT PB#, SELECT PB#, ETC.] 

The Command line will display your selection; for example: 

 

3. Using the BEAT key tap to a beat to set the beat. 

The beat will now be set to the selected PB’s 

 

Assigning Tap Beat to a Playback key 

Tap Beat can be assigned to a Playback or Qkey button from the Playback Definition list which 

can be used on-the-fly during live shows. The definition list can be accessed by selecting a PB 

key from the Settings ► Playback tab OR from the Playback Definitions tab in Qlist properties. 

 

 

When Tap Beat is assigned to a 

PB key, the PB wing will 

display the text “Beat”. 

To assign Tap Beat from System Settings 

1. From the Menu bar select Tools ► Settings ► Playback tab. 

2. Select the Default PB Definitions option: 
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The PB Key options will become active. 

3. Select a PB key to assign Tap Beat: 

 

4. From the Playback keys definition list select Tap Beat. 

Tap Beat be assigned and the selected key option text will change to Tap Beat. 

5. Click Apply to save the change. 

To assign Tap Beat from Qlist Properties 

1. Press [SETUP, PB SELECT#] 

The Qlist Properties dialog will open. 

Select a PB fader key or Q-Key 

to assign Tap Beat. 
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2. Select the Playback Definitions tab: 

 

3. Select a playback key to assign Tap Beat. 

4. From the Playback key definition list select Tap Beat. 

Tap Beat will now be assigned and the selected key option text will change to Tap 

Beat. 

5. Click OK to close the Qlist Properties dialog. 

 

 

 

 

 

Setting a beat using an assigned Tap Beat key 

The following makes use of an assigned Tap Beat key that has been assigned to a playback key. 

See: Assigning Tap Beat to a Playback key 

Before setting a beat make sure you have some cues running such as an effect or chaser.  

 

Select a PB fader key 

to assign Tap Beat. 
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To set a beat with an assigned Tap Beat key 

 Press on the assigned Tap Beat key to set a beat. 
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Go Reverse 

Go Reverse is a new playback control feature that enables you to go in a reverse direction when 

using cues. Go Reverse can be assigned to a PB key or Q-Key and will utilize the fade times of 

cues including; Time-In, Time-Out, Delay-In, Delay-Out and Param-Time. Go Reverse also 

enables you are to go from the first cue to the last cue in a Q-List instead of 0 (zero). 

Example: 

If there are 5 cues in a Q-List, by pressing on the assigned Go Reverse key, you will go back 

from the last cue in the list which is 5, to cue 4, 3, 2 and then to cue 1, then back to cue 5:  

 

 

Assigning Go Reverse to a Key 

Assigning Go Reverse to a PB key or Q-Key is done by selecting the option from the PB Keys 

Behavior list. The behavior list can be accessed by selecting a PB key from the Settings ► 

Playback tab or the Playback Definitions tab in Qlist properties. The PB key text will change to 

Go Reverse once assigned. 

Go Reverse can be assigned only to a PB key on-the-fly from the Qlist properties in which case 

the text GoRev will be displayed in the PB wing. Assigning Go Reverse from the System 

Settings will only be applied to new assignments. 

Go Reverse in the PB Keys 
Behavior list  

Example of a PB Key 
assigned to Go Reverse  

Example of GoRev text on 
the PB wing 

   

Using Go Reverse to go 

from first cue to last cue in 

the list 
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To assign Go Reverse from System Settings 

1. From the Menu bar select Tools ► Settings ► Playback tab. 

2. Select the Default PB Definitions option: 

 

The PB Key options will become active. 

3. Select a PB key to assign Go Reverse: 

 

4. From the PB Keys Behavior list select Go Reverse. 

Go Reverse be assigned and the selected key option text will change to Go Reverse. 

5. Click Apply to save the change. 

Select a PB fader key or Q-Key 

to assign Go Reverse. 
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To assign Go Reverse from Qlist Properties 

1. Press [SETUP, PB SELECT #] 

The Qlist Properties dialog will open. 

2. Select the Playback Definitions tab: 

 

3. Select a playback key to assign Go Reverse. 

4. From the Playback Key behaviour list select Go Reverse: 

Go Reverse will now be assigned and the selected key option text will change to Go 

Reverse. 

5. Click OK to close the Qlist Properties dialog. 

 

 

 

 

 

Go Reverse Sequences and Tips 

The following is list of Go Reverse sequences and what they do: 

Select a PB fader key 

to assign Go Reverse. 
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Sequence What is does… 

[GO REVERSE] Cue will fade to the previous cue in the Q-List with 

its cue times. 

[CUE, #, SELECT, GO REVERSE] Cue will fade to the previous cue in the Q-List with 

its cue time and will disregard the requested 

pending cue. 

[SHIFT + GO REVERSE] When using Go Reverse while holding down the 

Shift key will cause the fade to occur in zero time. 
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Group Selection and Release via PB 

Fixtures can now be selected and/or released by pressing on an assigned PB key or Q-Key. A key 

can either be assigned to function as a Group Selection or Group Release key. Content can be 

selected whether the PB fader is active or not. 

 Group Selection will select all content (Channels, Spots, etc.) on a cue or temp cue. 

 Group Release will release selected content from the editor. 

In order to use Group Selection or Group Release; Cue’s, Temp-Cue’s etc. should be first created 

on the PB’s. 

  

Example of Group Selection 

PB 1 has 5 Fixtures (1-5) and PB 2 has 5 Fixtures (6-10): 

 

The following PB keys have been 

assigned to Group Selection: 

 
 

 

If you select the assigned Group Selection key on PB 1 ,the group of Fixtures 

1- 5 will be selected: 

       

 

 

Fixtures 1-5 on PB 1 

Fixtures 6-10 on PB 2 

Group 

Selection 

assigned 

PB keys 

Selected content on PB 1 
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Example of Group Release 

PB 1 has 5 Fixtures (1-5) with editor values: The following key on PB has been 

assigned to Group Release: 

 
 

 

If you select the assigned Group Release key on PB 1, the group of selected Fixtures 

will be released from the Editor:  

   

 

 

Note: The Fixtures will still be selected, moving any parameter wheel 
will re-select the released fixtures. 

 

 

 

 

 

 

 

PB 1 Fixtures with editor values 

Group 

Release 

assigned PB 
key 

 

PB 1 Fixtures have been released from 

the editor 
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Assigning Group Selection or Group Release to a Key 

Assigning Group Selection or Group Release to a PB key or Q-Key is done from the PB Key 

behavior list. The behavior list can be accessed by selecting a PB key or Q-Key from the 

Settings ► Playback tab or the Playback Definitions tab in Qlist Properties. The key text will 

change according to the function selected. 

Group Selection and Group Release can be assigned only to a PB key on-the-fly from the Qlist 

properties in which case the text GrpRel or GrpSel will be displayed in the PB wing. Assigning 

them from the System Settings will only apply to new assignments. 

 

Group Selection and Group Release  in 
the PB Keys Behavior list  

Example of an assigned 
PB Key  

Example of GrpSel and GrpRel  
text in the PB wing 

  

 

GrpSel = Group Selection 

GrpRel = Group Release 
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To assign Group Selection or Release from System Settings 

1. From the Menu bar select Tools ► Settings ► Playback tab. 

2. Select the Default PB Definitions option: 

 

The PB Key options will become active. 

3. Select a PB key to assign. 

 

 

 

Select a PB key or 

Q-Key to assign 

either Group 

Selection or Group 

Release. 
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4. From the PB Keys Behavior list select either Group Selection or Group 

Release. 

The new function will be applied to the key and the text name will change. 

5. Click Apply to save the change. 

 

 

To assign Group Selection or Release from Qlist Properties 

1. Press [SETUP, PB SELECT#]. 

The Qlist Properties dialog will open. 

2. Select the Playback Definitions tab: 

 

3. Select a PB key to assign. 

4. From the PB Key behaviour list select either Group Selection or Group Release. 

The new function will be applied to the key and the text name will change. 

5. Click OK to close the Qlist Properties dialog. 

 

 

Select a PB key to assign 

either Group Selection or 

Group Release. 
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System Lock 

The system lock feature enables you to lock the console using a 1 to 10 digit code. Once locked, 

all panel keys, controllers, screens and access to windows will be disabled, except the numeric 

keypad, enter and protect buttons.  

 

Using System Lock 

Locking and unlocking the system is done using the Protect key. A 1-10 digit code needs to be 

chosen each time you lock the system. The same code will be used to unlock the system. Once 

the system is locked, a Protect Mode message is displayed stating that the system is locked. This 

activity is also seen on the command line with the text [LOCKED]: 

 

 

 

Administrator Passcode 

In case of a forgotten passcode, the administrator passcode can be used. This is a 6 digit code 

that has been hard-coded in the system and cannot be changed.  

The Administrator passcode is: 123456 

 

 

Note: Turning the Console OFF and ON will unlock the system. 
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To lock system 

1. Press PROTECT. 

The Command line will display the text [PROTECT]: 

 

2. Using the numeric keypad, enter a passcode of 1-10 digits. 

Example: 12233 

The command line will display the passcode in the form of a star *. 

 

3. Press ENTER. 

The Protect Mode pop-up will appear confirming that the system is now locked. This 

can also be seen in the command line with the text [LOCKED] 

 

To unlock system 

1. Press PROTECT 

The command line will display the text [PROTECT]: 

 

2. Using the numeric keypad, enter the passcode. 

The command line will display the passcode in the form of a star *. 

3. Press ENTER. 

The Protect Mode pop-up will disappear indicating the system is now unlocked. 

If the passcode is incorrect, an INCORRECT PASSWORD message will appear in the 

command: 
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Version Highlights 

1. Editing  

1.1. User Defined Curves 8 User Defined curves have been added which 

can be edited accordingly.  

2. Playback  

2.1. Enhanced Move Function Playbacks can now be moved to Playbacks on-

the-fly. 

2.2. New Snap Options  New snap options have been added which 

enable you to store a current master PB and/or 

current page number to a snap. 

2.3. Tap Beat Tap Beat enables you to set the Rate speeds by 

tapping on the BEAT button. 

2.4. Go Reverse Go Reverse is a new playback control feature 

that enables you to go in a reverse direction 

when using cues. 

2.5. Group Selection and 
Release via PB 

Fixtures can now be selected and/or released 

by pressing on an assigned PB key or Q-Key. 
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Important Bug Fixes – Vector Software 3.19R02 

 Snaps that were saved with running/off status did not come up as “Saved”. This has been 

fixed. Thanks to Stephen Plotkin, Canada. 

 A Macro with Freeze Effect did not unfreeze on the second pass. Now only one Macro 

can be used to freeze and unfreeze. Thanks to Moshiko Pe’er, Israel. 

 Assigning or storing a range of cues to a range of playbacks did not work properly; 

instead it was spreading the cues to Qkeys. This has been fixed. Thanks to Gerhard 

Feiner, Germany. 

 If the Autosave folder was moved or changed from the Vector Shows folder, an error 

message occurred. This has been fixed and now the system will auto create the Autosave 

folder again. Thanks to Eli Osawa, Tokyo. 

 Copying a fixture or parameter did not work properly especially when selecting groups. 

This has been fixed. Thanks Bill Peachment, UK. 

 When attempting to update a Library on a show that was saved on an older software 

version, produced an error message which was related to Mark-Cue. This has fixed. 

Thanks to Gino DeLeo, David Winnik, Ronen Ben-Harosh, Italia, Israel. 

 When assigning Delay In/Out times with a value smaller than 1 sec and using the decimal 

dot (.), the result was a wrong value. This has been fixed. Thanks to Uri Morag, Israel. 

 On some occasions, Vector did not download more than 180 thumbnails from Arkaos' 

Media-Master. This has been fixed. 

 On Vector orange, when loading a show that had DMX-In + Art-Net or DMX-In + ACN 

enabled, caused a windows crash. This has been fixed. Thanks to Orit Freedman, 

Holland. 

 There was a crash using the sequence [FIXTURE, #, VIRTUAL DIMMER, @, RED, 

Spin wheel] on a device that was using a virtual dimmer. This has been fixed. Thanks to 

Stephen Plotkin, Canada. 

 When loading a show from a previous version that had an infinite time setup to control 

parameter, caused the infinite time to be around 10 minutes. This has been fixed. Thanks 

to Pekka Rytilahti, Finland. 

 The Park sequence was always selecting the whole fixture. Now it is possible to select 

specific parameter/s that will be parked. This is done by the sequence:[FIXTURE, #, (→, 

#), Move values, PARAM, PARAM,… (To select the parameters in RED), 

SHIFT+PARK, STORE]. This sequence will also work to release parameters from park. 

Thanks to Moshiko Peer and Speedy Cole, Israel & Matthias Kern, Switzerland. 
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 When working in Multi-Editors mode with the option "Take Multi-Editors" activated, 

then updating objects did not take all the editors. Now when this flag is enabled, updating 

objects will use all editors. 

 When examining a PB after the key "PB/QKey Display" was pressed, the content of the 

exam was incorrect. This has been fixed. Thanks to Raphael from Crystal, France. 

 The Automatic Parameter Grouping flag from the Editing tab in the system settings was 

not applied after exiting the System Settings. This has been fixed. Thanks to Orit 

Freedman, Holland. 

 The sequence of releasing fixtures from Sub-Masters did not work on some occasions. 

This has been fixed. Thanks to Filip Wiesner, Austria. 

 Wheel assignments did not page correctly when there were spaces between the 

parameters on the wheels. Now paging will page exactly as stored in the device. Thanks 

to Bonder, Israel. 

 If a device had no Dimmer, Virtual Dimmer or RGB parameter patched, it caused odd 

behavior to the system. This has been fixed. Thanks to David Bishop, UK. 

 The sequence of [CUE, #, NEXT/PREV] did not work if the # (cue number) did not exist. 

Now when doing this sequence on a non-existing cue and pressing NEXT/PREV then it 

will give the nearest cue next/prev to the number that was entered. Thanks to Aviram 

Shahinu, Israel. 

 It was not possible to see 16 bit color parameters in the Matrix-List live view. This has 

been fixed. Thanks to Jerry Roberto Romani, Italy & David Bishop, UK. 
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Text Conventions 

The following text conventions exist in this document: 

 The actual keys on the console panel are referred to as KEYS. Panel KEYS are in BOLD 

CAPS. 

 The keys on the touch screens are referred to as BUTTONS. Touch screen BUTTONS are 

BOLD ITALICIZED CAPS. 

 Dialog boxes, Window titles and field names appear in this font. 

 Sequences appear like this; [SEQUENCE, SEQUENCE]. 

 The word “Click” also refers to “tap”. This depends if you are using the mouse to “click” 

or “tapping” on the touch screen. 
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User Defined Curves 

8 User Defined curves have been added which can be edited using the windows interface. User 

Defined curves can be applied to a dimmer the same way you apply the factory curves. See: 

Editing DMX channel properties on page 76 in the Vector Reference Guide. 

A new folder called “Curves” has been added to the Patch folder in the Workspace tree. The 

folder contains factory and user defined curves. Clicking on the Curves folder in the Workspace 

Tree will also display the curves in a grid window, and will indicate which curves can be edited 

or not; (Yes / No). 

Editing of User Defined curves can only be done from the Patch Manager.  

 

 

 

 

 

 

 

 

 

 

 

No: 

Curves 

cannot 

be edited 

Yes: 

Curves 

can be 

edited 
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Editing User Defined Curves 

Curve names and points can be edited and saved to a show. Curves can contain up to 255 curve 

points (Min is 2 points). Factory curves can also be copied and pasted into user defined curve 

and then edited. 

Curves are edited by adding and moving active points. Active points are white and non-active 

points are blue: 

 

 

Graph Editing Controls 

The following is list of graph editing controls and what they do: 

Controls What it does… 

 

These controls are used to move the active point to the next or previous point 

on the graph. 

 

These shows the Input and Output points of the curve. 

 

 

Active Point 

is white 

Non Active Point 

is blue 
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Controls What it does…(Cont.) 

 

 

 

This will add a point to the left of the active point. The point will be added in 

the middle of the two points: 

Example:  

 

 

 

 

 

 

This will delete an active point only. Click on a point to make it an active 

point and then press the delete button. 

 

This will add a point to the right of the active point. The point will be added 

in the middle of the two points: 

Example:  

 

 

 

 

 

 

Hide or show grid icon. 

 

Copy From enables you to copy a curve from either Factory curves or User 

defined curves and automatically pastes it to the current open User defined 

window. 

 

 

 

 

 

 

 

Point 2 

Active Point 

Point 1 Point 3 

The new point will be added in the middle of point 1 and point 2. (To the left 

of point 2 – Active point) 

Note the 

light 

shade  

Point 2 

Active Point 

Point 1 Point 3 

The new point will be added in the middle of point 2 and point 3. (To the 

right of point 2 – Active point) 

Note 

the 

light 

shade  
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To edit a user defined curve 

1. Open the Patch Manager; Tools ► Patch Manager. 

2. Open the Workspace Tree. 

3. From the Workspace Tree click on the Patch folder to display the Patch list. 

4. Scroll down the list until you reach the Curves folder. 

5. From the Curves folder select a User defined curve to edit. 

 

 

 

 

Select a User 

Defined curve to 

edit. 
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The User Defined curve window will open. 

Example: 

User Define1 was selected: 

 

6. Add points to the graph using the plus button;  or . 

For example; one point was added using the right plus button: 

 

Point was added in 

the middle of point 

1 and point 2  

Point 1 

Point 2 

Active point (White Point) 
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TIP! You can add a point by double clicking the mouse on the graph line. 

 

7. Using the mouse, left click and hold on the active point and drag the point to the 

desired location: 

Example: 

 

 

TIP! You can use the arrow keys on the keyboard for moving the point to a 
more accurate value: 

Using the mouse, left click on the point to move, and then use the keyboard 

arrow keys to move the point.  

8. To add more points go back to step 6.  

9. Save the curve by clicking on the tick button on the Patch Manager toolbar: 

 

Press to 

save curve 
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To name a curve 

1. Open the Patch Manager; Tools ► Patch Manager. 

2. Open the Workspace Tree. 

3. From the workspace tree click on the Patch folder to display the Patch list. 

4. Scroll down the list until you reach the Curves folder. 

5. Select the Curves folder. 

A window will appear with all the curves in a grid form: 

 

6. Double click on the User Define curve you want to name. 

Example: 

 

7. Type in the name of the curve. 

8. Save the curve name by clicking on the tick button on the Patch Manager toolbar: 

 

Double click to 

name curve 



User Defined Curves  

     | 12 

The curve name will be changed in the Workspace Tree and the Curve grid: 

Example: 

 

 

To copy a curve 

1. Open the Patch Manager; Tools ► Patch Manager. 

2. Open the Workspace Tree. 

3. From the Workspace Tree click on the Patch folder to display the Patch list. 

4. Scroll down the list until you reach the Curves folder. 

5. From the curves list select a User Defined curve that you want to copy a curve to. 

The User Defined curve window will open. 

6. From the Curve editing toolbar select the Copy From button. 

A Copy From drop down menu will be displayed: 
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7. From the Copy From drop down menu select where you want to copy the curve from; 

either Factory curves or User curves, then select the actual curve you want to copy. 

Example: In this example we will copy from Factory curves and select the S-Curve: 

 

Once you select the curve it will be immediately copied into the User Defined curve: 

Example: Factory curve; S-Curve was copied into User Define 1: 

 

8. The curve can now be edited and named; See To edit a user defined curve 

9. Save the curve by clicking on the tick button  on the Patch Manager toolbar.  

Factory Curve: S-Curve 
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Moving Playbacks to Playbacks 

The Move function has been enhanced to enable you to move a single playback to another 

playback or a range of playbacks to a range of playbacks on-the-fly. This is now achieved by 

using the SELECT key. Playback Definitions and fader position (if motorized) of a selected 

playback will also move to the new location. 

 

What Playbacks can be moved? 

Single, multiple or a range of PB’s can be selected and moved. All playbacks are movable; for 

example: 

 PB’s to PB’s and QK’s  

 QK’s to QK’s, PB’s  

 

 

Note the following:  

 Assignments cannot be moved to and from the A/B. 

 A mixed selection is not movable; for example, PB and QK. 

 

Example of moving PB’s  

4 PB’s have been setup with the following: 

 PB 2/1; Qlist 3 with Playback Definition defined as GoRev (Go Reverse) 

 PB 2/2; Chaser (Qlist 4) with Playback Definition defined as Rls (Release) 

 PB 2/3; Qlist 5 with Playback Definition defined as GoRev (Go Reverse) 

 PB 2/4; Temp Cue with Playback Definition defined as Hld/Bck (Hold/ Back)  

Move PB 2/2 and PB 2/3 to PB 2/6 and PB 2/7 which are empty: 
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Use the sequence: 

[SHIFT, MOVE, SELECT PB 2, SELECT PB 3, SELECT PB 6]  

 

The above sequence will move the selected PB’s (PB 2/2 and PB 2/3) to PB 2/6 and PB 2/7: 

 

 

In the above example, you can see that the Playback Definitions of the PB’s (Rls and GoRev) are 

also moved to the new PB location. 

 

Sequences to Move a Playback to an Empty Playback 

When using the following sequences, the last SELECT in the sequence is the destination PB: 

[SHIFT, MOVE, SELECT #, SELECT#] This will move a single PB.  

[SHIFT, MOVE, SELECT#, SELECT#, SELECT#, 

ETC.] 

This will move multiple PB’s.  

[SHIFT, MOVE, SELECT #, ,#, SELECT #] This will move a range of PB’s.  
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Moving a Playback to an occupied Playback 

Playbacks can also be moved to occupied playbacks by using the @ key. When a playback is 

occupied an “Occupied!” dialog will appear with options to; Overwrite All, Swap or Cancel. 

 Overwrite All – This will overwrite all the existing PB information with the new PB 

information. 

 Swap – This swap the PB information around. 

 Cancel – This will cancel the operation. 

 

 

Sequences to Move a Playback to an occupied Playback 

The @ key is used when moving a PB to an occupied PB. The last SELECT in the sequence is 

the occupied destination PB. 

[SHIFT, MOVE, SELECT#, @, SELECT#] This sequence will move a single PB 

to an occupied PB.  

[SHIFT, MOVE, SELECT#, SELECT#, SELECT#, @, 

SELECT#] 

This sequence will move multiple 

PB’s to an occupied PB.  

[SHIFT, MOVE, SELECT#, , #, @, SELECT#] This sequence will move a range of 

PB’s to an occupied PB.  
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Illegal Destination error 

When moving a range to a destination that overlaps the selected range, for example; moving 

1→5 to 3, an error message will appear in the command line “ILLEGAL DESTINATION” 

 

 

Destination Limit Exceeded error 

When moving a range to a destination that exceeds its limits, an error message will appear in the 

command line; “DESTINATION LIMIT EXCEEDED! SELECT A NEW DESTINATION”. The 

range will still be on the clipboard allowing you to select a new destination.  

 

Example: 

If you select a range of PB’s and move them to Channel 10 on page 10, the destination range will 

be exceeded as there is NO page 11. 

 

Moving Playbacks to Qkeys and visa-versa 

Playbacks can be moved to Qkeys and visa-versa by using the following sequences: 

[SHIFT, MOVE, SELECT PB#, QKEY#] This will move a single PB to a QK. 

[SHIFT, MOVE, SELECT PB#, SELECT PB#, 

SELECT PB#, QKEY#] 

This will move multiple PB’s to QK’s  

[SHIFT, MOVE, SELECT PB#, , SELECT PB#, 

QKEY#] 

This will move a range of PB’s to QK’s 
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New Snap Options 

New Snap options have been added called “Include Current Master PB” and “Include Current 

Page #” which enable you to store the current master PB and/or current page number when 

storing a snap. A new snap option toolbar has been added for this purpose which is activated 

every time the Snap key is pressed. 

The snap options have also been added to the Snap Options section in the System Settings 

(System Settings ► Playback tab), enabling you to set the snap option defaults for a show. The 

default snap option will then always be triggered when a Snap key is pressed.  

You can toggle between options on-the-fly by using the Snap Options toolbar without affecting 

the snap default settings.  

The Snap options will always be restored when a “New Show” is selected. 

 

New Snap Options Toolbar New Snap Options in Systems Settings 
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Using the New Snap Options 

The following explains the storing and loading of snaps using the new snap options: 

Snap Option Storing Loading 

INCLUDE CURRENT MASTER PB When this option is 

enabled, the current master 

PB will be stored in the 

snap. 

When this option is 

enabled, the stored master 

PB will be loaded to the 

snap. 

INCLUDE CURRENT PAGE # When this option is 

enabled, the current page 

number will be stored in 

the snap. 

When this option is 

enabled, the stored page 

number will be loaded to 

the snap. 

Both snap options can be enabled for storing and loading. 

 

Viewing the Stored Snap Information 

When the new snap options are enabled, the stored snap information can be viewed from the 

snap view window: 

  

 

 

 

 

Stored Master PB Number 

 

Stored Page Number 

 

If a snap is stored with a snap option off, the text “None” will appear in the 

relevant cell. 
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Default Snap Options 

Changing the default options will only be applied to new assignments. The Snap “Include” 

default settings also affect how a snap is loaded. 

 

To change default snap options 

1. From the menu bar select Tools ► Settings ► Playback tab. 

2. Under Snap Options enable or disable the desired “Include” option: 

 

3. Click Apply to apply the new default setting. 

4. Click OK to exit System Settings. 
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Storing Master PB and/or Page number in Snap 

Storing snaps using the “Include” options can be done on-the-fly or by using the “Include” 

options default settings. See: Default Snap Options 

 

Note: The sequences below use Action Mode. When using Enter Mode, end a 

sequence with ENTER.  

 

To store Master PB and/or Page number in a snap 

Use the following sequence to perform operations on-the-fly: 

1. Press SNAP. 

The snap toolbar will be displayed: 

 

2. Enter a number on the numeric keypad. 

3. Select a desired “Include” option to enable or disable. 

4. Press STORE. 

 

Use the following sequence to perform operations using the default snap settings: 

1. Press STORE. 

2. Select a number on the snap soft keys. 

The snap will be stored using the default “Include” options. See: To change default 

snap options. 
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Loading a Snap with Include Master PB and/or Page Number 

Loading snaps stored with Include Master PB and/or Page Number can be done on-the-fly or by 

using the “Include” default settings. See: Default Snap Options. 

 

To load a snap with Master PB and/or Page Number 

Use the following sequence to perform operations on-the-fly: 

1. Press SNAP. 

The snap toolbar will be displayed: 

 

2. Select a desired “Include” option. 

3. Select a stored snap from the soft keys. 

 

-OR- 

 

1. Press SNAP. 

The snap toolbar will be displayed: 

 

2. Enter a snap number on the numeric keypad. 

3. Select the desired “Include” option. 

4. Press ENTER. 

 

Use the following to perform operations using the default snap settings: 

 Select a stored snap from the soft keys. 

The snap will load according to the default “Include” snap options. 

See: To change default snap options. 
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Tap Beat 

The Tap Beat feature enables you to set the Rate/Speed of a Chaser, Q-List or Effect by tapping 

a beat. This is done by either tapping on the Beat key or defining a Tap Beat button to a Playback 

key from the Playback Definitions. Beat pace can be set for all or selected Playbacks. 

 

Using Tap Beat 

The number of beat taps can be set for 2 taps, 4 taps or 8 taps from setting options in the Rate 

toolbar. The Command line will also display the selected Tap Beat option. When you start 

tapping, the Command line will show the amount of beats tapped. 

 

 

 

 

The Tap Beat options 

The following is an explanation of each Tap Beat option: 

 

TAP BEAT 2; enables you to tap 2 beats. The first tap will be the first beat and the 

2
nd

 tap will be the last beat; for example; tap tap 

 

TAP BEAT 4; enables you to tap 4 beats. The first tap will be the first beat with 

the 4
th

 tap being the last; for example; tap tap tap tap 

 

TAP BEAT 8; enables you to tap 8 beats. The first tap will be the first beat with 

the 8
th

 tap being the last, for example; tap tap tap tap tap tap tap tap 

 

 

 

 

Command line displaying the 

selected Tap Beat option 

Command line displaying the 

amount of beats tapped; 1 beat 

tapped out of 2 
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Setting the number of taps 

The number of taps can be set once. You can reset the number of taps at any time by accessing 

the Rate toolbar via the RATE key. 

 

To set number of taps 

1. Press the RATE key. 

The Command line will display the following: 

 

2. From the Rate toolbar, select a TAP BEAT button; 2, 4 or 8 number of taps: 

 

The Command line will display the selected Tap Beat option, for example: 

 

The console will store the selected Tap Beat setting until a new Tap Beat option is 

chosen. 

 

Setting a Beat using the Beat key 

A beat can be set to; all, single, or multiple playbacks. The following sequences use the BEAT 

key to set a beat. 

Before setting a beat make sure you have some cues running such as an effect or chaser. 

 

To set a beat to all playbacks 

1. Press the RATE key. 

The Command line will display the following: 

 

2. Using the BEAT key tap to a beat to set the beat. 

The beat will be set to all playbacks. 
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To set a beat to a single or multiple playbacks 

1. Press the RATE key. 

The Command line will display the following: 

 

2. Select a single or multiple of playbacks to set a beat: 

Single PB sequence [SELECT PB#] 

Multiple PB sequence [SELECT PB#, SELECT PB#, ETC.] 

The Command line will display your selection; for example: 

 

3. Using the BEAT key tap to a beat to set the beat. 

The beat will now be set to the selected PB’s 

 

Assigning Tap Beat to a Playback key 

Tap Beat can be assigned to a Playback or Qkey button from the Playback Definition list which 

can be used on-the-fly during live shows. The definition list can be accessed by selecting a PB 

key from the Settings ► Playback tab OR from the Playback Definitions tab in Qlist properties. 

 

 

When Tap Beat is assigned to a 

PB key, the PB wing will 

display the text “Beat”. 
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To assign Tap Beat from System Settings 

1. From the Menu bar select Tools ► Settings ► Playback tab. 

2. Select the Default PB Definitions option: 

 

The PB Key options will become active. 

3. Select a PB key to assign Tap Beat: 

 

4. From the Playback keys definition list select Tap Beat. 

Tap Beat be assigned and the selected key option text will change to Tap Beat. 

5. Click Apply to save the change. 

Select a PB fader key or Q-Key 

to assign Tap Beat. 
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To assign Tap Beat from Qlist Properties 

1. Press [SETUP, PB SELECT#] 

The Qlist Properties dialog will open. 

2. Select the Playback Definitions tab: 

 

3. Select a playback key to assign Tap Beat. 

4. From the Playback key definition list select Tap Beat. 

Tap Beat will now be assigned and the selected key option text will change to Tap 

Beat. 

5. Click OK to close the Qlist Properties dialog. 

 

 

 

 

 

Select a PB fader key 

to assign Tap Beat. 
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Setting a beat using an assigned Tap Beat key 

The following makes use of an assigned Tap Beat key that has been assigned to a playback key. 

See: Assigning Tap Beat to a Playback key 

Before setting a beat make sure you have some cues running such as an effect or chaser.  

 

To set a beat with an assigned Tap Beat key 

 Press on the assigned Tap Beat key to set a beat. 
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Go Reverse 

Go Reverse is a new playback control feature that enables you to go in a reverse direction when 

using cues. Go Reverse can be assigned to a PB key or Q-Key and will utilize the fade times of 

cues including; Time-In, Time-Out, Delay-In, Delay-Out and Param-Time. Go Reverse also 

enables you are to go from the first cue to the last cue in a Q-List instead of 0 (zero). 

Example: 

If there are 5 cues in a Q-List, by pressing on the assigned Go Reverse key, you will go back 

from the last cue in the list which is 5, to cue 4, 3, 2 and then to cue 1, then back to cue 5:  

 

 

Assigning Go Reverse to a Key 

Assigning Go Reverse to a PB key or Q-Key is done by selecting the option from the PB Keys 

Behavior list. The behavior list can be accessed by selecting a PB key from the Settings ► 

Playback tab or the Playback Definitions tab in Qlist properties. The PB key text will change to 

Go Reverse once assigned. 

Go Reverse can be assigned only to a PB key on-the-fly from the Qlist properties in which case 

the text GoRev will be displayed in the PB wing. Assigning Go Reverse from the System 

Settings will only be applied to new assignments. 

Go Reverse in the PB Keys 
Behavior list  

Example of a PB Key 
assigned to Go Reverse  

Example of GoRev text on 
the PB wing 

   

Using Go Reverse to go 

from first cue to last cue in 

the list 
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To assign Go Reverse from System Settings 

1. From the Menu bar select Tools ► Settings ► Playback tab. 

2. Select the Default PB Definitions option: 

 

The PB Key options will become active. 

3. Select a PB key to assign Go Reverse: 

 

4. From the PB Keys Behavior list select Go Reverse. 

Go Reverse be assigned and the selected key option text will change to Go Reverse. 

5. Click Apply to save the change. 

Select a PB fader key or Q-Key 

to assign Go Reverse. 
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To assign Go Reverse from Qlist Properties 

1. Press [SETUP, PB SELECT #] 

The Qlist Properties dialog will open. 

2. Select the Playback Definitions tab: 

 

3. Select a playback key to assign Go Reverse. 

4. From the Playback Key behaviour list select Go Reverse: 

Go Reverse will now be assigned and the selected key option text will change to Go 

Reverse. 

5. Click OK to close the Qlist Properties dialog. 

 

 

 

 

 

Select a PB fader key 

to assign Go Reverse. 
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Go Reverse Sequences and Tips 

The following is list of Go Reverse sequences and what they do: 

Sequence What is does… 

[GO REVERSE] Cue will fade to the previous cue in the Q-List with 

its cue times. 

[CUE, #, SELECT, GO REVERSE] Cue will fade to the previous cue in the Q-List with 

its cue time and will disregard the requested 

pending cue. 

[SHIFT + GO REVERSE] When using Go Reverse while holding down the 

Shift key will cause the fade to occur in zero time. 
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Group Selection and Release via PB 

Fixtures can now be selected and/or released by pressing on an assigned PB key or Q-Key. A key 

can either be assigned to function as a Group Selection or Group Release key. Content can be 

selected whether the PB fader is active or not. 

 Group Selection will select all content (Channels, Spots, etc.) on a cue or temp cue. 

 Group Release will release selected content from the editor. 

In order to use Group Selection or Group Release; Cue’s, Temp-Cue’s etc. should be first created 

on the PB’s. 

  

Example of Group Selection 

PB 1 has 5 Fixtures (1-5) and PB 2 has 5 Fixtures (6-10): 

 

The following PB keys have been 

assigned to Group Selection: 

 
 

 

If you select the assigned Group Selection key on PB 1 ,the group of Fixtures 

1- 5 will be selected: 

       

 

 

Fixtures 1-5 on PB 1 

Fixtures 6-10 on PB 2 

Group 

Selection 

assigned 

PB keys 

Selected content on PB 1 
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Example of Group Release 

PB 1 has 5 Fixtures (1-5) with editor values: The following key on PB has been 

assigned to Group Release: 

 
 

 

If you select the assigned Group Release key on PB 1, the group of selected Fixtures 

will be released from the Editor:  

   

 

 

Note: The Fixtures will still be selected, moving any parameter wheel 
will re-select the released fixtures. 

 

 

 

 

 

 

 

PB 1 Fixtures with editor values 

Group 

Release 

assigned PB 
key 

 

PB 1 Fixtures have been released from 

the editor 
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Assigning Group Selection or Group Release to a Key 

Assigning Group Selection or Group Release to a PB key or Q-Key is done from the PB Key 

behavior list. The behavior list can be accessed by selecting a PB key or Q-Key from the 

Settings ► Playback tab or the Playback Definitions tab in Qlist Properties. The key text will 

change according to the function selected. 

Group Selection and Group Release can be assigned only to a PB key on-the-fly from the Qlist 

properties in which case the text GrpRel or GrpSel will be displayed in the PB wing. Assigning 

them from the System Settings will only apply to new assignments. 

 

Group Selection and Group Release  in 
the PB Keys Behavior list  

Example of an assigned 
PB Key  

Example of GrpSel and GrpRel  
text in the PB wing 

  

 

GrpSel = Group Selection 

GrpRel = Group Release 
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To assign Group Selection or Release from System Settings 

1. From the Menu bar select Tools ► Settings ► Playback tab. 

2. Select the Default PB Definitions option: 

 

The PB Key options will become active. 

3. Select a PB key to assign. 

 

 

 

Select a PB key or 

Q-Key to assign 

either Group 

Selection or Group 

Release. 
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4. From the PB Keys Behavior list select either Group Selection or Group Release. 

The new function will be applied to the key and the text name will change. 

5. Click Apply to save the change. 

 

 

To assign Group Selection or Release from Qlist Properties 

1. Press [SETUP, PB SELECT#]. 

The Qlist Properties dialog will open. 

2. Select the Playback Definitions tab: 

 

3. Select a PB key to assign. 

4. From the PB Key behaviour list select either Group Selection or Group Release. 

The new function will be applied to the key and the text name will change. 

5. Click OK to close the Qlist Properties dialog. 

 

 

Select a PB key to assign 

either Group Selection or 

Group Release. 
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SEE Quick Access to MACRO’s 
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IMPORTANT NOTES!! 

Please note the following before continuing! 

In this version we added more options to the System Settings. 

The following list is new options that are disabled by default (Previously they were always 

enabled); this is relevant for new shows and saved shows from previous software versions: 

 The Remote Control is now DISABLED by default. See Remote Control Enable / 
Disable 

 SMPTE and MTC new buttons are DISABLED by default. Any external trigger (SMPTE 

or MIDI Time Code) will be ignored unless you enable the relevant SMPTE or MIDI 

Time Code button. See SMPTE Midi Enable / Disable  

 “Activate Snap On Load” is DISABLED by default. Saved shows from previous 

versions will be loaded to the default setting. See Vector Snap Enhancements 

We recommend using 2GB of RAM for better performance while 

using this version on Vector PC. (3.19) 
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Version Highlights 

In this version we added more than 40 new devices and updated 80: 

1. Display  

1.1. View Properties Button  

 

A new View Properties button was added to 

the pane title of any grid or soft key view:   

 

1.2. Master PB Indication Enhancement The Playback key on the Faders Mode can be 

used to display the Master PB on the Faders 

Mode LCD. 

1.3. Clock and Date View A Digital and Analog clock was added 

together with a Date view. 

2. Matrix  

2.1. Live Matrix Zoom Function You now have full zoom function control 

while in Live view; Zoom in/out and Fit To 

Screen. These controls are found on the pane 

title of the Matrix programmer live view. 

2.2. Increased Matrix Width / Height in 
the Patch manager 

The Matrix width or Height can now be 

increased to 10,000.  The max cells 

width/height is still 40,000. 

2.3. Clear Selection A Clear Selection button was added to the 

Matrix Programmer. Now you can clear a 

selection by a click of a button: 

  

See Vector Reference Guide;  

Chapter 11, Page 292 on how to display the 
Matrix programmer. 

3. Editing  

3.1. Vector @ Key Enhancement This enables only the dimmer intensity 

parameter value to be affected each time you 

use the @ Key. 
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3.2. Fan Enhancements 

3.2.1. Fan From Step to Step 

 You are now able to activate the Fan 

mode by selecting the Fixture’s, then 

pressing the Fan key. 

 Now you can change a range of 

Fixtures while in Fan mode. 

 You can Fan from one step to another 

using the Step Picker (Color Wheel 

Picker, Gobo Picker and Media Server 

Picker etc.) 

 Now you are able to go from value to 

value using a shorter sequence. 

3.3. Prohibit Mark Cue Vector will now protect Mark cues from being 

manipulated. However you can still edit the 

timing properties and the name of the mark 

cue.  

3.4. Move Function  The Move function enables you to 

move objects such as cue’s, groups, 

libraries etc.  

 More sequences where added for Copy 

and Cut in Enter Mode Syntax. 

3.5. Effect Editor Improvements 

 

 

 

 Now you can assign an exact value 

using the keypad. 

 The Release button has been 

enhanced. 

 A Pre Build effect can now be run on 

parameters of the same type, example; 

RGB 

4. Playback  

4.1. Direct PB operations You are now able to do PB operations, for 

example; assign Qlists, release PB’s etc., 

directly from the PB wing view.  

4.2. Vector Snap Enhancements A new option was added that enables you to 

choose if the PB will be released or activated 

when loading a show, for example; “Activate 

the snap on load”.   
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5. Patch Manager  

5.1. Apply and Continue Wizard Now you are able to apply a patch and 

continue working in the same wizard dialog 

without re-opening the wizard after every 

operation. 

6. System Settings  

6.1. SMPTE Midi Enable / Disable  You now have the ability to control 

the signals from SMPTE, MTC, MIDI 

In and MIDI Out. 

 A larger clock view was added to the 

active TimeLine view screen.  

6.2. Remote Control Enable / Disable 

 

 

 

A Remote Control Application’s option was 

added to allow you to enable or disable the 

ability for an external application to connect 

to the console. This option can be found in the 

Network tab: 

Tools ► System Settings ► Network 

The Remote Control Application’s option is 

DISABLED by default. Enable the option so 

that an external application can connect. 

(iControl, iControl App & Remote PC Panel). 

 

 

You will still be able to see the console in 
the console list on the remote application, 
however, the console will NOT respond 
until you ENABLE the remote control in 
that console. 

Note: External hardware (Editor, 

Playback and Channel wing), can still be 

connected to the console if the Remote 

Control Application’s option is either enabled 

or disabled. 
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7. Desktop  

7.1. Desktop Enhancements  A bunch of new desktop enhancements where 

added: 

 Stage Element support: 

There are 16 elements that can be 

dragged onto the Desktop. Each 

element can be manipulated to change 

size, angel, line thickness and line 

color. 

 Ability to add shortcuts from the 

windows explore to the desktop. 

 Printing ability 

 Undo changes  

 A new Layers Toolbar that enables 

you to define layers, lock layers and 

decide which layers you want to 

display. 

8. General Improvements  

8.1. Export Show to ASCII Vector now supports ASCII show file export 

according to the ASCII Standard Protocol.  

8.2. Import ASCII Show File Enhanced Import ASCII Show file now supports: 

 Proportional Patch Level 

 Cue Link 

8.3. WIN SCROLL Mode Enhancements 6 new functions where added to the WIN 

SCROLL mode. 

8.4. Locked Columns Enhancement  A thicker and brighter line can now be seen 

when you lock columns on a grid view. 

8.5. Blind Enhancements It is now possible to copy the editor values 

into the Blind editor. 

8.6. Import Devices Improvements You are now able to select multiple devices 

from the Import Device tree as you would in 

windows.(CTRL or SHIFT) 
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8.7. Delete / Clear Patch in reverse 
order 

Now you can delete or clear a patch in reverse 

order in the Clear Patch dialog from the Patch 

manager. 

 

8.8. VC Compressed Indication When you use VC Compressed, the indication 

bar will now indicate VC’c. 

 

8.9. Workspace Improvement Now if you have only one workspace, there 

will be no workspace indication tab until you 

add another workspace. This helps save 

screen space. See Workspace example.  

8.10. Range Information The Modify or patch dialog title bar now 

contains range information. 

See Modify and Patch Information 

Improvement. 

8.11. Import / Export shows Enhanced 
Menu 

The new Import / Export Show’s menu now 

contains all the Import and Export show 

options: 

 Import Partial Show 

 Import 4D Show 

 Import Sabre Show 

 Import ASCII Show 

 Export Show To ASCII 

8.12. Using PB in Cut Time  You are now able to manipulate PB content 

by using the [SHIFT] key together with a PB 

key. 
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Bug Fixes – Vector Software 3.19.R01 

1. When using DMX input on Fixtures with high Fixture numbers (example; 1000), after 

loading that show, the DMX input was deleted. This has been fixed. Thanks Bill Peachment, 

Little Mouse Production, David Bishop & Ian Reith, UK.  

2. The column order of the DMX Port view was misleading. Now the first field is the Fixture 

name. Thanks to Alone Cohen, Israel 

3. If a text of a “point cue” contained zero at the end, the text did not show on the SK view. 

This has been fixed now. Thanks Raphael Ollier, Crystal Equipment, France and our French 

distributor and his clients.  

4. Pressing again on an enabled button in the pre-built tab was not possible. When the PB 

definition was enabled (in the system settings), and you were working in main master Qlist 

mode, [STORE, CUE, SELECT] was not using the single cue definition.  

5. When a PB fader behavior was X-Fader and the fader was at zero position, raising the fader 

after [Qlist, #, Cue, #, SELECT] did not work the first, but worked the second time. If the 

fader is at full position it must be taken down and then up again. This has been fixed. Thanks 

to Gino De-Leo, Spotlight and RAI TV, Italy.  

6. [FIXTURE, #, FULL/ON/ZERO] on an RGB Fixture with a virtual dimmer was not possible.  

7. When a RGB device had a Dimmer parameter and you stored cues on a fader that was set as 

intensity, taking down the fader also took down the RGB values. This is now fixed. Thanks 

Bill Peachment & Ian Rieth, UK.  

8. When fanning values with [90% →10], the spread negative was activated and if pressed 

again the data changes where incorrectly calculated. This has been fixed.   

9. When using HOME or RELEASE key while in REM Dim mode, kicked you out of the 

mode. This is now fixed. Thanks David Winnik (Vini), Israel.  

10. When examining an A/B or PB that was active, the console showed the preview instead of 

the Exam tab. This has been fixed. Thanks Sabi at House of Tradition (MUPA), Hungry.  

11. When using the blackout key, or grand master, the "fine" parameter of the 16 Bit dimmer did 

not change to 0% and therefore the console did not black-out. This is now fixed. Thanks 

David Bishop, David Bishop Lighting, UK.  

13.  [UPDATE, Cue Only] on a cue before a mark cue or a force black cue, was ignoring the cue 

only function. This has been fixed. Thanks Orit freedman, BEO, Netherlands.  
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Operating New Features 

 

ATTENTION! 

 

This Vector documentation contains both Action and Enter procedure syntax. Procedures that 

use Action syntax are preceded by:  procedures that use Enter syntax are preceded by:  

 

 

Limitations 

 When dimming desk lights, FULL, ON, or ZR will only work after the Wheel has been 

moved.  

 Beat is not implemented yet.  

 In Try Cue, the parameter time progress will not displayed.  

 Qlist and Cue cannot be set as the Numeric default in the Command line.  

 Interactive Fixture selection does not work on a console designated for slave or node.  

 Matrix and Topo selection does not work on a console designated for slave or node.  

 Cue numbers in Qlists on time-lines will not be updated when re-numbering Cues.   

**Work around: Re-number before teaching the time-line.  
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The View Properties Button 

The View Properties button which replaces the Soft Key editor button enables you to change 

properties according to the view type on any soft key or grid views. The View Properties option 

can be accessed from; the pane title, right click menu or View menu ► View Properties.  

For example:  

To change the SK view properties  

 Click on the View Properties button on the SK view pane title bar.  

-OR- 

 Right click, select View Properties. 

-OR- 

 From the View menu select View Properties. 

 

  

To change the Grid view properties 

 Click on the View Properties button on the Grid view pane title bar. 

-OR- 

 Right click, select View Properties. 

-OR- 

 From the View menu select View Properties. 

 

View Properties 

button on the 

pane title 

View Properties 

button 
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Clock and Date View 

The Clocks and Date view options have been added to the Workspace tree ► Editor Tool’s ► 

System Time: 

  

 

 

 

 

 

 

 

 

To add a clock or date 

 From the Workspace Tree, click on System Time; choose a clock or date or both.  

(Each one will be in a separate tab view) 

 

Each clock and date view will be resized automatically when you change the tab size. By double 

clicking on the actual clock or date will bring up the PC’s Date and Time Properties box: 
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Master PB Indication on the Faders Mode LCD 

By pressing and holding down the Playback key on the Faders Mode, will display the Master PB 

in the Faders Mode LCD. This feature works for all Vector models. 

  

 

 

 

 

 

 

 

 

 

 

 

Faders Mode LCD displaying 

the Master PB 
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Vector @ Key Enhancement 

A new button has been added to the System Settings ► Editing tab, called “@ Key For 

Intensity Only”: 

 

 

When the @ Key For Intensity Only is enabled, only the dimmer intensity parameter value will 

be affected each time you use the @ Key. The keys; ZERO, FULL and ON will also default to the 

intensity parameter, not to the last selected parameter. 

You can also use ZERO, FULL and ON for parameters but only if the parameter key is pressed 

directly before you press ZERO, FULL or ON. 

The @ Key For Intensity Only is saved in the show data, so you can decide if to enable it per 

show. 

 

NOTE: Old shows will be loaded with the @ Key For Intensity Only disabled. 
 

When the @ Key For Intensity Only is enabled, you are also able to select and change multiple 

parameters by using the following sequences: 

 [Param, Param, enter value] 

 [Param, Param, FULL/ON/ZERO] 

 

If the @ Key For Intensity Only is disabled, then the last selected parameter will be affected by 

the @ Key, (Which is how it has always worked)  

 

 

NOTE: Decimal value input [SHIFT+@], is not affected by the @ Key For Intensity Only 

function key. 

 

 

 

 

 

 

New added key to 

the Editing tab 
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Examples: 

When the @Key For Intensity Only is disabled: 

Sequence: 

1. Select a FIXTURE, example; Spot 1. 

2. Select a parameter, example; Cyan. 

3. Press the @ key and enter a value using the keypad, example; 75.  

The Cyan parameter will be changed to value 75. 

 

 

When the @Key For Intensity Only is enabled: 

Sequence 1: 

1. Select a FIXTURE, example; Spot 1. 

2. Select a parameter, example; Cyan.  

3. Press the @ key. (Once you press the @ key the parameter selection will automatically 
change to the dimmer intensity parameter).  

4. Enter a value using the keypad, example 75.  

The dimmer intensity parameter value will be changed to 75 without Cyan being 
changed. 

 

 

Sequence 2: - Selecting multiple parameters:   

1. Select a FIXTURE, example; Spot 1. 

2. Press the @ key. 

3. Select parameter, parameter, enter a value, example: 

[Cyan, Magenta, 45] 

-OR- 

1. Select a FIXTURE, example; Spot 1. 

2. Press the @ key. 

3. Select parameter, parameter, enter a value, example: 

[Cyan, Magenta, FULL] 
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When the @ Key For Intensity Only is enabled or disabled 

Sequence 1: 

This sequence will work regardless if the @ Key For Intensity Only is enabled or disabled. 

1. Select a FIXTURE, example; Spot 1. 

2. Select a parameter, example; Cyan.  

3. Enter a value using the keypad, example 75.  

The Cyan parameter will be changed to value 75.  
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Fan Enhancements 

The new Fan enhancement gives you a faster way of using the Fan feature without exiting the 

Fan mode. You are now able to activate the Fan mode by selecting the Fixture’s, then pressing 

the Fan key, and then selecting a parameter, or you can use the previous sequence of activating 

the Fan feature [Fixture # → # select parameter, FAN]. 

A new soft-key attribute has also been added to the Fan Toolbar which is the Fan Inward Mirror 

button: 

 

 

 

The Fan Inward Mirror key 

The Fan Inward Mirror button enables you to fan from the outside to the center. The Fan 

Inward Mirror button is the opposite of the Fan Outward Mirror button . 

 

Using the new Fan Mode 

When you are in Fan mode, the Fan key LED will be lit and the command line will display 

[FAN] together with the current selected Fan parameter, for example: 

 

 

As soon as a parameter key is pressed or a parameter wheel is moved, the indication on the 

command line will show [FAN_*_], indicating that a parameter is in active Fan mode. 

 

 

When using the new sequence of activating the Fan [Fixture # → #, Fan], the last used Fan 

parameter will be selected. (The default Fan parameter is Fan Center Diagonal). 

 

 

 

NOTE: When using the previous sequence, [Fixture # → # @ # → #], out of the Fan 

mode, the default fan direction will still be the Fan Side Right button. 

 

Fan Inward Mirror key 

Last selected Fan parameter 
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After the Fan feature is activated using the sequence [Fixture # → #, Fan], you are then able to 

select a parameter, such as yellow, and then Fan it using the wheel of that parameter.  

After selecting a fan option, the system will always default back to the last used fan option until 

you select a different fan type or reboot the console. 

Example: 

If you are using the Fan Side Left option to fan spots 1-5, then you select spots 6-10, the 

minute you press the Fan key the system will default to the last used fan option which 

was the Fan Side Left option. 

When you select a parameter to fan, the fan will stay on that parameter until you select another 

parameter, in which case you will need to press the Fan key again to activate the fan for that 

parameter.  

Example: 

If you have selected the Cyan parameter to fan, and then you select the Magenta 

parameter to fan, the minute you select the Magenta parameter the console will exit the 

fan mode until you press the Fan key again. 

  

To exit the Fan mode 

 Press either Fan, ENTER (in ENTER Mode), Clear or Reset. 

The Fan key LED will turn OFF and [FAN] will disappear from the command line. 

 

Fan mode sequences 

These are the sequences that can be used to activate the Fan mode: 

 Select Fixtures, FAN, then adjust fan with a parameter wheel. 

 Select Fixtures, Select parameter, FAN, then adjust fan with the selected parameter 

wheel. 

 [Fixture # → #, @, # → #] 

 [Fixture # → #, Select a parameter, # → #] 

 [Fixture # → #, FAN, @, # → #] 

 [Fixture # → #, FAN, Select a parameter, # → #] 

 Using the Step Picker [Fixture # → # STEP → STEP]. See Fan Parameter from Step to 

Step. 

 Using the Media Server Picker [Fixture # → # STEP → STEP]. See Fan Parameter from 

Step to Step. 
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 We also added a sequence to make it easier to go from: 

 Value to value to value etc.: 

[Fixture # → #, @, # → # → # → # → # → # → #...etc. etc] 

-OR- 

 Using the Step Picker: 

[Fixture # → #, STEP → STEP → STEP → STEP…etc] 

  

NOTE: You can change the Fixture selection while in fan mode as long you keep 

working on the same parameter. 
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Fan Parameter from Step to Step 

This new features enables you to Fan from one step to another using the Step Picker (Color 

Wheel Picker, Gobo Picker and Media Server Picker etc.) 

 

Using the Step to Step Fan Feature 

The Step to Step Fan feature is now similar to the sequence of value to value: 

[Fixture, # →# @ # →#] 

You are now able to use the same sequence using Steps from a Picker. This sequence can be 

used whether you are in Fan mode or not. 

For example; 

1. Select a range of Fixtures. 

2. Open a picker from a parameter, for example; double tap on color wheel to open the color 

wheel picker. 

3. From the picker, tap on a step, for example; Red. 

4. Press on the “Thru” key →. 

The console will now enter into Fan mode. 

5. From the picker, tap on another step, for example; Orange. 

The selected range of Fixtures is now fanned from Red to Orange. 

6. Repeat point 4 – 5, to carry on fanning from step to step. 

 

Tip! You can change the Fan attributes from the Fan toolbar. 

 

Note the following: 

When you Fan using pickers, if the Fixtures in the selected range are from 

different device types, the Fan will be from the start point of the step you choose 

from the active picker, until the end step you choose from the active picker. This 

will actually spread the result values of that parameter type to all the active 

devices.  

Example; If you work with VL3000 Spot and Mac III Spot, assigning values to 

both of these Fixtures range from the color wheel picker of the VL, from step 2 

(24%, Orange) to step 7 (72%, Deep Red), the values of the Fan on the whole 

range will be fixture 1 color wheel at 24% until the last fixture at level of 72%, 

This will happen even though the actual step value and content on either of the 

device type are not necessarily a Deep Red color but the device value of the color 

wheel at 72%. 
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Prohibit Mark Cue Data Modifications 

You are now prohibited from editing the Mark Cue, except the timing properties and the name of 

the mark cue. If you try to update, overwrite or store on an existing mark cue, the console will 

prompt you with “Mark cue cannot be edited”. You are still able to delete a mark cue. 

If a mark cue already exists and you try to re-store the mark cue, then the console will prompt 

you with “Object Exists” together with an option to “Overwrite”. 

 

Updating an Active Mark Cue 

If a Mark cue is active on the PB and you update that mark cue using the Update dialog 

[Update], the command line will show the error message “MARK CUE CAN NOT BE EDITED” 

and the Update dialog will open. The Update dialog will show the Cue before the Mark cue that 

you are trying to update. You will now have the option to update the cue before the Mark cue or 

update a different cue. 

Example: 

1. [Spot 1-10, HOME, Channel 1-10, @ 50%, Cue 1, Store] 

2. [Spot 1-10, ZERO, Cue 2, Store] 

3. [Spot 1-10, FL, Pan Tilt changes, Cue 3, Store] 

4. [Cue 2.5, Mark Cue, Store] 

5. Go to cue 2 on the PB, the console will automatically fade to the mark cue (2.5) 

6. [Channel 1- 10, @ 80%, Update] 

The Update dialog will open showing Cue 2 (which is the cue before the Mark cue) and 

the Command line will indicate “MARK CUE CAN NOT BE EDITED”: 

 

 

  

 

 

 

 



The Move Function  

     | 20 

The Move Function 

The Move function enables you to move objects such as cue’s, groups, libraries etc. This is a 

faster and easier way without using the cut and paste functions. We also enhanced the Copy and 

Cut sequences to work in Enter mode. (Meaning now you can start with an action, e.g. [Copy]) 

 

Sequences to move objects 

The following sequences are used to move objects by either using the keypad or soft keys. These 

sequences can also be used with Copy and CUT. 

 

To move an object using the keypad 

1. [SHIFT + MOVE] 

2. Press on the object key that you want to move, e.g. [Group], [Qlist] etc. 

3. Type in the object number that you want to move. 

4. Press @ key.  

5. Enter in the target number (The place number to move the object to) 

 

6.  [Store]  

-OR- 

 

7. [ENTER] / [Store] 

 Example: 

In this example we will move Group 1 to Group 10: 

1. [SHIFT + Move] 

2. Press [Group] and type 1 on the keypad. 

The command line will indicate the following: 

 

3. Press the [@] key.  

The command line will indicate the following: 

 

4. Enter target number 10 

5. Press [Store] / [ENTER] 

The command line will indicate the following: 
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To move a range of objects using the keypad 

1. [SHIFT + MOVE] 

2. Press on the object key that you want to move, e.g. [Group], [Qlist] etc. 

3. Select the range [# → #] 

4. Press [@] key.  

5. Enter in the target number. (The place number to move the object to) 

 

6. [Store] 

-OR- 

 

7. [ENTER] / [Store] 

 

 

Example: 

In this example we will move Group 1-5 to Group 8: 

1. [SHIFT + Move] 

2. Press [Group, 1 → 5] 

The command line will indicate the following: 

 

3. Press the [@] key.  

The command line will indicate the following: 

 

4. Enter target number 8. 

5. Press [Store] / [ENTER] 

The command line will indicate the following: 
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The above image shows that the group range 1 -5 was moved to group range 8-12. 

  

 

NOTE: If an object already exists in the target place, a pop-up message will appear giving 

you the option to either overwrite the existing or Swap the existing: 

 

 

 

ATTENTION! By default the numeric object type is Cue.  

For example;  

If you have Qlist 1 on the Master PB, which has cues 1-5, as soon as you start the 

sequence [MOVE, 4], the system will know you are referring to cue 4 from Qlist 1. 
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To move an object using the soft keys 

Sequence 1 

1. [SHIFT + MOVE] 

2. Select or Tap on the object to move. 

3. Select or Tap on the target soft key.( If the SK is empty) 

-OR- 

4. Press @ 

5. Select or tap on any target soft key. 

 

Sequence 2 

1. Press and Hold down [SHIFT + MOVE] 

2. While holding down [SHIFT + MOVE] select the object to move. 

3. Release [SHIFT + MOVE] 

4. Select or Tap the target soft key. (any free or occupied soft key)  

-OR- 

Enter the target number on the keypad. 

 

5. Press [Store] 

-OR- 

 

[ENTER] / [Store] 

 

ATTENTION! Sequence 2 above will not work if you have Fixture 

selection. 

To overcome this problem, press [SHIFT+ ●], before 

using the sequence. 
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To move a range of objects using the soft keys 

Sequence 1 

1. [SHIFT + MOVE] 

2. Select or Tap on the objects to move. 

3. Select or Tap on the target soft key.(If the SK is empty) 

-OR- 

4. Press @ 

5. Select or tap on any target soft key. 

 

 

 Sequence 2 

6. Press and Hold down [SHIFT + MOVE] 

7. While holding down [SHIFT + MOVE] select the objects to move. 

8. Release [SHIFT + MOVE] 

9. Select or Tap the target soft key.  

-OR- 

Enter a target number from the keypad.  

 

10. Press [Store] 

-OR- 

 

[ENTER] / [Store] 

 

Note the following: 

 Holding down the Copy / Cut or Move key on the keypad, will disable the keypad 
until you release them. 

 The MOVE sequences are NOT valid for Fixture copying or playbacks. 

 The above sequences can be used with numeric or non-numeric ranges. 

 Objects will be pasted in order of selection. 

 On non-linear ranges, the gaps will be kept after pasting to the target range. 
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The Copy Cue + Properties Button 

In tracking mode, we added another option to the Copy Cue dialog: 

 

 

By using this new option you are able to copy the Cue together with the cue properties(time, 

Delay etc.). This is the Default option. 

 



Effects Editor Improvements  

     | 26 

Effects Editor Improvements 

The following improvements were added to the Effects Editor: 

 Assign a value using the keypad at any time 

 Assign a negative value using the keypad 

 The Release button has been enhanced 

 Ability to run a Pre-Built effect on parameters of the same type example; RGB 

 

Assign a value using the keypad 

When using the Effect Editor, you are now able to assign an exact value using the numbers 

keypad. The value will be assigned immediately once entered. The system will now also accept a 

single digit number such as “1”. 

If you have entered a value and you decide to change that value completely, then you will need 

to do either of the following before entering a new value: 

 Press on the Effect attribute button you are working on, example; Rate → All 

-OR- 

 Press on the parameter key associated with the effect you are working on.(The keys 

above the Parameter wheels on Vector Red or Vector Blue) 

You are now also able to enter a negative value for Size and Rate using the “-“key. 

[- Key, #], Example; -50 

 

Note the Max values for the following: 
 

 Offset; 100% 

 Size; 100% -OR- -100% 

 Rate; 327 sec –OR- -327 sec 

 Duty Cycle; 255 

  

 

     Tips!  

 Instead of using the Keypad for Full, On or Zero values, press the FULL or 

ON/ZERO keys. 

 You can also use the negative “-“key with the FULL or ON/ZERO keys.  

For example; [- Key, FULL] 
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The Enhanced Release Button  

The enhanced Release option which has now also been added to the advanced tab can now be 

used in 2 ways: 

 When an effect is running, click on the Release button once to release a Primitive 

selection, click again to reset the other effect attributes. (Offset, Size, Rate, Duty cycle) 

 If NO Primitive is selected, click once to reset the Effect attributes. 

  

ATTENTION! If you release a Primitive only (One Click), then close and re-

open the Effect Editor, the Effect attributes will be reset. 

  

NOTE: You can also use the [RELEASE] key on the console panel to perform 

the above operations when the effect machine is open. 

 

 

 

 

 

 

 

Release Button 

Effect Attributes 

Effect Primitives 
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Run a Pre-Built effect on parameters of the same type 

An effect will now run on all parameters from the same type. This can only be done when using 

effects from the Pre-Built tab. 

Example 1: 

If you have 10 (Color kinetics), ColorBlaze-72 fixtures: 

[Fixture, 1->10, EFFECT, RAINBOW] 

The effect will now run on all the 12 sets of RGB parameters. 

 

Example 2: 

If you have 10 (Studio Due), CS-4 fixtures: 

[Fixture, 1->10, EFFECT, DIMMER FADE] 

The effect will now run on all the dimmer parameters of that fixture (4 Dimmers). 
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Direct PB Operations 

You are now able to perform PB operations, for example; assign Qlists, release PB’s etc., 

directly from the PB wing view by using the option “Interactive Selection”. This option is 

located in the View menu and can also be used to enable or disable the feature for every PB view.  

 

Using Interactive Selection 

When Interactive Selection is enabled a divider will be placed on the PB and Q-Key wing view: 

 

 

 

To turn ON Interactive Selection 

 From the View menu select Interactive Selection. 

 

Once Interactive Selection is enabled, then the section above the divider line will behave like the 

Select keys of the playbacks. This means that all operations that are done using the Select keys 

can now be done from the PB wing view. By clicking on the section below the divider line will 

open the Cue sheet for that PB. See Viewing the Cue sheet 

 

 

Tip! You can use the PB control keys to manipulate the PB, (PB release, Free, GO, Forward or 

Backwords, take Priority, Etc…) 

 

Interactive Selection OFF Interactive Selection ON with divider 

Use this section to assign Qlists, 

Release PBs, etc. 

Click here to open the Cue sheet 
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Example: 

If Interactive Selection is enabled and you want to store Qlist 1 on PB 1, then instead of using 

the Select key PB 1, click on the top section of PB 1 in the PB wing. 

Type Qlist 1 and tap or click on the Playback wing: 

  

 

 

 

 

 

 

Viewing the Cue sheet 

You can view a Cue sheet of a PB by simply clicking on the section under the divider line. From 

the Cue Sheet, you can also view the PB, Exam and Preview by clicking on those tabs. The Cue 

sheet now has 2 new buttons on the right hand side for easier navigation- A back button and PB 

Setup button: 

 

 

The PB Setup option is also available on the pane title bar of any specific PB view including A/B 

and Master PB Views: 

 

Click here to add Qlist 1 to PB 1 

Qlist 1 has been added to PB 1 

The Back button will take you back to the PB 

wing view. 

The PB Setup button will open the PB 

properties dialog. 

Pane Title 

Right hand side options 
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Inside a specific PB view, the PB tab is also intercative and can be used instead of using the PB 

select key. This includes A/B and Master PB views: 

 

 

ATTENTION! By default the Interactive Selection is enabled, even when loading a layout 

from a previous version (3.18). 

 
Note the following: 

 

 The Right hand side options (Back button and PB Setup) are not available on 

A/B and Master PB views. 

 The Interactive PB operations will work on PB’s and in Qkeys views. 

 The console will divide the PB view regardless of the fields order. 
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Vector Snap Enhancement 

A new button has been added to the System Settings ► Playback tab under the Snap Options 

called “Activate Snap On Load”. The “Activate Snap On Load” enables you to choose what 

happens to the snap when you load a show. When the option is enabled, the snap will load as it 

does at the moment. When the option is disabled, the snaps will be loaded forcing all PB’s to be 

released. 

 

 

The behavior of the “Activate Snap On Load” is saved in the Show Data, (Meaning, when 

loading a show, the console will check the state of this option and then load the show 

accordingly). Therefore, before saving a show you will need to decide how you want the snap to 

behave when loading that show. 

Example: 

1. Store a Cue on a PB. Make sure the PB is activated. Save as Snap 1.  

2. Enable “Activate Snap On Load”. Save the show as “Snap Active”. 

3. Disable “Activate Snap On Load”. Save the show as “ Snap Released” 

4. Load a new show to clear all the data. 

5. Load the saved shows and notice what happens: 

Activate Snap On Load - Enabled:      Activate Snap On Load - Disabled: 
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ATTENTION! Old and new shows will be loaded to the default setting of 

“Activate Snap On Load” disabled. 

 

Tip! Load your old shows, and then re-save them using the “Activate Snap On 

Load” feature. 

 

 Note the following:  

 Warm Data has no relation to the “Activate Snap On Load” option. Warm 

Data will continue working as it does today. 

 The Snap will remember which PB’s are enabled, but when loading the show 

this data will be ignored. 

 

 

 



The Apply & Continue Option in the Wizard  

     | 34 

The Apply & Continue Option in the Wizard 

The Wizard that is used to Create & Patch Fixtures, Patch Fixtures, Modify Fixture Ranges, and 

Modify Dimmer Ranges has been enhanced with a new button called “Apply & Continue”. 

This button enables you to apply the change and continue working in the same wizard dialog 

without re-opening the Wizard after every operation. The “Finish” button is still a valid 

operation that can be used once you are satisfied with your changes. 

 

Using the Apply & Continue button 

When opening a wizard the Apply & Continue button will be greyed out until you have made 

your additions or changes and have moved to the next screen using the Next button: 

 

 

  

Apply And 
Continue 

button 

NOTE: The Help 
button is now 
move to the top 
right of the dialog 
box. 
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Tapping on the Apply & Continue button will apply the changes, and then the wizard will return 

to the previous screen thereby enabling you to add more devices or fixtures. When you are 

satisfied with your additions, tap the Finish button to close the wizard. 

Every time you use the Apply & Continue button, the system will automatically generate the 

next available number for that device. For example; if you modify a range for spots 1-9, then you 

use Apply & Continue, the next range will start from the next available number, i.e. spot 10. 

 

NOTE: The Help button is now at the top right corner.  

 

Modify and Patch Information Improvement 

Now when you Modify or Patch dimmers in the patch manager, the range selected will be shown 

in the Title of the dialog. This applies to the following: 

 Creating and Patching Fixtures 

 Patching Fixtures 

 Modifying Fixture Ranges 

 Modifying Dimmer Ranges 

 

 

Apply And 
Continue 
button 
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SMPTE, MTC, MIDI Enable / Disable 

You now have the ability to control the signals from SMPTE, MTC, MIDI In and MIDI Out. 

This enables you to turn OFF one or more of these protocols. 

 

New buttons have been added to the System Settings ► MIDI/SMPTE tab: 

 

 

The MIDI Input, Output and Macro buttons are greyed out until the main MIDI button is 

activated. 

 

 

NOTE: When MTC is enabled, the console will listen for MIDI time code protocol 

regardless if the main MIDI button is enabled or not. 

 

 

 

New added buttons 

Main MIDI button 
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A new “MIDI/SMPTE” Soft Key option has also been added to the Setup Toolbar. This is 

accessed by pressing the Setup key on the actual console: 

 

 

By pressing the MIDI/SMPTE soft key will open a new MIDI/SMPTE toolbar: 

 

 

 

 

Tip! You can create a Macro to trigger the options in the MIDI/SMPTE Toolbar.  

 

The MIDI/SMPTE new buttons 

The following is a list of the new MIDI/SMPTE buttons with their functions: 

Button Function 

MIDI Input Keys Enable this key together with the main MIDI button to receive MIDI 
commands into the console. 

MIDI Output Keys Enable this key together with the main MIDI button to send MIDI 
commands from the console. 

MTC Enable this key to receive MIDI Time Code protocol (External Timeline 
Clock) into the console. 

SMPTE Enable this key to receive SMPTE protocol (External Timeline Clock) into 
the console. 

 

 

 

 

 

 

 

Main MIDI SK 
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Using MIDI/SMPTE System Settings Tab 

After pressing on the main MIDI button, the MIDI Input, Output and Macro keys will become 

available: 

 

 

Once the main MIDI key is activated, and you have clicked on OK or Apply; The Indication bar 

will display MIDI: 

 

 

After selecting a MIDI key choice; MIDI Input Keys, MIDI Output Keys, or MIDI Macro, the 

changes will NOT be immediate until you apply the change by pressing OK or Apply.  

Once you have applied the change, it will be visible on the Indication bar and on the 

MIDI/SMPTE Toolbar. 
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Example: 

MIDI, MIDI Input and MIDI Output keys have been selected: 

 

 

After you press Apply, the Indication bar will display “MIDI I/O”(MIDI Input / MIDI Output): 

 

 

Indication bar MIDI/SMPTE indications 

The following is a list of MIDI/SMPTE indications on the Indication bar: 

MIDI 
Indications 

Activated key’s SMPTE / 
MTC 
Indications 

Activated key’s 

 Main MIDI Only or 
main MIDI + MIDI 
Marco 

 SMPTE  

 Main MIDI + MIDI 
Input keys 

 MIDI Time Code (MTC) 

 Main MIDI + MIDI 
Output keys 

 MIDI Time Code (MTC) + 
SMPTE 

 Main MIDI + MIDI 
Input keys & MIDI 
Output keys 

  

Selected 

MIDI keys 
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Using the MIDI/SMPTE Toolbar 

The MIDI/SMPTE Toolbar is accessed by pressing the Setup key ► MIDI/SMPTE Soft key: 

 

 

When using the MIDI/SMPTE Toolbar, by pressing on any of the MIDI commands (MIDI Input, 

MIDI Output, MIDI Macro), will automatically activate the main MIDI key. After selecting an 

option from the MIDI/SMPTE Toolbar, Store (Action Mode) or ENTER/Store (Enter Mode) 

needs to be pressed to assign the command. Once the MIDI/SMPTE command is assigned, the 

Command line will display Assigned and the Indication bar will display the assigned MIDI or 

SMPTE command. 

The Assigned command will also be visible in the MIDI/SMPTE System Settings tab. 

Example: 

MIDI Output is enabled: 

 

 

After the MIDI/SMPTE command is stored, the Command line will display Assigned with the 

Indication bar displaying the assigned command: 

 

 

NOTE: The MIDI/SMPTE Toolbar will return back to the Default Tool bar after 

assigning the command. 

The Command line 

displaying the activated 

MIDI command 
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ATTENTION! SMPTE and MTC new buttons are disabled by default, so any external 

trigger (SMPTE or MIDI Time Code) will be ignored unless you enable the relevant 

SMPTE or MIDI Time Code button. This is relevant for new shows and saved shows 

from previous software versions.  

 

The SMPTE / MTC TimeLine Clock 

A new Clock tab has been added to the active TimeLine view screen. This clock is a reflection of 

the Indication bar TimeLine clock. The Clock can be resized by changing the tab size. 

 

The active TimeLine clock is for preview only and cannot be edited. 

 

 

 

 

 

Note the following color changes: 

(This also applies to the SMPTE / MTC Clock on the indication bar)  

 The Clock color will be Orange when SMPTE is running from the internal 

clock. (TimeLine Toolbar ► RUN) 

 When running from an external clock, the clock color will be according to the 

console theme. 

 

SMPTE / MTC 

Clock View on 

the Indication 

bar 

Hours Minutes Seconds Frames 
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Desktop Enhancements                                                          

The new desktop enhancements enable you to do the following: 

 Add stage elements in various shapes 

 Define, lock, display or hide elements using the Layers Toolbar 

 Group elements 

 Drag shortcuts from the Window explorer to the desktop  

 Undo last changes 

 Print the desktop 

 

With these enhancements come two new Toolbars; The Stage Elements Toolbar and the Layers 

Toolbar. These are floating Toolbars which can be positioned anywhere on the screen. 

The Toolbars are accessed from two new buttons located on the Desktop pane title: 

 

 

 

 

NOTE: Unlock   the display before editing anything on the desktop. When finished, 

be sure to lock the display.   

 

The Stage Elements Toolbar 

The Stage Elements Toolbar contains 16 pre-defined elements that can be dragged onto the 

Desktop. Once an element has been dragged to the desktop, then you can manipulate them to 

change size, angel, shape, line thickness and line color.    

Stage Elements Toolbar: 

 

 

 

 

 

Layers Toolbar 

button 

Stage Elements Toolbar NOTE: The Grid button has also 

been added to the Desktop pane title. 

Vertical 

Line 

Curve Square 

Rectangle 

Polygon 

Triangle 
Open Circle 

Open 

Polygon 

Open Triangle Open Square L-Shape 

Hoist 
Truss 

Circle Arrow Horizontal 

Line 
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To add stage elements to the Desktop 

1. Add a Desktop to your show.(Right click and select Add Desktop) 

2. From the Desktop pane title click on the Stage Elements button: 

 

The Stage Elements Toolbar will appear: 

3. Using the mouse, drag the desired element onto the Desktop area. 

The Element will appear on the Desktop like the following example which is a circle: 

 

 

 

To name the element 

1. Double click the Name field.  

-OR- 

Click on the actual element to select it, and then Right click, select Rename from the 

menu.  

2. Type desired name in the Name field. 

3. Press Enter or click anywhere in the desktop area. 
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To move an element 

1. Click on the actual element to select it. 

-OR- 

Highlight the Element/s by left clicking the mouse and dragging the highlighter over 

the Element/s. 

-OR- 

Select a few elements using CTRL and left mouse click. 

2. Once the Element is selected, left click on the actual element, hold the mouse key 

down and move the Element to the desired location. 

You can also move the Element by clicking on the Name field and dragging the 

mouse. 

 

To change element size 

 Click and drag one of the white points from the outside frame: 

 

 

 
Tips!  

 To change the size of multiple elements, select the elements, and then 

drag one of the points from the outside frame. 

 To equally change the size of an element; press and hold SHIFT while 

stretching the element. 

 

 

 

 

 

 

The Arrows icon will appear once 

the mouse is over a stretch point.  
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To rotate the element 

Click and drag the rotation handle (Green point) at the top of the Element in the direction 

that you want to rotate. 

OR 

Right click ► Rotate. 

 

 
Tips!  

 To rotate multiple elements, select the elements, and then drag the 

rotate point of one of the elements. 

 By holding SHIFT together with the mouse, you can rotate the 

element in jumps of 18 degrees. 

 

To change the element shape 

Click and drag one of the points on the actual element (Red points): 

 

 

Tip! By holding SHIFT together with the mouse, you can drag the element from 

the red points in a straight line. 

 

The Rotate icon will appear once the 

mouse is over the rotate point.  

The Red Arrows will appear once the 

mouse is over a draggable point.  



Desktop Enhancements  

     | 46 

To add points to an element 

You can add more points (Red only) to an element if needed; Min 2, Max 16 points. 

1. Select the stage element. 

2. Place the mouse on the element line where you want to add a point. 

3. Right click and select Add Point. 

 

To remove a point 

1. Place the mouse on the red point you want to remove. 

2. Right click and select Remove Point. 

 

To delete an element 

1. Click on the actual element to select it. 

-OR- 

Highlight the Element/s by left clicking the mouse and dragging the highlighter over 

the Element/s. 

2. Press Delete. 

-OR- 

Right click ► Delete 

-OR- 

Press Delete on the keyboard. 

A Delete Objects dialog will appear: 

 

3. Click Delete to delete the Element or Cancel. 
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To print a desktop 

You are now able to print the desktop. 

1. Open the Desktop view 

2. Click on the Desktop view tab to activate it for printing. 

The selected desktop view should have an orange frame around it. 

3. From the File menu select Print. 

-OR- 

Ctrl + P 

 

NOTE: The Desktop will not print using the “Print Multiple” option. 

Using Undo 

The Undo command can be used to undo the following: 

 Undo Movement of an object. 

 Undo a deleted object. (When using undo to restore a shortcut, the shortcut will be 

restored with a generic icon) 

 Undo an “Add/Remove” object from the user defined layer. 

 Undo Rotation, Stretch and drag. 

 Undo for group or ungroup. 

 

To undo 

1. Place the mouse anywhere in the Desktop. 

2. Right click, select Undo. 

 

NOTE: You only have 1 Undo.  
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Stage Element properties 

In the Stage Element Properties you can change line thickness, angel, color, and style, name the 

Element and decide if you want the Element to be open or closed, curved or not curved.  

 

To access stage element properties 

1. Right click on the element. 

2. Select Properties. 
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The Stage Element Properties window 

 

 

Stage Element properties options 

The following is an explanation of the Stage Element Properties options: 

 Name: Name of the Element. Click in the Name field to change the name. 

 Location: The X and Y points enable you to place the element in the exact location. 

 Layer: Use the Layer drop down menu to add the element to a layer. See The Layers Toolbar  

 Thickness: Changes the thickness of the Element line; Min value is 0. Max value is 255.  

 Angle: Changes the Angle of the Element. 0 - 360Deg  

 Style: Allows you to change the Style of line, for example; Dotted line………. 

 

NOTE: In order to use the Styles, the Curved Element button must be disabled. See 
number 9 below. 

Tip! You can also change any element into a “Truss” style by selecting Truss from the 
Style pull down menu and increasing the Thickness of the line. 

1 

4 

5 

6 

7 

8 9 

2 

10 

3 

1 

2 

3 

4 

5 

11 12

2 

6 
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 Color: Changes color of the Element line. 

 Close Element: If the button is enabled the Element shape will be closed. If the button is disabled 
the Element shape will be open. 

Example:  

In this example we will use the Circle Element. 

 

Closed Element:          Open Element: 

 

 

 

 

 

Tip! If you have an open element, for example; Open Square, you can close the Square 
by clicking the on the Close Element button.  

 

 

 

 Curve Element: The Curve Element button is used to Curve or un-curve the Element. 

Example:  

In this Example we will use the Square Element. 

 

Curve Element button is disabled:                         

 

 

 

 

 

 

 

 

 

7 

8 

Curve Element button enabled: The 
Square now becomes a sort of circle: 

 

9 

8 
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 Reset Buttons: By clicking on the Reset button will reset the individual function back to the last 
saved value.  

 Show: Show or hide element name. 

 Center: Centers the Element name or places the name outside the Element. 

 

 

NOTE: The changes to the object will be saved only if you close the dialog by 

clicking on OK or Apply. 

 

Tips! 
 

 You can change the stage properties of multiple elements by selecting the elements 
then selecting properties. 

 You can preview the changes on the actual element.  

 

The Layers Toolbar 

The Layers Toolbar gives you the option to display the Elements on the Desktop or not. You can 

also define layers, lock layers and decide which layers you want to display. 

A Layers Toolbar button will only become active once you add a relevant object to the Desktop. 

 

Layers Toolbar: 

 

 

 

 

 

 

 

 

 

 

 

Shortcuts 

Layer 
Topo 

Shortcuts 

Layers 

Stage 

Elements 

Layer 
Groups 

Layer 

User Defined Layers with Lock Layers 

10 

11 

12 

Show / 

Hide 

Text 

Show / Hide objects 

that are not 

attached to any 

user defined layer 
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The Layers Toolbar options 

The following is an explanation of the Layers Toolbar options: 

Layers Toolbar 
Option 

What is does… 

 

This option will show or hide all text on the desktop. 

When Enabled: 

Object text will be visible on the desktop ( According to the object 

properties) 

When Disabled: 

All object text will be hidden. 

 

This option will show or hide all shortcut objects on the desktop, (except 

Topo shortcuts) 

When Enabled: 

All shortcut objects will be visible. 

When Disabled: 

All shortcut objects will be hidden. 

 

This option will show or hide all shortcut objects added from the Topo 

view. 

When Enabled: 

All Topo shortcut objects will be visible. 

When Disabled: 

All Topo shortcut objects will be hidden. 

 

This option will show or hide Stage elements on the desktop. 

When Enabled: 

All Stage element objects will be visible. 

When Disabled: 

All Stage element objects will be hidden. 

 
This option will show or hide grouped objects on the desktop. 

When Enabled: 

All grouped objects will be visible. 

When Disabled: 

All grouped objects will be hidden. 
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These options are user defined layers, of which there are 5 to work with. 

When the Layer is Enabled: 

All the objects in the layer will be visible. 

When the Layer is Disabled: 

All the objects in the Layer will be hidden. 

 

Locked or Un-Locked Layers 

When a layer is locked, you will not be able to select or manipulate the 

objects in it. The layers lock can only be used when the Vector display is 

Unlocked :  

When the Layer is Locked: 

The Objects in the layer will be visible but they cannot be manipulated. 

When the Layer is Un-Locked: 

The Objects in the layer will be visible and can be manipulated. 

 
This option will show or hide objects that are NOT linked to a user defined 

layer. 

When Enabled: 

All the objects that are not linked to a user defined layer will be visible. 

When Disabled: 

All the objects that are not linked to a user defined layer will be hidden. 

  

 

NOTE: When an object is part of a user defined layer, the object will still be part of its 

generic layer. Therefore both of the layers must be visible in order for the object to be 

visible. 

Example: 

If you add a shortcut to the desktop, it is automatically part of the Generic shortcut 

layer. 

If you add that shortcut into a user defined layer; example user defined layer 1, the 

object will then part of both layers.(Generic shortcut layer and User defined layer 1) 

In order to see this object, both layers must be enabled. 
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To add objects to a user defined layer 

Any desktop object can be added to a user defined layer. 

1. Select the objects to add. 

2. Place the mouse on the selected objects. 

3. Right click. 

4. From the User Defined Layers list select a layer from 1-5. 

 

-OR- 

Right click on the Object ► Properties ► Layer 

Once you have selected a User Defined Layer, the User Defined button on the Layers 

Toolbar will become active: 

 

 

To hide objects in a layer 

 Click on the active User Defined Layer. 

 

To lock objects in a layer 

 Click on the lock button 

 

To remove objects from a layer 

1. Make sure the layer is unlocked. 

2. Select the objects to remove. 

3. Place the mouse on the selected element. 

4. Right click. 

5. From the User Defined Layers list select None. 
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To hide text on all objects on the desktop 

 From the Layers Toolbar click on the Text button  

This will hide all text from all objects. 

 

To hide text on selected objects on the desktop 

 To hide text from a selected object, Right click on the object and select Show/Hide 

Text. 

 

 

 

Groups 

Grouping is when you take a bunch of objects and put them into one group. You can have many 

groups each with a bunch of objects. Any desktop object can be grouped. 

Note the following on groups: 

 A group can also be part of a user defined layer. 

 Objects in a group cannot be selected or manipulated separately.  

 Object options such as rename, properties, rotate etc. will be greyed out when the 

object is in a group. 

 Objects that are part of a user defined layer or any other generic layer will be cleared 

from those layers after grouping.(These objects will now be part of the Groups layer) 

 Groups can be combined together by selecting both the groups (Right click ► Group) 

 An object in a group will belong to the Groups Layer until ungrouped. 

 When you group objects, there unique properties will be kept (Show/Hide Text, 

Color, thickness etc.) 

 

 

 



Stage Element properties  

     | 56 

To group objects 

1. Select the objects to group. 

2. Place the mouse on the actual element. 

3. Right click, select Group. 

The Groups Layer button  will become enabled and there will be white broken 

lines around the group. These broken lines will become a dark grey color once you 

click on another object. 

 

 

To ungroup objects 

1. Select the group to ungroup. 

2. Place the mouse on the selected group. 

3. Right click, select Ungroup. 

 

To undo 

See Using Undo 
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Drag Files from PC Desktop to Vector Desktop 

Shortcuts from the Window explorer can be dragged to the desktop (Except windows 

components, such as “My Computer, My Networks, etc.) 

 

To drag files to the desktop 

 Simply drag the Shortcut from the Window explorer to the Vector desktop: 

 

 

 

NOTE: The shortcuts are LINKS only. These files will not be saved in the 

show, only the links will be saved.  

 

Tips! Dragging files to the Vector Desktop can be usefull for: 

 Quick access to run applications such as C-Net Manager. 

 CAD drawing of your stage or bitmap. 
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The Shortcuts properties dialog 

The Shortcuts properties dialog is used to edit properties of a shortcut object. 

You can perform the following: 

 Change the name of the Shortcut 

 Show / Hide the Shortcut text 

 Enter an exact location to place the shortcut using X and Y fields 

 Add the Shortcut to a user defined layer 

 Add a hotkey for the shortcut  
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Using the Grid 

The Grid Show / Hide button , which is located on the desktop title pane, adds layers of dots 

that can be used to align objects. This grid works the same as the grid on the Topo.  

 

General Desktop Notes 

The following are general notes on using the Desktop enhancements: 

 To select an object click once, then click again to move the object. 

 When moving an object red point the frame will reset. 

 When printing a desktop the zoom may change. 
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Export Show to ASCII 

You are now able to export channel information, groups and 1 single Qlist (According to the 

standard protocol) to an ASCII show file. The console will not allow you to export unless you 

have at least 1 channel and 1 Qlist. 

When exporting an ASCII show file, the following data is exported: 

 Cue data 

 Group data 

 Cue time data (time-in / time-out) 

 Cue Link 

 Patch 

 Proportional patch level  

 Text of the Cue or Group 

 

NOTE: A group will not appear in the Export to ASCII Show dialog if it does not 

contain any channel data.  

 

To export a show to ASCII 

Before you export a show to ASCII make sure you have a channel and a Qlist in the show. 

1. From the File menu select Import/Export Shows ► Export Show To ASCII. 

 

2. From the Export to ASCII show dialog select the objects to export: 
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3. Click Export. 

4. Select the destination to save the file. 

5. Type the file name, select Save. 

The file will be saved with the extension:.asc  

 

ATTENTION! If more than 1 Qlist is selected, the console will merge these Qlists 

into 1 Qlist. This will cause the cues to be re-numbered. 

 

NOTE: Import ASCII show file now supports; Proportional Patch and Cue Link.  
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More General Enhancements 

The following pages contain explanations on more general enhancements. 

 

WIN SCROLL Enhancements 

The following are new supported keyboard keys in WIN SCROLL mode: 

Pressed PC Panel key Will act as Keyboard key 

[MACRO] ALT 

[SNAP] Space 

[UNDO] UNDO ( CTRL + z) 

[COPY] COPY (CTRL + c) 

[PASTE] PASTE (CTRL + v) 

[ACTIVE] SELECT ALL (CTRL + a) 

 

 
Tip! By using [MACRO] + → (Thru) in WIN SCROLL mode will give you the 

same effect as Alt + Tab on the windows keyboard. 

 
NOTE: When you open a Text dialog or the Matrix ► Fixture properties, the WIN 

SCROLL will turn ON automatically.  

The WIN SCROLL will automatically turn OFF when you exit the Text dialog 

or Matrix ► Fixture properties. 

 

Locked Columns Enhancement 

Now when you lock columns there will be a thicker and brighter line. This line will take the 

colors according to the grid colors: 

 

Thicker and brighter line 

when columns are 

locked 
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Blind Enhancement 

By using the following sequence you can copy the editor values into the Blind editor. This can be 

done even if the Blind editor already has values. 

 

To copy current editor values into the blind editor 

This sequence will copy the editor values into the blind editor and will automatically enter 

the blind editor: 

 [SHIFT+BLIND]  

 

Import Devices Improvement 

By using CTRL or SHIFT together with the mouse (as you would do in windows), will enable 

you to select multiple devices in the Import device tree. 

 

Import / Export Shows Enhanced Menu 

All Import and Export options have been added into one menu: 

 

 

ATTENTION! The previous way of importing 4D / Sabre / ASCII shows by using File 

► Open Show is NO longer valid. 
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Workspace Improvement  

When you have only one workspace in a window, there will be no workspace indication tab until 

you add another workspace:  

 

 

To add a workspace 

1. Right click anywhere. 

2. Select Add Workspace. 

The Workspace indication tab will appear and will show both workspaces. 

 

 

 

 

 

 

 

 

 

 

 

No workspace indication tab 
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Using PB in Cut Time 

You are now able to manipulate PB content by using the [SHIFT] key together with a PB key. 

The following are PB key behaviors:  

Key Behavior  With SHIFT Without SHIFT 

GO PB will fade in using Cut 

Time. 

PB will fade in using Cue 

Time. 

GO / RELEASE PB will act as ON / OFF PB will fade in using Cue time 

or will be released using 

release Time. 

RELEASE PB will be released in Cut 

time 

PB will be released in release  

time 

BACK / HOLD or BACK PB will fade back in Cut 

Time. 

PB will fade back using back 

time. 

ON / OFF PB will act as GO / RELEASE PB will fade in/ out using Cut 

Time. 

 

NOTE: The above behavior will work with PB’s and Q-keys. 

 

 

Quick access to MARCO’s 111 – 116 

You are now able to use MARCO’s 111 – 116 directly from the 6 original MARCO keys on the 

panel. You can do this by pressing [SHIFT], then pressing on a relevant MACRO key. 

MARCO Key Key + SHIFT MARCO Key Key + SHIFT 

 macro 101  macro 111  macro 104  macro 114 

 macro 102  macro 112  macro 105  macro 115 

 macro 103  macro 113  macro 106  macro 116 

 



Vector Release Notes 

Release Date: 20/12/2010 

Real time version: 3.18.R03 

Windows version: 3.18.R03 

RT interface version: 3.18.R03 

Firmware file updates are required for:  

 Vector Red / Blue Editor: Version 14 

 Vector Green / Orange Editor: Version 24 

 Remote Playback Wing: Version 15 

 Remote Editor Wing: Version 27 

 Vector Violet Editor Panel: Version 26 

Key Panel has been changed to [@/DECIMAL]  

 

(Please contact your local Compulite distributor for replacement keys) 
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Version Highlights 

In this version we updated and added many more devices.  120 new devices where added with more 

than 100 devices updated: 

1. Display  

1.1. GUI Improvements The new GUI improvements include a 3D 

look and feel together with new dialog 

buttons. 

1.2. SK Editor The new SK editor enables you to 

personalize the Soft keys by changing their 

color, font size, pattern and more. 

1.3. Last Selected SK Indicator The last selected soft key will now be 

indicated by a red border.  

1.4. Hand Tool All Vector dialogs including the Vector PC 

now have a hand tool  which enables you 

to drag the Dialogs around the screen. 

1.5. Master PB Indication The Indication bar will now indicate which 

PB is the Master PB.  

2. Editing  

2.1. Default Behavior of the Update dialog 
box 

You now have the ability to change the 

Default options of the Update dialog box. 

2.2. New Qlist store sequences There are new sequences to store a Qlist 

either on the PB or as Data which can be 

used later on. 

2.3. Grid Editing  We changed some of the Operations of the 

Grid editing and added more key operations.  

2.4. Decimal Value assignment  A new option was added to assign values to a 

Fixture Parameter in Decimal instead of 

Percentage. 

2.5. Main Master Qlist A new mode was added which enables you to 

work with 1 main Qlist which defaults all cue 

operations to that Qlist.  

2.6. Fine tuning for 8 Bit parameters We added an option to use SHIFT + WHEEL 

to fine tune 8 Bit parameters. 
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2.7. Rename of the Tracking General 
Library 

We renamed the Library “Tracking 

General” to General. The Library will still 

function as before. 

3. Playback  

3.1. GO For Multifades You now can enable or disable the option to 

use the GO for fading between Cues while a 

fade is in progress.  

3.2. New Operations that exclude the 
Master PB 

There is a new range of PB Control 

operations that can be used on all the PB's 

without affecting the Master PB. 

3.3. Playback Intensity limit A new feature which enables you to adjust 

the Intensity limit of a PB.  

3.4. Look Ahead Improvements The Look Ahead can now be filtered to either 

work on the Master PB only, or on ALL 

PB‟s. 

4. Patch Manager  

4.1. New Topo options and improvements New Topo options and improvements 

include: 

 Set Stage Measurements in 

centimeters or inches. 

 Decide what fields will be visible in 

the Topo according to the Set Type. 

 Each Set Type has its own unique 

image; Channel, Spot, Matrix or 

Media Server. 

4.2. Matrix Grid Zoom We added a zoom facility which enables you 

to zoom in, out or fit to screen the Matrix 

grid. 

5. System Settings  

5.1. System settings tab layouts We re-arranged the System settings tabs and 

their options in a more logical order to 

improve navigation within the System 

settings. 

5.2. View show name and IP Show name and console IP are now seen in 

the System settings dialog title bar. 
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6. Dimmer Properties  

6.1. New Dimmer properties option With the new Dimmer Properties option, you 

can access the Grand Master and Dimmer 

Curves directly from the Editor Toolbar. 

6.2. Absolute DMX Toggle display With this new option called "Absolute DMX 

Display" you can decide whether to view the 

Absolute Dimmer range or the short Dimmer 

range with Port numbers. 

6.3. DMX Port Swap A new sequence has been added to enable 

DMX Port swapping.  

7. Exam  

7.1. Track Sheet Improvements Now you can show parameters according to 

banks which can be filtered to all parameters 

for that bank or a specific parameter. 

7.2. Quick Dimmer patch information You are now able to quickly get valuable 

Dimmer patch information about a selected 

Dimmer, which will be displayed in the 

Command line. 

7.3. Dimmer Exam View With DMX Exam you are able to Exam a 

whole Port or a specific Dimmer address, 

which is done directly from the Keypad. 

8. DMX Protocols  

8.1. ACN Support Vector now supports ACN Protocol 

9. Vector PC  

9.1. Panel Skins You are now able to select a Panel skin that 

represents a certain Vector console with the 

actual Keys location on the Panel. 

9.2. Hotkey Mapping You are now able to customize the Hotkeys 

mapping on the Panel, according to your 

preferences. 

9.3. Other improvements  Other improvements include: 

 Show/Hide panel title bar 

 Attach the PC Wing to the Panel 
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10. Vector Violet  

10.1. New Physical Wheel Features for 
Vector Violet and Ultra Violet 

The Physical wheels on the new line of 

Vector Violet and Ultra Violet can now be 

pushed down, giving you a faster way of 

selecting and fine tuning parameters.  

10.2. Desk light On Vector Violet we added more desk light 

options to control the Vector Violet 7 Inch 

LCD brightness and the Gooseneck desk 

light. 

10.3. Playback Select Key and Q-Key 
Mode Functions 

A Q-Key mode is now available on Vector 

Violet. In this mode you have direct access to 

20 PB‟s and 20 Q-Keys per single page. 

11. General  

11.1. Grand Master 200% A new option was added to enable the Grand 

Master to exceed 100% of intensity to 200%.  

 

Limitations 

 When dimming desk lights, FULL, ON, or ZR will only work after the Wheel has been 

moved. 

 Beat is not implemented yet. 

 In Try Cue, parameter time progress is not displayed. 

 Qlist and Cue cannot be set as the Numeric default in the Command line. 

 Interactive Fixture selection does not work on a console designated as slave or node. 

 Matrix and Topo selection does not work on a console designated as slave or node. 

 Cue numbers in Qlists on time lines are not updated when re-numbering Cues.  

**Work around: Renumber before teaching the time line. 

 On the Matrix List ► Live view, devices with 16 Bit parameters are not presented 

correctly 

 Mark Cues should not be updated directly. The Update of values on it will cause the 

Mark cue to not function correctly. 
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Bug Fixes – Vector Software 3.18.R03 

Graphical Users Interface – Windows 

1. A new Green Hippo Hippotizer version 3.14 - devices have been added to enable you 

to download thumbs. 

 

 

Real Time 

1. When Violet was in Master/Slave mode, values sent via the Wheels were incorrect. 

This has now been corrected. Thanks to Anton, Russia  

2. When replacing 8-Bit parameters with 16-Bit, values were not recalculated. Thanks to 

Gdynia, Poland, - Jerry Roberto Romani, Italy and Koby, LightVision, Israel.  

3. When in Master / slave and using the Wheel to change values, the values were sent to 

the opposite side in system time and not in real time. This is now fixed. Thanks to 

Klaus Bolte, Germany, - Anton, Russia, - Orit Freedman, BEO, Holland, - Matthias 

Schoeffmann Taronic, Compulite Support Austria. 

4. Exam of device specific libraries did not show the content of that library. This is now 

corrected.  

5. When using a chaser with chase fade-in and back to top on release options, after 

releasing the PB and running it again, the chase fade in was ignored. Thanks to 

Matthias Schoeffmann, Taronic, Compulite Support Austria. 

 

Hardware 

1. The Trackball on Vector Violet was too sensitive and even while pressing other keys 

caused the Trackball to change values. Please make sure you update the firmware. 

2. The Vector external wings (PB and Editor) had distorted images on the LCD display. 

This has been corrected. Please make sure you update the firmware.  Thanks to 

Stephen Plotkin & Paul Grant, Canada, Klaus Bolte & Gerhard Feiner, Germany 
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Bug Fixes – Vector Software 3.18.R02 

Graphical Users Interface – Windows 

1. When examining a Tracksheet in which the Fixture had the same parameters that 

appeared more than once, then the Tracksheet did not show them. This has been 

corrected. Thanks to Orit Freedman, BEO, Holland.  

 

Real Time 

1. In Fixture mode, after copying and then pasting a single parameter to another fixture 

without pressing the Set key (Channel, Spot, etc) did not work. Thank you Orit 

Freedman, BEO, Holland. 

2. When you used the Sequence of RATE, Library Fade time, and then entering zero 

value and moving the corresponding wheel counter clockwise, resulted in a negative 

library fade time. Thanks to Matthias Scoffmann, Austria. 

3. Using shared PB‟s caused the Main PB priority to be saved in Zero priority. This has 

been corrected. Thanks to Matthias Scoffmann, Austria. 

4. The system crashed when changing snaps in master / slave configuration. This is now 

corrected. Thanks to Gerhard Feiner, Feiner – Lichttechnik, Germany 

5. On the 3.18R01 and only on Vector red single core, the middle wing was not 

recognized; therefore it behaved like a “Blue” Vector with one wing and 10 PB 

pages. This has been corrected. Thanks to Bojan Repic, RTV Slovenia and Rob 

Eunson , Epic , Canada.   
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Bug Fixes – Vector Software 3.18.R01 

Graphical Users Interface – Windows 

1. After restarting the Console or PC, the Scheduler disappeared. 

2. On 4D and Sabre the delay timing was not correctly converted. 

3. On 4D and Sabre, Cut timings converted to vector were 0.1. 

4. When pressing on a Channel short-key on the Desktop and sending FULL from the 

Panel Hotkeys, the Desktop crashed. 

5. When opening an already existing desktop on a smaller tab, the Desktop size changed 

and caused the Icons on the Desktop to move. 

6. On the Catalyst, file names showed only the number with no text. Now the File shows 

the number with the Names. Thank you Klaus Bolte. 

7. When loading an image, the Image preview was too small. A zoom scroll bar was 

added to give you the option to zoom in or out of the Image. 

8. When opening a show saved in different regional settings other than English, the 

Show did not load. Thanks to the guys at MUPA, Hungary. 

9. The Workspace or Desktop icons could not be renamed using the Virtual keyboard. 

Thank you Jerry Roberto, Romani, Italy. 

10. When examining a Tracksheet in which the Fixture had the same parameters that 

appeared more than once, then the Tracksheet did not show them. This has been 

corrected. Thanks to Orit Freedman, BEO, Holland.- 7136  

 

Real Time 

1. When you updated a Qlist, and released it, the next Flash did not show the Updated 

values. This has been corrected. Thanks to our clients in the UK and Holland. 

2. When you copied a range of Fixtures and pasted them, only the exact range was 

pasted, not beyond. Thanks to Klaus Bolte, Germany. 

3. When using a chaser with loop count, after the Chaser was released and then run 

again, it ran the loop count with an added loop. Thanks to Gerhard Fiener, Germany.  

4. When a chaser was created with a loop count using the Chase pattern of Bounce and 

Random, the Loop count was totally ignored. This has been corrected. 

5. When Input patch to PB is used and faders were channel mode, the Operations on the 

PB were shifted by 2 PB‟s the left. This has been corrected. Thanks to Moshiko Peer, 

Danor, Israel. 

6. When storing effects on 8 bit parameter, it did not work on 16 bit parameters and 

visa-versa. This has been fixed. Thanks to Klaus Bolte, Germany. 
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7. When the Console is turned on and the Warm data is loaded, the last stored Cue on 

the Indication bar displays 0 instead of the actual last stored Cue. This has been 

corrected.  

8. When using the Editor fade options of, - clear on Master GO or clear on PB GO, the 

Soft key of the Editor fade is not colored in orange. This has been fixed. 

9. When selecting a range of Fixtures, the system gave an error when the end of the 

Range does not exist. This has been corrected. 

10. When you connect in Master / Slave or Master / Node, and you flash a PB on the 

Node or Slave, after a few seconds the Flash stopped working until you flash again. 

This has been fixed. Thank you Matthias Kern, Switzerland. 

11. When using value extraction from Cues [Fixture #, @ Cue #, Enter / Copy], CE did 

not work to fix the Cue selection or the Fixture number. Thanks to Klaus Bolte, 

Germany. 

12. When connecting Master / Slave, the Macro LED 101-106 on the slave was off. 

Thanks to RAI TV Italia & Compulite China. 

13. When assigning a Qlist on the A/B or a PB with the Fader set to X-Fade when the 

Faders are at the Top level, moving the Faders did not activate the Cue correctly. 

Thanks RAI TV, Italy. 

14. When you SOLO a PB using the Flash key, instead of flashing it once and then 

releasing it, it will stay ON. This occurs when you use the SOLO once and not 

SOLO, SOLO. Thanks to Jonathan Cole, Speedy and Alon Cohen, Israel. 

15. Selecting libraries and then Fixtures resulted in a different library being selected 

instead of the Fixture. Thank you, Richard ten Hof, Nationale Reisopera, Holland. 

16. When pressing SET, the LED was on in the old position. Thanks to Agustin Arocha, 

Burple, UK. 

17. Exchange did not work correctly on devices with similar parameters. Thank you 

Klaus Bolte, Germany. 

18. When assigning a loop to a few Cue‟s in a Qlist, and assigning a link from a Cue in 

the Loop range to a Cue outside the Loop range, caused the system to run the loop 

incorrectly. 

19. 8 Bit to 16 Bit Parameter values was not re-calculated when replacing Fixtures in the 

Patch. Thanks to the Operators at Gdynia, Poland. 

20. When you Clone from 8 Bit to 16 Bit, the Parameter values were not Cloned (Copied) 

correctly. Thanks to Orit Freedman, BEO, Holland. 

21.  A Chaser that was running fast on a heavily loaded system caused a random release 

on the Main PB. Thanks to David Bishop, UK.  

22. When using the Snap update option “On any change”, a Submaster or Temp Cue was 

not saved in the Snap. Thanks to David Bishop, BBC and House of Tradition theatre, 

Hungry. 
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23. Macro of Master PB GO, Hold or Back did not work when changing the Master PB. 

Thanks to Jonathan „Speedy‟ Cole, Yaron Shosh, Israel and Ruben De Snoo, Holland.  

24. When using STEP ◄ till the last Cue, then using STEP ► to go to the first Cue, did 

not work. Thanks to Matthias Scoffmann, Austria. 

25. When in Compulite mode and you modify a Cue with parameter time, and finish the 

sequence with STORE, the Editor did not clear as it should. Thanks to Richard ten 

Hof, Holland.  

26. In Master or Slave, the Master lost patch data after shutdown. Thanks to Stephen 

Plotkin, CBC, Canada.  

27. In Master / Slave Sync, the Slave did not show the correct SNAP number. 

28. When working with MSC, the GO command ignored Follow-On Cues and Loops. 

Thank you to Shoko Mishima – SEW, Japan. 

29. After opening a show on an existing show the parameter header had the previous 

show parameters causing confusion in the view and for the operator. Thanks to Chris 

Nathan, GNR Tour 2010.  

30. LOOK AHEAD did not work correctly with an effect on the Dimmer. Thanks to Orit 

Freedman BEO, Holland and House of Tradition Theatre, Hungry. 
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Operating New Features 

 

ATTENTION! 

 

This Vector documentation contains both Action and Enter procedure syntax. Procedures that 

use Action syntax are preceded by:  procedures that use Enter syntax are preceded by:  
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User Interface Improvements 

The Vector user interface on Windows has been improved with a 3D look and feel, with larger 

dialog buttons to assist with better work flow and visibility:  
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The SK Editor  

A new editor dialog box has been added which enables you to personalize the Soft keys on 

Vector. All changes are saved in the System layout. 

The SK Editor enables you to change the following: 

 Soft key pattern 

 Pattern grain and texture 

 Soft key color 

 Font color 

 Font size 

 Soft key width and height 

 Soft key highlight brightness (during mouse hover on a soft key) 

 

ATTENTION! Please Re-save your old layouts in the current version. 

 

Accessing the SK Editor 

There are 2 ways to access the SK editor: 

 From the SK editor icon   located in the Pane title of the Soft keys tabs: 

 

 

-OR- 

 By Right clicking the Mouse anywhere in the SK view that you want to edit: 

 

SK Editor Icon 

SK Editor 

Icon 
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The SK Editor Dialog box 

Once you click on the SK Editor icon, the following dialog box appears: 

 

SK Editor Dialog Box 

 

 

 

 

 

 

 

 

 

 

 

SK Color Preview 

Font Color Preview 

Result Preview 

Function Reset to 

Default Buttons 

Reset all functions back to default 

Width and Height Reset buttons 
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SK Editor Functions 

The following is a list of SK editor functions and their purpose: 

SK Editor Functions What they do.. 

Pattern   From the Pattern drop down list you can choose 9 different types of SK 
patterns. 

SK Color With the Color palette you can choose basic colors or define custom 
colors for the Soft keys. 

Font Color The Font color on the SK can be changed using the Color palette. 

Font Size The Font size can be increased to a max of 40 or decreased to a min of 

10. Use the Bold key  for bold text. 

Grain The Grain slider enables you to manipulate the SK pattern, by adding a 
smooth or ruff finish to the Pattern. The Maximum is 70% Grain. 

Texture The Texture slider changes the amount of texture so that the Image will be 
more of a 3D or flat look pattern. It has a maximum of 100%. 

Highlight By using the Highlight slider, you control the Brightness of the SK when 
the mouse is HOVERING over it. The Maximum is 70% highlight. 

Width The Width of the SK can be adjusted to a minimum of 10 pixels to a 
maximum of 180 pixels. 

Height The Height of the SK can be adjusted to a minimum of 10 pixels to a 
maximum of 180 pixels. 

 

The Default button resets all the Settings to the Factory default. 

 
On the Right hand side of every function, there is a reset button to reset 
the Individual setting back to Default. 

 

The OK button is used to apply the Settings to a particular SK tab only 
and will also close the Dialog box. 

 

The Apply to All button applies the Settings to ALL currently open SK 
views in the Layout. This will then become the Default layout "look" for 
any new SK tab's that is opened. Clicking on the Apply to All button will 
also close the Dialog box. 

 

Note the following: 

 When you use “Apply to All”, the Size and width are not applied to the Editor 

tool bar or Wheel assignment, as there sizes are different than other soft keys. 
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The Last Selected SK Indicator 

The last selected Soft key on each soft key view will now have a red border to indicate the last 

used soft key.  

 

 

The Above image shows the last used soft keys 

 

NOTE: Each time you restart the Application or change the Window size, the Indication will be 
cleared. 
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Hand Tool 

A hand tool  was added to all Vector dialogs to enable you to drag the Dialogs around the 

screen.  

Whenever you see the Hand tool, either LEFT click the Mouse or press and hold on the screen 

to move the Dialog. 
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Master PB Indication 

The Indication bar will now display the current Master PB. 

The following examples show the 3 different types of current Master PB‟s: 

 

Example 1: 

The current Master PB is PB 10 on page 1: 

 

 

 

 

 

Example 2: 

The current Master PB is Q-Key 10 on page 1: 

 

 

 

 

 

 

 

Example 3: 

The current Master PB is on the A/B Cross-Fader: 

 

 

 

 

 

 

NOTE: On Vector Violet ONLY, by pressing and holding the PB SELECT key, will show the 
Master PB on the Fader LCD. See Master PB Indication when using the Playback select 
key. 

When a PB is the Master PB 

 

 

When a Q-Key is the Master 

PB 

When the A/B Cross-fader is 

the Master PB 
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Default Update Options 

You now have the ability to change the Default options of the Update dialog box. 

The Default update options can be accessed from the following: 

 The Update Items dialog box. 

-OR- 

 The System settings dialog box in the Editing tab. 

NOTE: Any changes made to the Update Items dialog box options, which are saved as 
default, will be visible in the System settings Default Update options and vice versa. 

 

 

The Update Items dialog box 

The Update dialog box is where you are able to update Cues and libraries. The Cues affected by 

the Update are displayed in the Cue column. The Libraries affected by the Update are displayed 

in the Library column. You can update all the Items that appear in the Columns or update items 

selectively. Undo is valid for all update actions. 

 

NOTE: The Update Items box can only be accessed once you have an active PB. 

Active Cue 
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The Save as Default and Factory Defaults buttons 

 
 

 

The Save as Default button 

The Save As Default button enables you to change the Default options of the Update items box. 

By using this option you are guaranteed that the Item selected from the Update Items box 

remains saved as the Default. The new Default will be saved in the Show and warm data. 

The Save as Default button can be used with all the Update options except the Copy New Delta 

option.  

 

Example: 
Let's say you always want to use the Back Track option. Then, all you need to do is 

select the Back Track option, and then select Save As Default. This will save the 

selected option.  Every time you return to the Update Items box, the Back Track option 

will still be selected. 

 

 

 

The Factory Defaults button 

The Factory Defaults button returns the Options in the Update Items dialog box to their factory 

Default value which is New to Master PB and Update All Libs options selected. 

NOTE: The Factory Defaults button is grayed out when the Settings are the Default.  
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The Default Update options in the Systems settings 

The Default update options can also be accessed from the System settings under the Editing tab. 

Their functions work in the exact same manner as the Update Items options. See the Update 

Items dialog box options. 

 

 

 

Special conditions for using the Default Update Options 

 Cue Only and Back Track are toggle buttons and therefore cannot be used at the same 

time.  

Example: 

If Cue Only is selected and then you select Back Track, then Cue Only will be de-

selected. 

 

 New to Master PB and Grab All are toggle buttons only and therefore cannot be used at 

the same time.  

Example:  

If New to Master PB is selected and then you select Grab All, then New to Master PB 

will be canceled and Grab All will become selected. 

 

 When the Master PB Only button is chosen, the Grab All button becomes grayed out, 

even if the Grab All button was previously selected. 

Default Update Options in the System 

Settings dialog box. 

 

 

The Restore Factory Defaults button 

restores all the Default Update options to 

their factor default state. 
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New Qlist Store Sequences 

There are new sequences to store a Qlist either on the PB or as data which can be used later on. 

 

Using the new sequences 

The new sequences can be used to do the following:  

a) Store a new Qlist to an empty PB without specifying a Qlist or Cue number. 

b) Store a new Qlist to an empty PB specifying the Qlist number. 

c) Store a new Qlist on an existing PB. 

d) Store a new Qlist without assigning to a PB. 

 

 

To Store a new Qlist to an empty PB without assigning a Qlist or Cue number 

  Existing  Sequence New Sequence 

1. STORE 

2. CUE 

3. SELECT PB 

 

NOTE: In Main Master Qlist mode, 

this sequence will store a new 

Cue to the Main Master Qlist. 

 

1. STORE 

2. QLIST 

3. SELECT PB 

 

 

 

With this sequence a Qlist is automatically created with the first available Cue on an 

empty PB. Every time you use the above sequence on an existing PB, the Qlist number 

will remain the same, but the Cue count will increase. 
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Example 1: 

Creating a new Qlist to an empty PB in a show that has no Qlists: 

Sequence Result 

1. STORE 

2. QLIST 

3. SELECT PB 1 

The Console assigns Qlist 1 to PB1 with the first available 
Cue which is Cue 1. 

 

Qlist 1 on PB 1 with Cue 1 

1. STORE 

2. QLIST 

3. SELECT PB 2 

The Console assigns the next available Qlist which is Qlist 2 
to PB 2 with the first available Cue which is Cue 1 

 

Qlist 2 on PB 2 with Cue 1 

  

 

Example 2: 

Adding a Cue to an existing Qlist in a show that already has Qlist 1 on PB 1 with Cue 1 

setup: 

Sequence Result 

1. STORE 

2. QLIST 

3. SELECT PB 1 

The Console assigns the next available Cue which is Cue 2 
to Qlist 1 on PB 1. 

 

Qlist 1 on PB 1 with Cue 2 

 

 

To Store a new Qlist to an empty PB specifying a Qlist number 

1. STORE 

2. QLIST # 

3. SELECT 

 

With this sequence a new Qlist is created with the specified Qlist number, with the 

first available Cue.  

 
NOTE: A Qlist number will be created if it does not exist. If the Qlist number exists 
then the next available Cue will be created. 
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 Example: 

Let's say you have Qlist 1 on PB 1 and Qlist 2 on PB 2, each having 1 Cue and PB 3 is 

empty. You now want to add Qlist 5 to PB 3 with the first available Cue: 

 

 

Sequence to assign Qlist 5 to PB 3 with the first available Cue: 

1. STORE 

2. QLIST 5 

3. SELECT PB 3 

The result is the following: 

 

 

 

   

NOTE: Storing a new Qlist to an existing PB will overwrite the Qlist on that PB 
with the first available Cue. 

 

 

 

The Console assigned 

Qlist 5 to PB 3 and 

stored the first available 

Cue. 

Assigned PB's with 

Qlist 1 and 2 each 

with 1 Cue. 

PB 3 is empty 
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Storing a new Qlist without assigning it to a PB 

You can store a new Qlist with the first available Cue without assigning it to a PB. The new 

Qlist will be visible in the Show ► Qlists tab spread sheet or SK. 

 

Note the following: 

 Adding a Qlist without assigning it to a PB can only be done by using a 

specific Qlist number. 

 Adding a Cue to an existing Qlist will store the next available Cue on that 

Qlist.   

 

 

To Add a Qlist without assigning it to a PB 

 

1. QLIST # 

2. STORE 

-OR- 

 

1. STORE 

2. QLIST # 

3. ENTER 

 

 

 Example 1: 

Creating a new Qlist without assigning it to a PB: 

Sequence Result 

1. QLIST 1 

2. STORE 

The Console adds Qlist 1 to the Show Qlist storing the 
first available Cue, which in this case is Cue 1.  

 

 

 

Qlist 1 is added 
with the first 

available Cue. 
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NOTE: If you repeat the above sequence with the same Qlist number, then the Console 

will store the next available Cue. 

 

 

Using the NEXT function key 

By using the NEXT function key, you are able to see what the next available Qlist number is. 

The next available Qlist number is shown in the Command line. 

Using the NEXT function key is ideal if you have forgotten the last Qlist number that you used. 

 

To Use the NEXT function key 

 

1. STORE 

2. QLIST 

3. NEXT 

4. SELECT PB 

 

-OR- 

 

1. QLIST 

2. NEXT 

3. STORE 

-OR- 

 

1. STORE 

2. QLIST 

3. NEXT 

4. ENTER 
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Example: 

If you have Qlist 1 on PB 1, Qlist 2 on PB 2 and Qlist 5 on PB 3, and no other Qlists in 

the show, and you want to add an additional Qlist to PB 4, but you are not sure what the 

next available Qlist number is, then you can utilize the NEXT function key as follows: 

1. STORE 

2. QLIST 

3. NEXT 

The next available Qlist number will be shown in the Command line which is 

Qlist 3. 

4. Then press SELECT PB 4 

The available Qlist number was Qlist 3 which has now been added to PB 4: 

 

 

NOTE: When the Option “Automatically assign to Playback” is turned ON and 
you are NOT in Main Master Qlist mode, if the Master PB is free, the Sequence 
above will assign the new Qlist to the Master PB.  

 

 

 

 

 

 

 

 

Qlist 3 has 
been added to 
PB 4 storing 
the first 

available Cue. 
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Grid Editing 

The following new changes were made to the Grid editing: 

 The Windows arrows can now be used to navigate left and right with the given values. 

The up and down arrows will jump between fields as it does now. If there are changes, it 

will apply the change and skip to the next cell. This is similar to using the Arrows, 

Up/Down/Left and Right on the Ascii keyboard. 

 The Next / Prev keys can now be used to navigate like the Console arrow keys do. You 

can also use the Next / Prev keys to toggle between options in the Drop down list. This is 

similar to using the Arrows, Up/Down/Left and Right on the Ascii keyboard. 

 By pressing RESET or SHIFT RESET, will take you out of Grid editing at any point. 

This is similar to ESC from the Keyboard which will also turn OFF the SCROLL WIN. 

 When pressing ENTER after data has been changed, the System will apply the change 

and EXIT the Grid editing and turn OFF the SCROLL WIN. This is similar to using the 

ENTER key on the Keyboard. 

 

NOTE: All the existing options for Grid editing are still the same. 
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Assigning Decimal Value 

A new option was added to assign values to a Fixture Parameter in Decimal instead of 

Percentage. With this new option comes a change to @ Panel key cap: 

 

The ability to enter a number in decimal is especially handy if you are using a media server and 

you want to access a certain folder or file number. The Decimal input can also be used for 

Dimmer parameter operations, such as; proportional level, test etc. 

 

Using the Decimal value sequence 

The Decimal command is a SHIFT operation of the @ key. 

Decimal value assignment is from 0-255. The Decimal value is absolute and will ignore 

European value input. 

 

 

Example: Using a Decimal input for a Fixture dimmer value: 

 

 

1. FIXTURE # 

2. SHIFT 

3. @ (Decimal key ) 

 

 

4. Press Enter. 
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Decimal Input Rules 

The following is a list of input Decimal rules for Enter  and Action sequence modes: 

Input Rule How it works.. 

3 Digit Input 

 

NOTE: You can also use a 3 digit 

number with a “0”(Zero) at the 

beginning; For example: 023 

 

If you input a 3 digit decimal value, the Output will 
be immediate. 

 

After you input a 3 digit value, press Enter. 

Less than 3 digit input If you input a 2 or 1 digit decimal value, the 
Output will not be immediate until you press 
Enter.  

This operation works in both Action  and 

Enter  modes. 

Input value over 255 or a 4 digit input value. Any input value over 255, or, a 4 digit value input 
will cause the Console to select the next selection 
and will ignore the Input value and will not output 
a value. 

 

Example:  

[Channel , 1 , SHIFT, @, 1256] 

Will cause the Console to select Channel 6 

 

 

More sequence examples: 

 Fixture level or Fixture parameter level: 

Fixture, #, CYAN, Shift+@, # 

Fixture, #, ->, #, Shift+@, 010, ->, 120 to Fan the Values 

 Dimmer test level: 

Dimmer, #, Shift+@, # 

 Dimmer proportional level: 

Dimmer, #, proportion level, Shift+@, # 

 Input patch to a MACRO trigger level: 

Dimmer, #, INPUT PATCH To, Macro, #, SHIFT+@, # 
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Main Master Qlist Mode 

The Main Master Qlist mode allows you to work with 1 main Qlist which will always be 

assigned to the A/B Cross fader. 

Every time you store a Cue, by default it will be assigned to the Main Master Qlist even if the 

A/B Cross fader is not assigned. This gives you an easier way of programming by making sure 

that all Cues‟ will be stored to the same Qlist, unless you specify a different Qlist number.  

Once the Main Master Qlist mode is activated, the Master PB will be locked to the A/B Cross 

fader with NO option to select a different Master PB, unless you deactivate the Main Master 

Qlist mode. 

NOTE: The Main Master Qlist can be used in either Compulite or Tracking mode. 

 

 

 

How to enable the Main Master Qlist mode 

The Main Master Qlist mode is enabled or disabled from the System settings dialog box. [Tools 

►Settings ►Editing] 

 

 

 

 

 

The Main Master Qlist button 
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Special color coding for the Main Master Qlist 

The Main Master Qlist has special color coding which helps you identify when the Mode is 

active. The Color coding is Cyan text and/or shade when the Mode is enabled. 

The new color coding can be seen in the following locations: 

 Indication bar – Master PB, Qlist and the last stored Cue fields. 

 Playback – A/B view 

 Playback – Master View – PB Tab 

 Playback – Master View – Cue sheet Tab 

 Playback Wing window 

 

 

Color changes to the Indication bar 

When the Main Master Qlist mode is activated, the Background color on the Indication bar 

[MPB: Qlist: Cue:] changes to the Cyan color, this is an indication that the Main Master Qlist 

mode is now active: 

 

 

 

Color changes in the Playback – Master View in the PB Tab 

 

 

Color changes in the Playback – Master View in the Cue Sheet Tab 

 

 

NOTE: The Color changes in the Playback – Master View in the Cue sheet tab are the same for 
the Playback A/B view as the A/B is locked as the Master PB. 

The Cyan color indicates 
the Main Master Qlist is 

active. 

Active Main Master Qlist – Qlist 1 text is in Cyan 
with A/B and Cue 1 in Cyan shade.  

 

Active Main Master Qlist – Shaded Cyan color on 
the Progress bar for the Active Cue. 
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Color changes in the Playback Wing window 

 

 

 

Using the Main Master Qlist Mode 

When the Main Master Qlist mode is active, any exciting Qlist on the A/B Cross fader will 

become the Main Master Qlist. You can also change the Qlist on the A/B Cross fader which will 

then become the New Main Master Qlist. 

If you activate the Main Master Qlist with no existing Qlist in the A/B Cross fader, then Qlist 1 

will automatically be assigned storing the first available Cue to the Main Master Qlist, unless 

you assign a specific Qlist to the A/B Cross fader. 

There is no available option to have no Main Master Qlist while the Main Master Qlist mode is 

active. If you free the A/B cross fader, the Console will remember the last Main Master Qlist that 

was on the A/B Cross fader, which is still the Current Qlist, until you assign a different Qlist.  

The last Main Master Qlist can be seen in the Status bar: 

 

 

 

 

NOTE: If you are modifying or storing new Cues while working in Tracking or Compulite Mode 

with "Automatically Assign to Playback" enabled, then the System will auto assign the last 

Main Master Qlist to the A/B Cross fader if the A/B Cross fader is not assigned. 

 

While the Main Master Qlist is active you can still store new Qlists on other Playback's in order 

to create Chasers, Looped Cues, Effects, etc.   

You can also store Temp Cues on the A/B Cross fader when in the Main Master Qlist mode. If a 

Temp Cue is stored to the A/B Cross fader, then the Qlist that was on the A/B Cross fader will 

still be the Main Master Qlist. 

 

NOTE: If the "Automatically Assign to Playback" is enabled, then storing the next Cue will 
override the Temp Cue. 

 

The Qlist text is Cyan indicating the Main Master 
Qlist is active and this Qlist is the Main Master Qlist. 

 

The last Main Master 

Qlist was Qlist 5 
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Important notes when the Main Master Qlist is active 

 If the A/B is empty, NO sequence of storing Cues will create a new Qlist on the A/B 

unless you specify a Qlist to the A/B. 

 The Sequence of [STORE, CUE, SELECT] on any PB will NOT create a new Qlist 

as it always did when the Main Master Qlist mode was off. Instead, this sequence will 

assign another Cue to the Main Master Qlist on the Selected PB with the Sequence 

OFF in the Qlist Properties for fast operation as a single Cue. 

 The Qlist field text in the PB View will be in Cyan color. See Special color coding for 

the Main Master Qlist.  

 Any [STORE+ / CUE #, STORE etc] sequence will always store the next Cue to the 

Main Master Qlist. 

 If you free the A/B and not assign a Qlist to it, then the next time you use the 

[STORE+ / CUE # , STORE, etc ] sequences, it will add the next Cue to the Main 

Master Qlist. 

 

Example:  

If your Main Master Qlist is Qlist 6 with Cue 2 and your A/B is empty. 

Store a new Cue using [STORE+ /  CUE #, STORE etc], Qlist 6 will be assigned to the A/B (If 

"Automatically Assign to Playback" is enabled) with the next available Cue, which is Cue 3. 

 

Sequence for creating and assigning a new Qlist to an empty PB 

Due to the fact that in the Main Master Qlist mode the Sequence [STORE, CUE, SELECT PB] 

or [STORE, SELECT PB], (when temp Cues are off), will always store a new Cue in the Main 

Master Qlist.  

The Sequence to assign and store a new Qlist is via the following sequence: 

 

To Store a new Qlist directly to a PB  

 See New Qlist Store Sequences   

 

 

 

NOTE: If you select the A/B to store the new Qlist, then the new assigned Qlist will become 
the new Main Master Qlist. 
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Using Cue operations while the Main Master Qlist is active  

If the A/B is empty, any Cue operation without specifying the Qlist number will automatically 

default to the Main Master Qlist. 

  

Sequence Examples: 

 [Cue #, Exam/ Exam, Cue #, ENTER] 

 [Cue #  #, Loop] 

 [Cue #, Link, Cue #...] 

 [Cue #, Time…] 
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Fine Tuning for 8 Bit Parameters 

An option was added to enable you to use the SHIFT + WHEEL to fine tune the 8 Bit 

parameters, in the exact same way as you can do with the 16 Bit parameters. This will help make 

the Parameter changes slower, which in turn will give you better control of the Parameters. 

When using the 16 Bit parameter with the extra Tilt Fine and Pan Fine wheels, the combination 

of SHIFT + Tilt Fine, will give you extra fine resolution of that parameter. 
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Tracking General Library Renamed  

The Library Tracking General was re-named to General.  

The Short name for the General library has also been renamed to Gen, instead of the Old Trk. 

All previous saved shows prior to the 3.18 release will automatically be converted to the new 

library name. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Library Renamed to General 
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GO For MultiFades 

The GO For MultiFades button can now be used to enable or disable the GO for fading 

between Cues while a fade is in progress. The GO time will run according to the Cue fade time 

which has been entered.  

The GO For MultiFades is located in the Playback tab under the GO Behavior section: 

  

 

 

The Button operates in the following ways: 

Button action How it works 

When Activated While a Cue is in a fading progress, pressing on the GO key will 
instantly fade to the next Cue that is in line, using the next Cue timing. 

Example:  

Cue 4 is fading at 20 seconds and next Cue is Cue 5 which has a fade 
in time of 8 seconds, if the GO button is pressed during the fade, then 
Cue 5 will start its fade at 8 seconds.  

When Deactivated While a Cue is in a fading progress, pressing on the GO key will NOT 
instantly fade to the next Cue that is in line, until the current Cue has 
finished its fade. 

Example: 

Cue 4 is fading at 20 seconds and the next Cue is Cue 5 which has a 
fade in time of 8 seconds. If the GO button is pressed during the fade, 
nothing will happen until Cue 4 has completed its fade; only then a GO 
press is needed to fade to Cue 5. 

   GO For MultiFades button 
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SHIFT + GOTO sequence 

The SHIFT + GOTO sequence enables you to instantly fade to the next available Cue when 

running Cues on the Master PB. This key sequence will instantly force a fade to the next Cue in 

its Cue time. 

The SHIFT + GOTO option sequence is always enabled as long as you have Cues set up on the 

Master PB only, and it is not affected whether the GO For Multifades option is enabled or 

disabled. 

Basically this is a shorter method of achieving the exact same result as using the GO For 

Multifades option. The difference being in that after activating the GO For Multifades option, 

uses just the GO key to jump to the next Cue, whereas the other option is to use the SHIFT + 

GO key sequence together.  

 

Example: 

If Cue 2 has a Time-In of 4 seconds, and Cue 3 has a Time-In of 10 seconds and Cue 2 is 

currently fading IN, if you press the key sequence SHIFT + GOTO, then Cue 3 will 

instantly fade IN, in its Time-In of 10 seconds. 

 

NOTE: In Tracking Mode, if the Values are still fading and they are in Tracking, they will 

continue fading according to their own timing, Cue or parameter timing. 
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PB Control Operations that exclude the Master PB 

There is a new range of PB Control operations that can be used on all the PB's without affecting 

the Master PB. 

The new range of PB Control operations comes with a new sequence: 

[PB Control Command,  (Through Command)] 

Example: 

To free all the PB's except the Master PB, use the Sequence [FREE,]. All the PB's will be 

freed, except the Master PB. 

 

 

New operation sequences  

The following is a list of new PB Control operation sequences that will not affect the Master PB: 

PB Controls with  Command What happens 

  Will Join all the PB's except the Master PB. 

  
 

Will toggle the Trigger ON/OFF on all the PB's 
except the Master PB. 

  Will toggle the sequence ON/OFF on all the PB’s 
except the Master PB. 

  
Will Free all the PB’s except the Master PB. 

   
Will turn ON all the PB’s except the Master PB. 

   
Will Solo all the PB’s except the Master PB. (All 
PB’s will remain Active except the Master PB). 

To Exit from the Solo mode, click on any key or 

the  key. 

   
Will turn all the PB's into STEP mode except the 
Master PB. 

  
Will release all the PB’s except the Master PB. 

  
Will send a GO command to all the PB’s except 
the Master PB. 

  + 

  + 

  + 

  + 

  + 

  + 

  + 

  + 

  + 

TRIG (Shift Seq) 

SEQ  
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PB Controls with  Command What happens 

   
Will send HOLD / BACK command to all the PB’s 
except the Master PB. 

  
Will reverse the direction of all the PB’s except 
the Master PB. 

  
Will select all the PB’s so that you can use the 
RATE Wheel assignment options on all of them 
except the Master PB 

 

ATTENTION! PRIO and SUB MASTER are not supported by the above sequences and 
will generate an "INVALID SEQUENCE" error! 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  + 

  + 

  + 
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Look-Ahead Enhancement  

Now there is a choice to filter the Look Ahead on the Master PB Only or on ALL active 

playbacks. 

The Look Ahead buttons are located in the System settings ► Playback tab: 

 

 

 

The Look-Ahead options are toggle buttons in which only 1 option can be selected at a time. 

 

The Functions of the Look-Ahead buttons 

The following are the Look-Ahead buttons and there functions: 

Button What it does.. 

 
Look-Ahead will work ONLY on the Active Master PB. All the other PB’s will 
work normally ignoring the Look Ahead mask (as if the Look Ahead is 
disabled). 

 
Look-Ahead will work all PBs (as it was in older versions). 

 

NOTE: The Look-Ahead rules apply to both Look-Ahead options. See Chapter 14 in the Vector 
Manual. 
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Playback Intensity Limit 

A new feature has been added which enables you to adjust the Intensity limit of a PB using an 

Intensity limit wheel or via the SETUP PB dialog box. This feature works with Temp Cues, 

Qlists and Chasers. 

The new Intensity limit wheel is simply a faster way of changing the Intensity limit of a specific 

PB without changing the PB fader behavior to Intensity Master. 

The Intensity limit will work on all PB types; QK‟s, PB‟s and the A/B cross-fader. 

 

ATTENTION! The Intensity limit feature will limit any intensity from a specific PB ONLY and 
ONLY if the Fader behavior is other than Intensity Master. 

 

 

Example: 

1. Set spot 1 intensity value to FL and Spot 2 intensity value to 50%. 

2. Store as Cue 1 on PB 1. 

3. Set spot 1 intensity value to 80%, and spot 2 intensity value to 20%. 

4. Store as Cue 2 on the same PB. 

5. Change the PB behavior to All Param (for example) and release it. 

6. From the PB properties dialog box of PB 1, change the Intensity limit using Wheel 3 to 

50%. 

7. Go to Cue 1 on PB 1 – Spot 1 value will be 50% and spot 2 value will be 25%.  

Go to Cue 2 on PB 1 – Spot 1 value will be 40%, and spot 2 value will be 10%  

 

 

Viewing the Intensity limit values 

The Intensity limit values can be viewed in the Wings and Qkeys PB views. 

The Wing view: 

 

The PB Fader behavior 

Intensity Limit value 
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The Qkeys view: 

 

 

Tip! The “Level/Prio” field is optional in the QK Wing view and can be added from the Grid 
properties. 

 

 

How to access the Intensity limit wheel 

There are 3 ways to access the Intensity limit wheel: 

 From the RATE key via the Wheel assignment named Intensity Limit (Wheel 3). 

 From the Wheel assignment of the Playback properties dialog box (Wheel 3): 

 

 From the Qlist properties tab in the Playback properties dialog box: 

 

 

 

How to modify the Intensity Limit 

You can modify the Intensity limit for a selected PB by doing either of the following: 

 Typing an intensity value into the Int. Limit field;  

 Using the Arrows;  

 Spinning the Intensity Limit Wheel (Wheel 3);  

 

Intensity limit value 
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Rules for using the Intensity Limit 

 When a Selected PB fader behavior is set to Intensity Master, then the Intensity Limit 

option in the PB Properties dialog will be grayed out, as the PB fader has priority in 

controlling the intensity of the Selected PB.  

The Intensity Limit wheel via the RATE key will not function and will not change 

anything on the Selected PB. 

 

 When changing the PB fader behavior from Intensity Master to any other behavior, the 

Intensity limit wheel will not be grayed out and the Value will be that of the last used 

fader intensity value. 

 The Intensity limit wheel value is saved in the Qlist properties.  

 When assigning a Qlist to a PB, the Console will always take the Stored Intensity limit 

value from the Qlist properties, unless the fader behavior is set to Intensity Master 

Behavior. 

 

 

Sequences for modifying the Intensity Limit 

In order to use the following sequences, the behavior of the PB faders must be different than 

Intensity Master.  

Using the Intensity Limit can be done from either of the following: 

 The PB properties dialog box 

-OR- 

 The Rate Wheel assignment 

 

ATTENTION! Changing the Intensity Limit by using the following sequences will affect the PB 
output immediately. If the PB is active, then the Intensity Level will change instantly! 

 

NOTE: If the Fixture is an RGB Fixture with no “real dimmer” parameter, but it has a Virtual 
Dimmer, then the Intensity limit will affect the level of the RGB values. 

 

 

 

Intensity limit option is grayed out when a selected PB fader 

behavior is set to Intensity Master. 
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Using the PB properties dialog box 

1. Setup ► Select a PB 

2. Spin wheel 3 to change the Intensity limit value. 

-OR- 

From the Qlist Properties tab, enter a value from 0-100 into the Int. Limit (Wheel 3) 

field, 

-OR- 

Use the Int. Limit arrows: 

 

The Intensity value of the Selected PB will be changed. 

 

NOTE: With this sequence you can only select 1 PB at a time. 
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Using the RATE wheel assignment 

 

NOTE: The PB’s must be occupied in order to use the RATE wheel assignment 
sequences. 

 

The following are the Sequences for RATE wheel assignment: 

PB’s Selected Sequence 

All occupied PB’s 1. RATE 

2. Spin wheel 3  

The Intensity value of all the occupied PB’s will be 
changed if the fader is other than Intensity Master. 

1 PB selected  1. RATE ► Select PB 

2. Spin wheel 3  

The Intensity value of the selected occupied PB 
will be changed. 

Multiple PB’s 1. RATE ► Select PB► Select PB (Select multiple 
faders) 

-OR- 

RATE ► ( To select all except the Master PB) 

2. Spin wheel 3 

The Intensity value of the selected occupied PB’s 
will be changed. 
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New TOPO Options & Improvements 

A new range of options and improvements were added to the Topo. These new options are 

available in the System settings. 

With the new Topo options you can: 

 Set Stage Measurements in centimeters or inches. 

 Set the Fixture Display Set Types; Channel, Spot, Matrix or Media Server 

 Decide what fields will be visible in the Fixture Set Types; Fixture Name, Fixture 

Number, both Fixture Name and Number or None. 

 

    

 

 

 

 

 

 

 

The New TOPO Options  

The Stage measurements settings: 

Fields / Options What They Do 

 

Display measurements in Centimeters 

( New added option ) 

 

Display measurements in Inches 

( New added option )  

Stage Width  Values to increase or decrease Width 

Stage Depth Values to increase or decrease Depth 
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The newly added Fixture Display settings: 

Options What They Do 

 

In the Set Type drop down list you can choose which Set Type 
you want to configure - Channel, Spot, Matrix or Media Server. 

 

NOTE: The Default Set Type is Channel 

 

If Fixture Name is selected then the Name of the Fixture will be 
displayed on the Fixture icon in the Topo view. 

 

If Fixture Number is selected then the Number of the Fixture will 
be displayed on the Fixture icon in the Topo view. 

 

The Apply To All Sets option will use the current Fixture display 
settings on all the other Set Types.  

Example: 

If you have selected to display just the Fixture name and 
you click on the Apply To All Sets then all the Set Types 
will display only the Fixture name on the Fixture icons in 
the Topo view. 
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How the Fixture Display settings affect the Fixture icons 

The new Display settings affect the Fixture icon in the following ways: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When the Option is selected Displayed as 

Both Fixture Name and Fixture Number: 

 

                  
The Fixture name will be visible at the 
TOP.  
 
The Fixture number and Set Type code          
will be visible at the Bottom. 

                                                       
NOTE: This is the Default.   

Fixture Name Only: 

 

 
Only the Fixture name will be visible at 
the TOP.  

 

Fixture Number Only: 

 

 
Only the Fixture number with the Set 
Type code will be visible at the TOP. 

None Selected: 

 

 
No Options will be visiable. 



New TOPO Options & Improvements  

     | 50 

New display format for the Fixture icon 

There is a new display format for displaying information and Set Types on the Fixture icon. The 

Set Type has a Set Type Code. 

 

The Set Type with Set Type Code: 

 

 

  
 
 
 
 
 
 
 

 

 

Note the following: 

 

 The above settings also affect the Topo view in the Patch Manager; the only 

difference is, in the Patch Manager the Address of the Fixture will be visible in 

the middle of the Fixture icon instead of the Intensity Value. 

 These settings also affect the PRINT of the Topo view; the Print data will be 

according to the Patch manager Topo view. 

 

 

New Fixture icons for the Matrix and Media server Fixtures 

In addition to the Spot and Channel Fixture icons, there now is a separate icon for the Matrix and 

Media server. This makes it easier to distinguish between sets that are being used in the Topo 

map. 

The New Fixture icons: 

Matrix Icon Media Server Icon 

 

 

 

 
 

Set Type Set Type Code 

Channel Ch 

Spot Sp 

Matrix Mx  

Media Server Ms  

The New Media Server 
Fixture icon 

The New Matrix Fixture 
icon 

The Set Type code indicating the 

Set Type 

Fixture Intensity Value 

Fixture Name  

Fixture Number 

The Fixture icon in the live view: 
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Configuring the Topo settings 

Configuring the Stage Measurements and / or Fixture display type, can be done before entering 

Topo view or while in the Patch manager Topo view. 

  

Note the following: 

 By default the Measurements are in Centimeters with the Default dimensions of; 

1800cm x 1200cm. 

 The Maximum stage size is 

8000 x 5000 cm  

-OR-  

3150 x 1969 inch 

 The Default for the Fixture display Set Type is Channel with the Fixture Name 

and Fixture Number enabled for all sets. 

 

 

Accessing the Topo settings tab 

There are 2 ways to display the Topo settings tab: 

 From the Tools menu ► Setting ► Topo Tab. 

-OR- 

 From the Patch manager via the Topo toolbar ► Topo Settings. 

 

Using the Topo settings 

The Topo settings can be used for changing the Stage measurements and Fixture display 

 

To Change the Stage measurements 

1. In the Topo tab under the Heading "Stage Measurements", select either Centimeters 

or Inches 

2. Enter the desired measurements in the available fields according to your selection (cm 

/ inch). 

3. Click Apply. 
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To Set the Fixture Display options 

1. In the Topo tab under the Heading "Fixture Display", click on the Set Type drop 

down list and choose the Set Type. 

2. Click on either Fixture name or Fixture number Refer to: New Display format for 

the Fixture icons. 

3. Click Apply. 

Optional – Using Apply To All Sets 

4. Click on Apply To All Sets, to apply the settings to all the Set Types. 

5. Click Apply. 
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Matrix Grid Zoom 

Three new buttons where added to the Pane Title of the Matrix grid inside the Patch manager. 

Now you can zoom in, out or fit the Matrix grid to screen.  

These new buttons can only be used when you are in the Patch manager Matrix list view: 

 

 

 

 

NOTE: Once you set the Zoom for a Matrix grid view, the Zoom will remain unchanged until you 
navigate to the Main Matrix list view. The Zoom of the Matrix grid view will then go back to the 
Default zoom size.  

 

 

 

 

 

 

 

 

 

Zoom In 

Zoom Out 

Fit To Screen 
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System Settings Tab Layouts 

We re-arranged the System settings tabs and their options in a more logical order to improve 

navigation within the System settings. 

Changes were made to the following System settings Tabs: 

 General tab 

 Editing tab 

 Playback tab 

 DMX Protocols tab 

 Topo tab 

 Hardware tab 

 

 

General tab 

The following was added to the General tab: 

 200% option for the Grand Master: 
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Editing tab 

 

NOTE: This tab was originally called the Behavior tab, now it has been changed to the Editing 
tab.  

 

The following was added to the Editing tab: 

 Main Master Qlist option in the Operation Mode section. 

 Default Update Options 

 

 

 

 

New options on the Editing tab 
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Playback tab 

The following was added and moved to the Playback tab: 

 The Look Ahead Active option name was changed to Look Ahead On ALL PB in the 

Look-Ahead section. 

 Look Ahead On Master PB ONLY option in the Look-Ahead section. 

 GO For Multi Fades option in the GO Behavior section. 

 The Default PB Definitions is located in the Playback tab  instead of the Default PB 

Definition tab.  

 The PB keys are now the same as the PB keys in the Real SETUP dialog which makes it 

easier to use on the Touch screen. 

 ALL Auto Snap Update and Snap Options, were moved from the old Behavior tab to 

the new Playback tab. 

 The Ordered Playback Priority and Dip X-Fade were moved from the old Behavior 

tab to the new Playback tab.  

 

 

 

 

New and changed options 
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DMX Protocols tab 

The following was added to the DMX Protocols tab: 

 ACN option in the DMX-On-Ethernet section. 

 ACN check boxes with Check All and Uncheck All options. 

  

 

 

New options 
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Topo tab 

The following was added to the Topo tab: 

 Centimeters and Inches option in the Stage Measurements section. 

 The Fixture Display section which includes: 

 Set Type drop down list 

 Fixture Name option 

 Fixture Number option 

 

 

 

 

Hardware tab 

Warning messages have been added to make you aware of certain actions that could cause a 

malfunction to the Console. 

These messages have been added to the following setting options: 

 Display Settings  

 Network Settings 

 Touch Screen Settings 

 

NOTE! Once OK is clicked, the Warning messages will no longer be valid until Vector is 
restarted! 

 

ATTENTION! Caution is advised when making changes to these options.  

 

 

 

New options 
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Viewing the Show Name and IP 

You are now able to view the Show name and IP address in the System settings dialog. 

 Tools ► Settings 

 

 

 

 

 

 

 

NOTE: On Vector PC the IP will not be shown, unless the Network card is named "Vector 
Network" 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Show Name 

System IP 
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New Dimmer Properties Option 

A new Soft key option has been added to the Dimmer options on the Editor tool bar called 

Dimmer Properties. By using the Dimmer Properties, you can access the Grand Master and the 

Dimmer Curves options, both of which can also be accessed, as always, from the Patch Manager 

(DMX Channel Properties).  

This enables faster and easier access to these options without opening the Patch manager. 

The Dimmer Properties Soft key on the Editor Tool bar:  

 

 

 

The Grand Master and Curve options in the new Dimmer Properties tool bar: 

 

 

 

 

Working with Grand Master and Curve from the Dimmer properties 

The Grand Master and Curve options in the Dimmer Properties work the same way as they do in 

the Patch Manager. 

The Dimmer Properties tool bar contains the Grand Master and Curve Soft keys, together with 

the existing Proportion level and Clear Proportion level Soft keys.  

When using the Grand Master Soft key on a single or a range of Dimmers, the following colors 

apply: 

 Blue, when the Grand Master is OFF for the given range. 

 Orange, when the Grand Master in ON for the given range. 

 Light Orange, when the Grand Master has a MIX of Dimmers ON and OFF for the 

given range.  

 

NOTE: The activity of the Grand Master can also be seen in the Command line: 

  

New added option – Dimmer Properties 

New Grand Master and Curve options 
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When you choose the Curve option from the Dimmer Properties, a new tool bar will open with 

all the existing Dimmer Curves that are available in the Patch Manager.  

The Current active Dimmer Curve for the given range of Dimmers will be highlighted in 

Orange: 

 

 

 

When using the Curve Soft key on a single or a range of Dimmers, the following colors apply: 

 Orange, when one of the Curve options is ON for a given range. 

 Light Orange, when there is a MIX of Curve options ON and OFF for a given range.  

 

NOTE: The Activity of the Curves can also be seen in the Command line: 

 

 

 

How to access the Dimmer Properties 

The Dimmer properties can be accessed by either of the following sequences: 

 DIMMER #  

-OR- 

 FIXTURE #, DIMMER 

 

 

 

 

 

 

 

 

 

 

Curve Options 

Active Dimmer Curve 
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Using the Grand Master option 

Fixtures or Dimmers need to be selected in order to use the Grand Master ON / OFF option. 

  

To Enable or Disable the Grand Master  

1. Select a Fixture or Fixtures.(optional) 

2. Press DIMMER. 

The Dimmer options on the editor tool bar will appear. 

3. From the Dimmer options on the Editor Tool bar, Tap Dimmer properties. 

The Dimmer properties tool bar will appear: 

 

4. Click on the Grand Master to toggle it ON or OFF. 

5.  Press STORE  

 

-OR- 

 Press ENTER 

 

Note the following: 

 If you have a range of Dimmers that the Grand Master is ON and OFF, 

then the color of the Grand Master will be light Orange. 

 If you click on the Grand Master (ON/OFF) while it is light Orange, then 

the console will change all the selected Dimmers to the new setting. 
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Using the Curve option 

 Fixtures or Dimmers need to be selected in order to use the Curve option. 

 

To Change Dimmer Curve  

1. Select a Fixture or Fixtures.(Optional) 

2. Press DIMMER. 

The Dimmer options on the editor tool bar will appear. 

3. From the Dimmer options on the Editor Tool bar, Tap Dimmer properties. 

4. Press Curve. 

The Curve tool bar will appear: 

 

 

NOTE: The Current active Dimmer Curve will be highlighted in Orange. 

5. Select a different Dimmer curve setting if desired. 

6.  Press STORE 

7. -OR-  

 Press ENTER 

 

 

Note the following:  

 There can only be 1 Curve selected. 

 If you have 2 or more Dimmers with different Curve settings, then 

the color of the used Curves will be light Orange. 

 By selecting a new curve setting, all the selected Dimmers will 

change to the new Curve setting.  

 If you select a different Curve setting, it will turn OFF the active 

Curve and Vector will store the new Curve setting. 
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Absolute DMX Toggle Display 

A new option has been added to the Dimmer tool bar, to enables you to view Dimmer patch 

information in 2 ways, which can be seen in the Command line. With the new option called 

"Absolute DMX Display" you can decide to view the Absolute Dimmer range or the short 

Dimmer range with Port numbers. 

 

Accessing the Absolute DMX Display option 

The Absolute DMX Display option can only be accessed after using the following sequence: 

 

1. FIXTURE # 

2. DIM 

 

NOTE: By default this option is OFF. 

 

The Dimmer tool bar: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The New Option; Absolute DMX Display 
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Using the Absolute DMX Display 

The following example shows how you can use the Absolute DMX display: 

 

Example: 

Channel 1 is patched to 3 Dimmers; 

 Dimmer 1 on Port 1 

 Dimmer 1 on Port 2 

 Dimmer 1 on Port 3  

 

The Sequence;  

1. Channel, 1  

2. DIM  

Will display the following in the Command line: 

When Absolute 
DMX Display 
option is.. 

What happens Command Line will 
display.. 

OFF The Command line will 
display the short Dimmer 
range. 

[Channel 1, Dimmer 1, 2/1, 
3/1] 

ON The Toolbar option color will 
be orange and it will display 
the full Dimmer range. 

[Channel 1, Dimmer 1, 513, 
1025] 
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DMX Port Swap 

A new sequence has been added to enable DMX Port swapping. 

The Console will swap the entire Port including external parameters and all DMX properties 

related to each Dimmer. The Console will only allow one Port to be swapped at a time. 

The advantages of Port swapping is that if you need to move all the Fixtures from  Port 1 to Port 

2, instead of clearing the Fixture patches and then re-patching them, you can simply swap the 

Ports. 

Once you have swapped the DMX Ports, you will need to connect the related DMX Port cables 

to the new Port. If you are using Ethernet protocols (IE: VC) you will also need to modify the 

DMX Protocols settings accordingly: [Tools► System settings ►DMX Protocols] 

 

Swap With option on the Tool bar: 

 

 
 

 

Using the DMX Port Swapping sequence 

The SHIFT key needs to be used in order to activate the DMX key. 

 

To Swap DMX Ports 

 
 

1. SHIFT, DMX  

2. Type the Port number to swap. 

3. @  

-OR- 

From the Tool bar click on the Swap With option  

Either way the Command line will display the text [Swap with DMX Port]. 

4. Type the Port number you want to swap with. 

5. STORE 

-OR- 

 

Click ENTER 
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Either way the Console will prompt you with a warning message: 

 

6. Click OK to proceed or Cancel to cancel the swap. 

 

ATTENTION! There is NO UNDO for Port Swap. 
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Track Sheet Improvements 

The following new features have been added to the Track sheet: 

 You can filter the Parameters by Bank types. 

 There is an option to view all the Parameters of the Active bank or view just one 

parameter. 

 Every Fixture number heading is shown in a different color (Blue and Cyan), and the line 

between them will also be in those colors to help you locate them quickly. 

 Fixture names can be seen on the Header of the Fixture, instead of just a number.  

 

 

 

Track Sheet Improvements 

 

 

 

 

 

 

 

 

 

 

 

 

 

Filter by Bank Type 

New grid colors  
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Quick Dimmer Patch Information 

By using the Sequence of [DIM #, FIXTURE…], will allow you to quickly get valuable 

Dimmer patch information about a selected Dimmer. This information will be displayed in the 

Command line and will work in both Action and Enter modes. If the Dimmer has different DMX 

properties other than the Default, they will also be displayed in the Command line.   

The advantage of using this feature is that you can still store the Dimmer to any Fixture number 

as you do now, but you will know in advance if the Dimmer is patched or not before you get the 

override warning. 

 

NOTE: This sequence will only work for SINGLE Dimmer. 

 

How to display Dimmer patch information 

Dimmer patch information can be displayed using the following sequences. These sequences will 

works for ALL set types. 

 

To display Dimmer patch information 

1. DIM #  

2. FIXTURE 

Example: 

If Channel 1 is patched to Dimmer 128, and you use the sequence DIM 128, 

Channel, then the command line will display: 

 

This shows that Dimmer 128 is patched to Channel 1. 

-OR- 

1. DIM # 

2. SHIFT 

3. SET 

Example: 

If Dimmer 1 is patched to Spot 1, and you use the Sequence DIM 1, SHIFT, SET, 

then the Command line will display: 

 

This shows that Dimmer 1 is patched to Spot 1, and the Parameter is Cyan. 
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Example:  

Dimmer 1 is patched to Channel 1. The Default Dimmer parameter DMX 

properties are: Grand master Enabled, Curve Linear and proportional patch of 

100%. Dimmer 1 has GM disabled, Proportional level is set to 80% and the curve 

is set to Preheat 10%.  

Using the Sequence DIM 1, Channel, will display all the changes, since the 

Default has been changed: 

 

 

 

Note the following: 

 

 If the Dimmer is not patched to any Fixture, the Command line will display; 

Unpatched.  

 The Command line will still display the currently patched Fixture regardless of 

the Set type chosen. 
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Dimmer Exam View 

You are now able to examine a full DMX Port or a specific Dimmer address. This is now done 

directly from the Keypad or from the Workspace tree: 

 

Examining a full DMX Port: 

 

 

Examining a specific Dimmer or DMX Port: 

 

 

 

 

 

 

 

 

  

 

 

 

 

The Dimmer Exam tab 

show a specific Dimmer 

The DMX Port Exam tab 

shows a specific DMX 

Port 

The ALL DMX Ports tab 

shows ALL the DMX Ports  
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Examining a specific Port address from the Workspace Tree: 

 

 

 

 

 

How to Exam a DMX Port 

You can Exam a DMX Port by using the new DMX key. 

 

To Exam a DMX Port 

 

1. Press SHIFT + DIM. 

2. Enter a Port number. 

-OR- 

Use the NEXT or PREV keys. 

3. Press Exam. 
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1. Press Exam. 

2. Press SHIFT + DIM. 

3. Enter a Port number. (Example 1) 

-OR- 

Use the NEXT / PREV keys. 

4. Press Exam or ENTER. 

The Default Exam view will be displayed showing the Selected Port. 

 

 Tip! While the Port Exam window is open, you can use the NEXT and PREV keys to 

navigate to the Next or Previous Port. This will only work if you do not press RESET. 

 

 

How to Exam a specific Address 

You can Exam a specific Address by either entering a full range number or a Port / Address 

number. Either way the Exam for the desired address will open. 

 

To Exam a Port / Address number 

 

1. Press DIM. 

2. Enter a Port number. 

3. Press , then enter the Address number.( Example: 3/500) 

4. Press Exam. 

 

 

1. Press Exam. 

2. Press DIM. 

3. Enter a Port number. 

4. Press , then enter the Address number.( Example: 3/500) 

5. Press Exam or ENTER. 
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To Exam a full number range 

 

1. Press DIM. 

2. Enter a full range number (Example: 1524). 

3. Press Exam. 

 

 

 

1. Press Exam. 

2. Press DIM. 

3. Enter a full range number (Example: 1524). 

4. Press Exam or ENTER. 

 

 

Tip! While the specific address Exam window is open, you can use the NEXT and 
PREV keys to navigate to the Next or Previous address. This will only work if you do 
not press RESET. 
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ACN Support 

Vector now supports streaming ACN which enables you to control Fixtures over a network. 

ACN is a simple protocol that offers functionality comparable to existing DMX over Ethernet 

protocols. 

In order to use the ACN Protocol you need to make sure that you‟re Console and Fixtures are in 

the same network environment. 

 

Example: 

If Vector IP is 91.xx.xx.xx and the Subnet mask is 255.0.0.0, then the Fixture IP must 

also begin with 91 and Subnet mask must be 255.0.0.0 

 

How to use ACN 

The ACN options are located in the System settings ► DMX Protocols tab: 
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To Enable ACN 

1. From the Tools menu click on settings. 

2. From the System settings click on the DMX Protocols tab. 

3. Tick the ACN Port that you would like to enable. 

Once you tick an ACN Port/s, the ACN option will become available: 

  

4. Click on the ACN option to enable the ACN Protocol for the selected ports. 

5. Click OK or Apply. 

The Indication bar will show ACN, to indicate that ACN is enabled: 

 

Tip! You can use  or  options to tick or untick the ACN 
selections. 
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Vector PC Panel Skins 

You are now able to select a panel skin that represents a certain Vector console. The Panel will 

now look very similar to the actual console. The Panel buttons and layout will be re-ordered 

according to the actual Console skin that has been chosen. 

  

Example: 

If you choose the Violet skin, then the Panel buttons will be re-ordered according to the 

Panel layout of the actual Vector Violet console. 

 

Changing panel skins enables you to work in a familiar panel environment of a certain Vector 

console therefore making life much easier for you. 

There are 6 Panel skins to choose from: 

 Red – (Vector red console) 

 Blue – (Vector blue console) 

 Green – (Vector green console) 

 Orange – (Vector orange console) 

 Violet – (Vector Violet console) 

 Editor (Remote editor wing) 

 

NOTE: The Default skin is Blue 

 

How to change the Panel skins 

Changing panel skins is done from the Skins menu. There are 2 ways to access the Skins menu: 

1. Right click the Mouse anywhere when you see the Hand curser  

 

-OR- 

2. From the PC panel menu bar  
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NOTE: To reveal the Panel menu bar (Which is normally hidden), place the Mouse over the 
top left hand corner of the Panel. 

 

 

To Change the Panel skin 

1. From the PC panel, click on Skins. 

-OR- 

On the PC panel right click the Mouse when you see the Hand curser, and select 

Skins from the Menu. 

2. From the Skins menu, click on the desired skin 

 

The Panel skin will change immediately.  

 

 

NOTE: When you change the PC Panel skin, it will also affect the Remote PC editor 
and vice versa. 

 

 

 

 

 

 

 

 

 

 

 

 



Hotkey Mapping 

  79 |  
 

Hotkey Mapping 

You are now able to modify the Hotkeys mapping on the PC Panel. This enables you to 

customize your Hotkey mapping according to your preferences. It is also possible to save a few 

Hotkey mapping sets, so that each user can have his own Hotkey set. 

 

NOTE: The Enable Panel Hotkeys option has been moved to the new Hotkeys Menu. 

 

The Hotkeys menu 

The Hotkeys menu contains all the Hotkey options: 

 

 

The following are the Hotkey menu options and there functions: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hotkey edit menu option What it does 

Enable Panel Hotkeys Enable or Disable the Hotkeys for the Panel. 

Edit Hotkeys Mode When enabled, you can edit any Hotkey by 
clicking on the Panel button or Wheel. 

Save Keyboard Hotkeys Mapping Saves the Current mapping of the Hotkeys, to a 
file with the Extension. cvk.  

Load Keyboard Hotkeys Mapping A pre-saved Hotkeys map can be loaded. 

Restore System Defaults Will restore the Factory default hotkey map. 

Clear Hotkeys Mapping Will clear ALL the Hotkeys, so you can start 
mapping the Hotkeys from the beginning. 

Current Panel Hotkeys Mapping Will open a list of current Hotkeys in a new 
window.  
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The Edit Hotkeys dialog boxes 

In Edit mode, pressing on any Panel Key, Wheel or Track ball will open the Edit Hotkeys dialog 

box. Buttons, wheels and the Track ball each have slightly different edit Hotkeys dialog boxes: 

Button Dialog box 

 

 

 

Wheel Dialog box 

 

 

 

 

 

 

 

 

 

 

 

Current Hotkey 

When No Hotkey is assigned, the 
Text in the Box will be [NONE] 

New Assigned Hotkey 

The New assigned Hotkey 
will be visible in this block. 

   

Up and down Parameters 

Used to assign up and down 
Hotkeys 
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Track ball Dialog box 

 

 

 

 

 

The Edit Hotkeys dialog box options 

The following are the Edit Hotkey options and there functions: 

 
Restore the Factory default Hotkey for the Selected key. 

 
Saves the New selected Hotkey. 

 
Clears the Hotkey for the Selected key 

NOTE: If you disable a key, then [NONE] will be displayed: 

 

 
Cancels any changes made to the Selected Hotkey. 

 

 

 

 

Assign up, down, left and right Hotkeys on the Wheel or 
Track ball. 

 

 

 

 

 

Up, down, left, right  

Used to assign up, down, left and right 
Hotkeys 



Hotkey Mapping  

     | 82 

The Panel Hotkeys Mapping List 

The Panel Hotkeys mapping list displays the current panel hotkeys. The Hotkeys list is according 

to the current Hotkeys mapping of the Panel regardless if the Hotkeys are saved or not. From the 

Hotkeys mapping list, you can print and track changes of the current Hotkeys.  

 

 

The Hotkeys list window header will display the Name of the Current loaded Hotkeys map; 

. 

 If any changes have been made to the Hotkeys mapping list, the Window header will display 

“Modified” next to the Hotkeys map name;  

Once the Panel Hotkeys mapping list window is open, you can search for a Hotkey by using Ctrl 

+ F, which brings up a search box. 

 

How to Edit Hotkeys 

Each panel button can be assigned with only 1 keyboard Hotkey. All changes to the Hotkeys are 

temporary until saved.  

There are 2 ways to access the Hotkeys edit menu: 

3. Right click the Mouse anywhere when you see the Hand curser  

 

-OR- 

4. From the Panel menu bar  
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NOTE: To Reveal the Panel menu bar (Which is normally hidden); place the Mouse over 
the top left corner of the panel. 

 

 

To Edit Hotkeys 

1. From the Panel top menu, click on Hotkeys. 

–OR- 

Right click the Mouse and select Hotkeys. 

2. From the Hotkeys menu, select Edit Hotkeys Mode: 

 

 

NOTE: The Command line on the PC panel will display the following: 

      

3. Click on the Panel button or wheel to edit. 

The Edit Hotkeys dialog box will appear: 

 

4. Select the new Hotkey by pressing the Key from the PC Keyboard. 

5. Click Save. 
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NOTE: If the new Hotkey already exists, then you will be prompt with a warning 
message to overwrite: 

 

 

NOTE: The Panel will stay in the Edit mode until you disable the Mode. 

 

Tip: After you have assigned new Hotkeys, you can test them from the PC keyboard, 

provided the Enable Panel Hotkeys is enabled;  

 

 

To Disable edit Hotkeys 

1. From the Panel, click on Hotkeys. 

–OR- 

Right click the Mouse and select Hotkeys. 

2. From the Hotkeys menu, select Edit Hotkeys Mode to disable the Edit mode. 

 

 

NOTE: The Command line on the Panel will return to normal. 
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To Save the Current Hotkey map 

1. From the Panel, click on Hotkeys. 

–OR- 

Right click the mouse and select Hotkeys. 

2. From the Hotkeys menu, select Save keyboard Hotkeys Mapping. 

 

The Save As dialog box will appear. 

3. Type the Name of your Hotkeys file. 

4. Click Save. 

 

 

To Load a Hotkeys map 

1. From the Panel, click on Hotkeys. 

–OR- 

Right click the Mouse and select Hotkeys. 

2. From the Hotkeys menu, select Load keyboard Hotkeys Mapping. 

 

The Open file dialog box will appear. 

3. Select the Hotkeys file you want to load. 

4. Click Open. 
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To Restore system defaults 

1. From the Panel, click on Hotkeys. 

–OR- 

Right click the mouse and select Hotkeys. 

2. From the Hotkeys menu, Select Restore System Defaults. 

 

The Restore Hotkeys warning dialog box will appear: 

 

3. Click Yes to Restore. 

The Hotkeys system defaults will be restored. 
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To Clear Hotkey mapping 

1. From the Panel, click on Hotkeys. 

–OR- 

Right click the mouse and select Hotkeys. 

2. From the Hotkeys menu, Select Clear Hotkeys Mapping. 

 

The Clear Hotkeys warning dialog box will appear: 

 

3. Click Yes to clear Hotkeys. 

The System Hotkeys will be cleared. 
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To View current panel Hotkeys 

1. From the Panel, click on Hotkeys. 

–OR- 

Right click the mouse and select Hotkeys. 

2. From the Hotkeys menu, select Current Panel Hotkeys Mapping. 

 

A New window will open with a list of Current Hotkey mappings: 

 

 

NOTE: When the Current Hotkey mapping list is open, the option on the Menu 
will be grayed out: 

 

 

 

--Optional-- 

To Print the Current Hotkey mapping 

a. To print the Panel Hotkeys Mapping List the Print This Page option; 
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To Search for a Hotkey 

b. To Search for a Hotkey, press Ctrl + F to bring up the search box; 

 

 

 

NOTE: When you change the PC Panel Hotkeys mapping, it will also affect the Remote PC 
editor and vice versa. 
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Other Improvements for Vector PC Panel 

Other Vector PC Panel and Remote improvements include: 

 Show or Hide the Panel title bar 

 Attach the PC Wing to the Panel 

 

 

Show/Hide panel title bar 

It is now possible to hide the Title bar for the Panel and the Wing to save screen space. 

 

Accessing the Option to hide the Title bar 

There are 2 ways to access the Option: 

1. Right click the Mouse anywhere when you see the Hand curser  

 

-OR- 

From the Panel menu bar  

2. Select the Hide Panel Title option to hide the Title bar on both PC Panel and Wing 
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The PC Wing can attach to the PC Panel.  

You are now able to attach the PC Wing to the Panel. This helps you move both the PC Wing 

and Panel at the same time. 

The Wing can be attached to the Panel by simply dragging the Wing close to the Panel corner 

that you want it to attach to. Once they are attached, dragging the Panel only, will affect both the 

Panel and Wing.  

To de-attach the Wing from the Panel, simple drag the Wing away from the Panel. 

 

  

 

 

 

 

Attached from 

the Left 

Attached from 

the bottom 
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New Physical Wheel Features for Vector Violet and 
Ultra Violet 

The Physical wheels on the new line of Vector Violet and Ultra Violet are now pushed down 

wheels, giving you a faster way of selecting parameters and fine tuning parameters. 

 

 

The New "push" down feature includes: 

3. Ability to select a parameter by pushing down on the Physical wheel, instead of; pressing 

on the Parameter bank on the Touch screen: 

4. Fine tuning of a parameter, by pushing the Physical wheel down and turning it, instead 

of; pressing and holding SHIFT while turning the Physical wheel. 

 

NOTE: The rest of the wheel functions are the same as the other consoles. 

 

 

Using the Push down feature on the Wheels 

The Push down feature can be used in the Following ways: 

Doing the Following What happens.. Same as .. 

Pressing down on the Wheel 
only. 

By Pressing the Wheel down 
once without turning it will select 
the particular parameter. 

Selecting the Parameter from the 
Parameter bank on the touch 
screen 

Pressing down on the Wheel 
and turning. 

This gives you finer tuning control 
of the Selected parameter.  

Holding SHIFT and turning the 
Wheel. 
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New Desk Light Control Functions for Vector Violet 

New desk light functions have been added to the Vector Violet only. The Desk light control 

options can be accessed from the Editor Toolbar: 

 

The New desk light control options: 

 

 

Desk light control options 

The following is a list of desk light control options and there functions: 

Desk light control option What it does 

LED Desk Light Controls the LED strip light on the Ultra Violet wide 
screen. 

External Desk Light Controls the Gooseneck external light on the Violet. 

Wide Touch Screen Backlight Controls the Wide touch screen backlight on the Ultra 
Violet. 

7'' Touch Screen Backlight Controls the Backlight of the On-Board 7'' screen on 
the Violet. 

 

To Access the Desk light control functions 

1. Press Setup. 

2. From the Editor Tool bar, click Desk lights. 

3. Use the Wheels to change the levels. 
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Vector Violet Playback Select Key and Q-Key Mode 
Functions 

The Q-Key mode has now been added to Vector Violet only which will simulate 20 Q-Keys. 

This gives the ability to change the functions of the PB select key to the Q-Key control key. 

Once the System is in Q-Key mode you have access to 20 PB‟s and 20 Q-Keys per page. 

Two new buttons have been added to the Vector Violet Console for the Q-Key mode: 

 The Q-Key mode key 

 The Playback Select key 

 

 

 

 

Q-Key Mode 

The Q-Key mode can either be turned ON or OFF. When the Q-Key mode is OFF, there will be 

20 PB‟s per page with NO access to the Q-Keys and the Operations are the same as on all the 

other Vector Consoles. 

When the Q-Key mode is ON (LED is Red), there will be 20 PB‟s and 20 Q-Keys available per 

page and the SELECT keys of the PB‟s will become the Q-Keys control key. The Sequences for 

using the PB‟s and Q-Keys are slightly different as there are NO select keys for the PB‟s and Q-

Keys. 

 

 

 

 

 

 

 

New Buttons added: 

Q-KEY MODE  

PLAYBACK SELECT 
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Q-Key Mode: 

 

 

 

 

 

 

NOTE: Access to the Q-Keys is from the Q-Key mode ONLY. There is NO Access to the Q-Key 
when the Console is not in Q-Key mode. 

 

Playback Select key 

When the Console is in Q-Key mode, the PB‟s and Q-Keys do not have a physical select key, 

which means that most of the PB operations are not available. For this reason a general Playback 

Select key was added to the Vector Violet Console. When pressing the Playback select keys, all 

PB keys become the Select keys. 

The Playback Select key gives you the ability to do all the Playback operations using the same 

sequences that you use on the other Vector consoles with the addition of one more key in the 

Sequence.  

 

Example: 

The Console is in Q-Key mode. If you want to store a new Cue on PB 1, the Sequence of 

[Store, Cue, Playback Select] (All the Playback keys function will change to the select 

key function), then press on any of the Playback keys. The new Cue will be stored on the 

PB 1. 

PB Keys when Qkey 

mode is OFF 

 

Top Row LED’s are for Playbacks. 

The Bottom Row LEDS are for Qkeys. 

PB Keys when Qkey 

mode is ON 

 

Q-Keys when Q-Key is ON 
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Playback Select key mode: 

 

 

 

 

Master PB indication when using the Playback select key 

When you press the Playback Select key, the Faders mode LCD will indicate the current master 

playback: 

 

 

 

 

 

 

 

 

 

When pressed, the Q-Keys control 

key functionality changed to - 

SELECT 

 

 

When pressed, all of the PB 

control key’s functionality 

changed to - SELECT 

 

MPB   # / ## MQK   # / ## MPB   A / B 

When the 

PB is the 

Master 

When the Q-

Key is the 

Master 

When A/B 

the Cross-

fader is the 

Master 
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How to use the Playback Select key 

When the Playback Select key LED is ON, then all the Playback control keys function as a 

SELECT key. The Playback Select key can be used in the following ways: 

 Once only (LED is ON) 

 Multiple times (LED Blinks) 

 Hold down (LED is ON) 

 

Using the Playback Select key once Only 

When you want to do a single Playback operation, one press on the Playback select key (Green 

LED is ON), will turn the Function of all the Playback control keys to the SELECT key function. 

Once you press on a control key, the Playback Select key will turn OFF and all Playback keys 

will return to their original state. 

 

Using the Playback Select key multiple times  

When you want to do a few playback operations at a time, you can double press on the Playback 

Select key (Green LED Blinks), this will turn the Functions of all the Playback control keys to 

the SELECT function key. The Keys of the Playback will remain in the SELECT mode until you 

press on the RESET key or again on the Playback Select key. 

 

Holding down the Playback Select key 

Holding down the Playback Select key is another way of doing a few operations at a time. But 

instead of double pressing on the Playback Select key, you need to press and hold down the 

Playback Select key. This will turn all the Playback control keys to the SELECT function key. 

The Control keys will remain in the SELECT function until you release the Playback Select key. 

 

NOTE: The Playback select key will function outside of the Q-Key mode only for Playbacks  
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The Grand Master at 200% 

A new option was added to enable the Grand master to exceed 100% of intensity to 200%. This 

is extremely useful if you are moving to a bigger venue with an elevated ceiling that requires a 

higher lighting intensity.  

The new option is located in the System settings ► General tab 

 

 

 

Using the Grand Master 200% option 

When switching between 100% and 200%, the System must match the new Grand Master level 

only by going through zero level, either by taking the Fader down to zero level, or by pressing 

the B.O. key when the “Black Out” option is enabled. 

 

ATTENTION! If the Grand master is set to 200% and the Grand master fader is 
disabled and the Grand Master will go to 100%. 

 

When switching between options, the following happens: 

 The GM will flash yellow with an astrix (*). This can be seen in the Command line; 

 

 The B.O  led will blink. 

 Fade the GM fader to 0% then increase the fader to the desired level. 

-OR- 

 Press twice on the B.O key if the Black Out option is enabled.  

 

 

 

The new 200% Grand master option. 
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New Grand Master indication color 

The Magenta color was added to the Grand Master indication area to show when the Grand 

Master is over 100%: 

 When the Grand Master is over 100% the Grand Master indication area changes to 

Magenta;  and the Led on the B.O. button blinks. 
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Version Highlights

1  Display

1.1  Command line Blind mode and ScrollWin indications appear on an orange field.

1.2  Cue sheet The new Param Time field, displayed on the cue sheet, shows the 
fade progress of the parameter with the longest fade-in time.

1.3  Desktop Create Desktop displays and populate them with short cuts for 
quick operation of many console functions.

1.4  Device headers A title bar graphically separates device types in the live display.

1.5  Full screen view When switching to Full Screen view, an info message with instruc-
tions for exiting the Full Screen view, is displayed.

1.6  Grid editing These values can be edited directly in the grid format:
• QList modes and text
• Cue properties can be edited directly on the cue sheet
• Library properties
• Time line values

1.7  Menus Icons in the menus have been upgraded.

1.8  Parked dimmer display There is a dedicated display for parked dimmers.

1.9  Scrolling You can use the mouse to scroll views even if they are not active.

1.10  Touch screen brightness Control the light level on the integral touch screens.

1.11  Workspace Workspaces are additional display screens that provide additional 
display areas. Workspaces are accessed via tabs in the general 
window pane. Each window can contain up to 7 workspace tabs.

1.12  Workspace tree The Workspace tree opens automatically each time a new tab is 
added to a pane.

2  Editing

2.1  Chasers with animated gifs The CREATE CHASER tool on the Matrix screen, automatically 
programs chasers for animated gif files 

2.2  Highlight/Lowlight Cycle through fixtures without exiting highlight/lowlight mode.

2.3  Updating cues during their 
fade

A set of rules govern how cues updates behave during fades.

2.4  Releasing parameter time 
for Enter syntax

The procedure used to release parameter fade times has been 
improved.
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3  Media Server

3.1  Arkaos Support for Arkaos.

3.2  Hippo version 3 Support for Hippotizer V3.

3.3  Catalyst Improved support for Catalyst V4.

4  MIDI

4.1  MIDI • MIDI tables have been expanded.
• MIDI functionality has been improved to include more MIDI 

notes.

4.2  MSC MIDI Show Control (MSC) functionality has been improved.
Note: MSC (and SMPTE) require a hardware upgrade.

5  Patch

5.1  DMX input patch New procedure to clear the DMX input patch.

5.2  Matrix Drag and drop a range of fixture to selected matrix cells. 

5.3  Parked display Park now has a dedicated display.

5.4  Playback input patch Operate Vector playback devices through an external console.

6  Playback

6.1  Flash indications • The playback device’s LED blinks while its flash is active.
• The flash level is displayed in orange in the Playback display 

Fader Level field.

6.2  Goto time Specify time-in when fading to a selected cue on the master play-
back and other playback devices.

6.3  Latch flash key The flash key can be locked for continual flashing until it is 
released.

6.4  Master playback indication The master playback display has green bars to differentiate it from 
the other playbacks.

6.5  Playback selection Select multiple playbacks for global control.

6.6  Playback wing displays • Each playback key has its own field.
• There are three options for the QList field display: QList 

number and name, Qlist number only, Qlist name only.

6.7  Step mode playback Stepping through cues now works with QLists also.
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7  Show file conversion

7.1  Sabre & 4D file names The names of show files that were converted from Sabre and 4D 
consoles, specify the source of the converted file.

8  System Settings

8.1  Art-Net When Art-Net is enabled, the IP Subnet setting defaults to 0.

8.2  Operation mode and syntax 
settings

Compulite mode and Action syntax are automatically set when 
loading shows converted from Sabre or 4D. 

8.3  System Settings tabs The Communication tab has been replaced by three new tabs: DMX 
Protocol, Network, and MIDI/SMPTE.

8.4  Timing Default system time is automatically entered in the Time field if 
the CUT button is disabled.

9  Topo

9.1  Topo display • The zoom and show/hide grid tools are always available on 
Topo views.

• Change stage element text.
• Show/hide stage element text.
• Show/hide the fixture name for fixtures hung on stage elements.
• New icon for a stage element.

10  Vector PC

10.1  Command line indications If the panel is disconnected an indication is displayed in the 
command line.

10.2  Hot keys Some laptops have a graphic card that uses ALT+CRTL+F1 to 
toggle through screens when multiple screens are open. For this 
hot key sequence to be available on Vector PC, disable them in the 
graphic card settings.

10.3  Messages Attempting to close the panel, GcConsole, or real time generates a 
warning message.
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Bug Fixes - Vector software 3.17

Graphical Users Interface - Windows

1. APPLY did not work in the System Settings dialog box.

2. In the Patch Manager, the APPLY button erroneously remained active after tapping it to apply 
patch changes. 

3. Topo did not print correctly. 

4. When adding or releasing parked fixtures, the park exam did not refresh and did not show the 
new data. 

5. Catalyst thumbnails did not work correctly. 

6. In the PB display, the text for Submaster was Temp Cue. Now the text is: Submaster. 

7. No progress bar was displayed when the console was busy opening a show. 

8. Adding a channel to the patch, in a show converted from Sabre, overwrote existing channels. 
Thank you to the crew at Moulin Rouge. 

9. Scrolling cues on the soft key display did not work correctly. Thank you to the crew at Karkov 
Opera House, Poland. 

10. The park exam and the DMX Out exam in the Patch Manager, did not display channels with 
four digits correctly. Thank you Christof Leuba, France, 

11. The data displayed in cue sheets did not refresh. Thank you to the crew at Hed Com, Finland. 

12. The digit 2 was not recognized when defining fixture range under the Every selection 
command (EVERY, 2/#). Thank you to the crew at Hed Com, Finland. 

13. The Matrix Grid and Programmer display set up was not saved with the layout. 

14. When using certain display formats (Time, Library, PB, etc.) in the live channel display, 
resizing the side header column did not work correctly. 

15. In the Desktop right click menu, the option to cancel transparent was missing. 

Real Time

1. If you paged the playbacks while flashing a playback, the output was stuck on stage. Only 
returning to the original page allowed release. Now a flashing playback is immediately 
released when paging.

2. When starting the console, the proportional patch was not loaded. Thank you Andy Stone at 
Fuzion, Great Britain. 

3. If fixture was parked, soft patching it did not park its dimmer. 

4. Enter syntax only! On completing a playback set up, the command line was not cleared and the 
editor did not return to selection mode. Thank you Stephen Plotkin, CBC, Canada 

5. Enter syntax only! After pressing DELETE and then a bank key, the command line showed 
Delete twice. Thank you Stephen Plotkin, CBC, Canada 

6. Enter syntax only! When setting fade time, the system returned an Invalid Sequence message 
when trying to type a number before pressing ENTER to validate the time. 

7. Clearing events on an active time line did not generate a warning message. 
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8. Pressing RELEASE did not stop the flash function. 

9. When flashing a dimmer, pressing FL or ZR generated an Invalid Sequence message. 

10. Exiting a picker by tapping CLOSE did not return the editor to idle (fixture selection mode). 
Attempting to select a fixture changed the parameter value instead. 

11. After running a test on a dimmer from port that has no patched fixtures at all, pressing RESET 
did not release (zero) the dimmer. 

12. Enter syntax only! If a group was used to select fixtures, the control parameter did not work 
and an Invalid Sequence message was generated. 

13. If a time line was active before shut down, it did not return after starting up the console. Note: 
Make sure the time line is stored before shut down. A time line that was not stored will not 
return. Thank you to Roberto (Jerry) Romani, Italy. 

14. When a dimmer was parked, clearing its patched fixture also cancelled the dimmer’s park 
level. 

15. When patching a fixture to a dimmer that was parked, but not patched, the dimmer it kept its 
parked value. 

16. In blind mode, setting an absolute value for a parameter originating from the editor or stage 
and then moving the parameter wheel, bumped the parameter to its original value. Thank you 
to the crew at Dutch View Studios, Amsterdam, Holland. 

17. The system capacity for events has been corrected for 1024 events. Thank you to the crew at 
Moulin Rouge, Paris. 

18. When pasting a value into a cue, a dialog box with the Overwrite All option selected was erro-
neously displayed. Thank you to Andrew Stone, Fuzion, Great Britain. 

19. There were fader matching issues when using a non- motorized Playback Wing with a Vector 
console equipped with motorized wings or with Vector PC. Thank you to Paul Grant, Canada.

20. Sometimes opening a new show did not clear all objects. 

21. Pressing SEQ after loading a cue to a playback device (using the sequence QLIST #, CUE #, 
SELECT) jumped to cue 0. Thank you Gino De-Leo, Spotlight, Italy. 

22. Import did not download all the selected data. Thank you to Klaus Bolte, Germany. 

23. After pressing UNDO to restore deleted macros 101-106, the LEDs for MACRO 101 J 
MACRO 106 did not work. 

24. Left and right mouse buttons did not work on the Editor Wing in mouse mode. Thank you to 
Klaus Bolte, Germany.

25. Keypad equivalents did not work on the Editor Wing in ScrollWin mode. Thank you to Klaus 
Bolte, Germany.

26. Updated values were ignored when updating a cue after it was flashed and then released on a 
playback. Thank you to Andrew Stone and Jonathan Cole (Speedy), Fuzion, UK. 

27. Flash did not work in cut time with solo. 

28. When the command line was too long the head of the command line was not displayed 
correctly. 
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29. In blind mode, editing cues using the long editing procedure (CUE #, values, STORE or 
UPDATE, ENTER for enter syntax) updated the cue immediately. Now, completing the 
sequence by pressing STORE requires reloading the cue using: CUE #, GO or BACK and GO, 
or GOTO. Note: The changes are output immediately when completing the sequence by 
pressing UPDATE instead of STORE.

30. Active playback device output faded to zero if new fixtures were patched in the Patch 
Manager. 

31. Effects jumped instead of fading between cues. 

32. Sometime effects stopped running while fading to the next cue.

33. Playback device priority was not saved in snaps. 

34. When TEACH MACRO was active the key’s LED did not blink. 

35. SHIFT, FREE was not stored in time lines.

36. If DMX input was enabled the console also listened for Art-Net, even if Art-net was not 
enabled. This caused a lot of extraneous traffic on the network. 

37. When editing a fixture that was also under submaster control, pressing @ and then moving the 
dimmer wheel set the value calculated by the submaster level instead of capturing the stage 
value. 

38. Control values that are infinite did not run more then 12 hours. Thank you to Raphael, Crystal, 
France. 

39. Taking the grand master to zero faded RGB parameters to zero along with the dimmer param-
eter. Now this occurs only when there is no dimmer parameter on the RGB device. Thank you 
Andy Stone, Fuzion, Great Britain. 

40. It was impossible to release fixtures from a submaster. To release fixtures from submasters use 
the sequence: Fixture # J #, SUB, SELECT, and tap UPDATE or OVERWRITE in the Object 
Exists dialog box. 

41. If two groups were selected using the soft keys, directly after selecting a group and applying a 
library, parameter values could be set for only the last group in the selection. thank you Vini, 
Israel. 

42. Sometimes when examining the first cue in a Qlist the parameter values color code was incor-
rect. Thank you, Vincent Criulanscy, Eclalux, France. 

43. When context soft keys were set for groups, the setting was lost after using the dimmer wheel. 
Thank you Matthias Kern, Switzerland. 

44. The Every function was limited every ninth fixture. this prevented selections such as 18/12. 
Thank you Matthias Kern, Switzerland. 

45. It was impossible to release a fixture from a submaster. Thank you Andy Stone, Great Britain. 

46. Highlight levels were not consistent when applying highlight to fixtures output from a 
submaster where the submaster fader was not at 100%. Thanks you Vini, Israel. 

47. After pressing PB RELEASE and then flashing a playback device, the playback output was 
stuck on the stage. Thank you, Brian Wagg, Canada. 

48. Storing a mark cue, which included a device that did not have a dimmer parameter, crashed 
Vector. Thank you, David Bishop at Tin fusion, UK. 
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49. The CUE ONLY LIST option, in the Playback Properties dialog box `Assignment Properties 
tab did not work. 

50. The Exclude From Lib(rary) setting in the device definition, was ignored when storing libraries 
manually or generating automatic libraries. Thank you Gino De-Leo at Spotlight, Italy. 

51. Updating a cue during its fade out restarted the fade to the cue that was fading in. Thank you 
Gerhard Feiner, Germany. 

52. For VxWorks systems only! After restarting windows primitive effects and profiles did not 
work unless the show was reloaded. Thank you, David, Canada. 

53. If a snap contained a released playback, the playback’s LED lit when triggering the snap. 
Thank you Stephen Plotkin, CBD, Canada. 

54. Single cue mode (QLIST #, CUE #, Select) did not work when set through Settings `Default 
PB Definitions. 

55. Go commands via playback sliders were ignored when teaching time lines. Thank you Sasi 
Garcia, Earpro, Spain. 

56. Libraries, in shows converted from Sabre or 4D consoles, contained all parameter banks in 
each library. Thank you to the crew at Moulin Rouge. 

57. Effects stored in blind mode did not run correctly. 

58. Updating parameter values that operated under Look Ahead, caused the values to jump. 

59. Opening the camera viewer while running a time line caused a crash. Thank you Roberto 
Romani, Italy. 

60. Effects were released in system time instead of Release Time. 

61. When DMX Input was sent through an ePort, the IP address of the ePort’s was not considered, 
therefore consoles that should have ignored the DMX Input did not. 

62. Art-Net could not be used with DMX Input. 

63. Pasting 8-bit values to a 16-bit parameter did not work correctly. Thank you to the staff at LTT. 

64. The procedure DIM, #/# J # did not work correctly. 

65. No warning message was generated when replacing patched fixtures with another device 
whose DMX requirements were larger than the original device. Thank you Roberto Romani 
(Jerry), Italy. 

66. Loading playbacks with non-sequential QLists did not work correctly. See “Limitations” 
page 9,Item 9. Thank you Klaus Bolte, Germany. 

67. Media server could not be set as the command line default. 

68. Cloning 8 bit parameters to 16 bit parameters did not transfer the values correctly. 

69. The display for values of 16 bit parameters that were cloned to 8 bit parameters was not always 
correct. 

70. BANK FILTERS OFF did not work correctly when selecting specific parameters to include in 
the library. Thank you, Chris Nathan, USA. 

71. In Topo view, it was impossible to remove a fixture from a selection.  

72. In Topo view, there was a small refresh after each mouse click. Thank you to the crew at LTT, 
Poland.  
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73. Compulite mode only! If the playback priority was set to ORDERED PB PRIORITY pressing 
Go after storing some cues to a playback did not initiate a fade from cue 0. Thank you Gino 
deLeo, Spotlight, Italy.

74. When filtering the fixture selection for Every and Even, the selection begins from the first 
even numbered fixture. Examples: If the command is, SPOT 1 J 10, EVERY, EVEN, /3, spot 4 
will be the first fixture in the selection. If the command is, SPOT 1 J 10, EVERY, EVEN, /6, 
spot 6 will be the first fixture in the selection.  

75. Desklight settings were not remembered.  

76. The first cell was always skipped when selecting matrix cells with the mouse.  

77. Re-occurrence events did work correctly in the Scheduler. thank you Alex Li, Macostar, 
China.  

78. The (PB) On command when used after releasing a playback did not work. Thank you to the 
crew at LTT, Poland.  

Hardware

1. MIDI and SMPTE reception stopped after approximately five days of constant operation. 
Thank you to Till Grab, Germany and to Shoko Mishima, SEW, Japan. 

2. When MIDI and MSC were enabled, sending an MSC command stopped all MIDI and MSC 
operation. 

ATTENTION! Improved MSC and MIDI function require a hardware upgrade.

3. Playback faders tended to jump on a manual fade in (especially when the Intensity Behavior 
was set to GO + JUMP or ALL PARAMETERS). Playback fader sensitivity from 0 - 3% has 
been damped down. Thank you to Alon Cohen, Israel. 
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Limitations

1.  When dimming desk lights, FULL, ON, or ZR only work after the wheel has been moved.
2.  Beat is not implemented yet.
3.  In the TOPO view, the dimmer levels for 16-bit dimmer devices are not displayed in percent-

age format.
4.  Fixture name is limited to 16 characters.
5.  In Try Cue parameter time progress is not displayed. 
6.  QList and Cue cannot be set as the numeric default in the command line. 
7.  Interactive fixture selection does not work on a console designated as slave or node.  
8.  Cue numbers in QLists on time lines are not updated when renumbering cues. Work around: 

Renumber before teaching the time line.
9.  There are some limitations when loading a range of QLists to playbacks.

a. When loading a sequential range (# J #), all QLists are loaded. If, within the selected range, 
there are QLists that don’t exist, they are programmed now. Example: the selected range is 
QLists 1 J 8. There is no Qlist 6 and 7. When loading the playbacks, the system automati-
cally creates QLists 6 and 7.

b. If the selected range is not sequential (# J #, + #, +#) and all the selected Qlists exist, they 
are loaded to the playbacks.

c. If the selected range is not sequential (# J #, + #, +#) and some of the Qlist in the selected 
range do not exist, nothing is loaded to the playbacks. 
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Operating New Features
ATTENTION! Starting from this version, the Vector documentation contains both Action 
and Enter procedure syntax. Procedures that use Action syntax are preceded by: ; 
procedures that use Enter syntax are preceded by: .

1   Display

 1.1  Command line

 1.1.1 Blind mode

When BLIND is active it is indicated in the command line and in the Indication bar.

Example:

 1.2  Cue sheet

The new Param Time field, displayed on the cue sheet, shows the fade progress of the parameter 
with the longest fade-in time.

 1.3  Desktop

 1.3.1 Desktop overview

Desktop is a special display area that functions just like the desktop on your pc. Populate it with 
icons for one click or hot key operation.

The Desktop is populated by dragging and dropping:

� Object soft keys

�Menus

�Menu items

� Tool bar objects

� Picker items
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Figure 1: Desktop Populated with icons

Desktop panes and icons populating the desktop can be customized through the Desktop and icon 
right click menus.

 1.3.2 Setting up Desktop views

ATTENTION! When populating the Desktop, the display must be unlocked:  
(when unlocked the Desktop pane has a cyan colored frame)
When finished, be sure to lock the display: .

The Desktop icons function only if the display is locked! 

View manipulation on the desktop is through the Desktop tool bar.

Figure 2: Desktop navigation tools

To set up a Desktop

1  Open the Workspace tree and expand the Desktop List node.

2  Activate a pane and right click anywhere in the pane.

The display control shortcut menu opens.
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Figure 3: The display shortcut menu

3  Tap Add Desktop.

In the Workspace tree, a Desktop is added to the Desktop List.

4  In the Workspace tree, tap the new Desktop.

A new tab, labeled Desktop #, is added to the active pane.

To rename a Desktop

1  In the Workspace tree, tap the Desktop List node.

The active pane shows the Desktops in grid format.

2  Double tap in the Name column of the new Desktop.

3  Type the Desktop’s name.

This name is displayed on the Desktop’s tab.
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To delete a Desktop

1  Make sure that the Desktop you are deleting is active.

2  Right click anywhere in the Desktop.

The Desktop right click menu opens.

Figure 4: Desktop right click menu

3  Choose Delete.

The Desktop is deleted.

OR 

1  Open the Workspace tree and tap the Desktop List node.

The active pane shows the Desktops in grid format.

2  Right click in any column in the Desktop row.

3  Choose Delete.

4  The selected Desktop is deleted and no longer appears in the Desktop List.

To customize the Desktop appearance

Right click anywhere on the Desktop and choose an option from the right-click menu.

Figure 5: Desktop right click menu
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 1.3.3 Populating the Desktop

ATTENTION! To populate a Desktop, the display must be unlocked. Either click the lock 
icon or enable Edit mode in the Desktop right click menu.

To populate a Desktop

Example: Place a shortcut to macro 999 on the Desktop.

1  Display the macro soft keys.

2  Right click the soft key for macro 999 twice and hold down the right mouse button.

3  Drag the soft key onto the Desktop and release.

Now you can trigger macro 999 by tapping its icon.

4  Repeat steps 1 through 3 for as many items as required.

Note:  To drag a soft key, it is always necessary to right click twice in order to grab it.

Example: Place a shortcut to a picker item on the Desktop.

1  Open the picker.

2  Right click on the image required and hold down the right mouse button.

3  Drag the image onto the Desktop and release.

4  Repeat steps 1 through 3 for as many items as required.

5  When finished, close the picker.

To add fixtures to the Desktop via topo

1  Open a topo view.

2  Select a fixture or a group of fixtures and drag them onto the Desktop.

 1.3.4 Editing Desktop icons

The Desktop icon right click menu provides tools for editing icons.

Figure 6: Right click a Desktop icon to open this menu
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To change an object’s icon and text tag

ATTENTION! To change an icon or text, the display must be unlocked. Either click the 
lock icon or enable Edit mode in the Desktop right click menu.

1  Right click the icon and, from the shortcut menu, choose Change Icon. 

2  Browse to the folder where icons are stored and select an icon.

3  Click OK.

4  Right click the icon and, from the shortcut menu, choose Rename. 

The text field is now selected

5  Type the new name.

To change the icon for more than one object

Example: Change the icon for all the soft key groups appearing on the Desktop.

1  Select multiple icons by holding down Ctrl and clicking each icon

 Or

Hold down the left mouse button and drag a rectangle around the icons.

2  Right click one of the selected icons and, from the shortcut menu, choose Change Icon. 

3  Browse to the folder where icons are stored and select an icon.

4  Click OK.

The icon is applied to the selected objects.

5  Remember to lock the display by clicking the lock icon on the tool bar or right click in the 
desktop and, in the shortcut menu, click Edit Mode to remove the check and lock the 
display.

Change icon Automatically opens a folder in Windows Explorer where you can find 
many *.ico and *.bmp files to use as icons in the Desktop.

Transparent color choose one color, used in the icon, to make transparent. Improves visi-
bility of icons.

Transparent corner Make the color in the corner of the icon transparent.

Disable transparent Remove the transparency for the selected icon(s).

Delete Delete the selected icon(s).

Copy Copy the selected icon(s).

Rename Change the text tag for the selected icon.

Add Hot Key Open the Add Hot Key dialog box to set a hot key for the selected icon(s).
Note: One letter or one number, or combinations using CRTL+ a letter or 
SHIFT +a letter can be used. Symbols are not valid for use as hot keys.

Delete Hot Key Delete the hot key for the selected icon(s).
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To use transparency for improved visibility

1  Right click an icon or select a group of icons.

The icon shortcut menu opens.

2  Choose Transparent Color.

The Color dialog box opens.

3  Tap the color.

4  Tap OK. 

The selected color is now transparent on the Desktop icon.

OR 

1  Right click an icon or select a group of icons.

The icon shortcut menu opens.

2  Choose Transparent Corner.

The color that appears in the corner of the icon is now transparent.

 1.3.5 Setting up hot keys

You can set up hot keys that will operate the Desktop icons with one press on the keyboard. Hot key 
status is saved with the show.

ATTENTION! Hot keys will not work hot keys are not enabled - .- or if the display 
is not locked.

To enable or disable hot keys

 On the Desktop tool bar, click . and make sure the display is locked .

To create hot keys

1  Make sure that hot keys are enabled.

2  Right click an icon.

The icon shortcut menu opens.
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3  Choose Add HotKey.

The Add HotKey dialog box opens.

Figure 7: Add HotKey dialog box

4  Enter a hot key string by typing on the keyboard.

One letter or one number, or combinations using CRTL+ a letter or SHIFT +a letter can be 
used. Symbols are not valid for use as hot keys.

5  Tap SAVE.

The dialog box closes. The hotkey is displayed, in parentheses, as a prefix to the icon’s 
name. Example: The palm leaves gobo hot key is (p).

To delete a hot key

1  Right click an icon.

The icon shortcut menu opens.

2  Choose Delete HotKey.

The hot key is deleted and is no longer displayed. with the icon

ATTENTION! Hot keys are global; they are valid for all Desktops.

To use the hot keys

 Type the hot key on the keyboard.

OR 

You can operate more than one hotkey at the same time.

1  Press and hold the left house button. 

2  Drag a rectangle around a group of icons on the Desktop.

3  Release the mouse button. 

All hot keys within the rectangle are triggered.
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 1.4  Device headers 

In the live display, a device title bar (header) separates groups of devices by type. Example: There 
are 24 patched VL 3000Spot fixtures (spots 1 J24) and 12 patched VL3000Wash (spots 25J36). 
A device header is placed between spots 24 and 25.

Grid columns are common to the entire display. If a particular type of device does not contain 
certain parameters, the column for that parameter is left blank. Example: Varilite 3000Spot and 
Varilite 3000Wash are used in the show. Of course, the VL 3000Spot has gobo parameters and the 
VL3000Wash does not, so the gobo parameter column shows no values in the VL3000Wash section 
of the live display. Scrolling is also common to the entire display.

Figure 8: Live spot display with headers separating types of devices

To show device headers

 Open the View menu and choose Headers Per Device.

 1.5  Full screen view

When switching to Full Screen view, an info message with instructions for exiting the Full Screen 
view, is displayed.

 1.6  Grid editing

Edit text and some values directly in grids (spread sheets).

Grid display What can be edited

QList exam • QList mode (toggle Normal or Chaser)
• QList name

Cue sheet • Cue name
• Fade times
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When SCROLLWIN is active, you can use console keys or the equivalent keys on an external 
keyboard to navigate the grid and for editing 

To edit cell information

Example: Edit a cue sheet.

1  Double click the cue name cell. 

2  Type the new text.

3  Press ENTER to apply the change.

 1.7  Menus
Icons in the menus have been upgraded. functionality has not changed.

 1.8  Parked dimmer display
Park now has a dedicated display.

 1.9  Scrolling

You can use the mouse to scroll in panes even if they are not active.

Libraries • Library name
• Mode (Device Specific, Fixture Specific, Pattern)
• Parameters (included in the library)

Groups Group name

Macros Macro name

Snaps Snap name

Time Line • Time code
• Fade times

Console key External keyboard What is does

ENTER Enter Applies the changes and moves to focus to the 
cell below.

J Tab Moves one cell right.

SHIFT J Shift + Tab Moves one cell left.

Arrows Arrows Navigate cells up and down or right and left.

NEXT and PREV Page up /Page down Cycle through options in a drop down list.

DELETE Delete Delete text.

CE Backspace Backspace. Deletes one character.

Grid display What can be edited
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To scroll panes

 Make sure mouse is active (LED on), hover on any pane and scroll as usual.

 1.10  Touch screen brightness

To control the light level on the integral touch screens

1  Press SETUP.

The tool bar is now in setup mode.

2  Tap DESK LIGHT.

3  Use wheel 4 (Vector Touch Screen Backlight) to adjust the light level.

 1.11  Workspaces

Workspaces are additional display screens that provide more work areas. You can create a dedi-
cated workspace for playback information, live displays, etc.

Each main window can contain more than one workspace. Workspaces are accessed by tabs located 
above the command line, so switching is very simple. 

Workspaces are saved as part of the layout or they can be saved separately and loaded for re-use.

Note:  Up to 7 Workspace tabs are allowed per window.

The default workspace is called Main and is the first workspace tab. Workspace tabs can be 
renamed and their order can be changed.

Figure 9: Workspace tabs and their navigation controls

To add and configure workspaces

1  Right click anywhere in a window and, choose Add Workspace from the right click menu.
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Figure 10: View controls - right click menu

 Or

Go to the Window menu `  Window Options and choose Workspace.

A workspace is added to the window. Its tab appears to the right of the last tab. 

2  Right click the new tab.

The display control, right click menu opens.

3  Choose Rename View.

4  Type a new name for the workspace and press ENTER.

5  Using the tools in the Window menu divide the workspace into panes and add tabs, as 
necessary

6  Open the Workspace tree .and set up the view as is suitable.

Example: If you have created a Live workspace, you will probably want to show the live 
fixture displays, the master playback display, and the playback wing display.

7  Optional - Save this as a display layout. 

To change the order of the Workspace tabs

1  Make sure the display is not locked.

2  Drag the tab to a new position.

To save a Workspace

The Workspace file extension is: csl.

1  Go to the Window menu `Layout `chose Save Workspace. 

The Save As dialog box opens to the default folder.

2  Optional - browse to a different folder

3  Type a name in the File Name field.

4  Tap SAVE. 

The workspace is saved.
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To load a Workspace

1  Tap Window`  Layout `chose Load Workspace. 

The Open dialog box opens.

2  Select a Workspace from the list of *.csl files.

3  Tap OPEN. 

The Workspace is loaded.

 1.12  Workspace tree

The Workspace tree opens automatically each time a new tab is added to a pane.

2   Editing

 2.1  Chasers with animated gifs

The CREATE CHASER tool in the matrix programmer automatically programs chasers for 
animated gif files. Save each chaser in a new QList.

Figure 11: Matrix programming controls

To automatically program chasers

1  Display the matrix programmer.

2  Tap LOAD FILE. 

The Open dialog box opens.

3  Browse to the animation and double click to open. 

4  The first animation frame is displayed.

5  Optional - tap AUTORUN to preview the animation.

6  Tap CREATE CHASER.

The Create Chaser dialog box opens.

7  Fill in the fields.
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Figure 12: Create Chaser dialog box

8  Tap CREATE.

One cue is automatically stored for each frame in the selected range. While cues are stored, 
a progress bar is displayed in the Create Chaser dialog box.

 2.2  Highlight/Lowlight

It is no longer necessary to select fixtures before activating the highlight/lowlight mode.

While in highlight or lowlight mode, most programming operations (such as storing and updating 
cues, storing and updating libraries, and applying fans) are available. 

Note:  Storing or updating a cue when in HI.LIGHT or LO.LIGHT mode, stores all the 
values originating in the HI.LIGHT or LO.LIGHT palette that are active in the 
editor.

Selecting unavailable features (such as, Rem Dim, flash, and all parameters except dimmer and 
position) generates the error message Not available in Highlight mode.

Highlight or Lowlight appears in the command line as long as the mode is active.

To apply highlight or lowlight

1  Press HI.LIGHT or LO.LIGHT.

Highlight or Lowlight appear in the command line.

2  Select a fixture, or a range of fixtures, or a group.

3  Move the pan/tilt wheel or trackball to initiate the highlight feature.

4  Press NEXT or PREVIOUS to move to the next or previous fixture.
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5  To jump to another fixture, select a new fixture and again move the pan/tilt wheel or track-
ball to initiate the highlight feature.

To exit highlight or lowlight mode

1  Clear the command line by pressing SHIFT + z or SHIFT+ CE.

2  Press the active mode -HI.LIGHT or LO.LIGHT.

The mode is no longer indicated in the command line.

ATTENTION! Pressing HI.LIGHT or LO.LIGHT without clearing the command line, 
clears the HI.LIGHT or LO.LIGHT values. Pan/tilt and dimmer changes are retained in the 
editor and the system is still in HI.LIGHT or LO.LIGHT mode.

To switch between highlight and lowlight modes

 Press SHIFT + HI.LIGHT or LO.LIGHT

 2.3  Updating cues during their fade

What happens when updating cues while they are fading in or out?

Example 1
The parameters have values in both cue 
1 (fading out) and cue 2 (fading in).
Update cue 1.

What happens after pressing UPDATE?

Cue 1 
(outgoing)

Chan 1 @ FL 
Chan 2 @ FL 

Editor:
Chan 1 @ 80
Chan 2 @ 80

The editor is released, in default system time, 
to the parameters’ current values and, if neces-
sary, the values complete their fade in the 
remaining cue time.Cue 2 

(incoming)
Chan 1 @ 50 
Chan 2 @ 50

Example 2
The parameters do not have values in cue 2 (fading in).
Update cue 1.

Cue 1 
(outgoing)

Chan 1 @ FL 
Chan 2 @ FL Editor:

Chan 3 @ 80

Compulite mode - The editor is released and 
parameters fade to their released (or home) 
value in system default time. 
Tracking mode - The editor is released and 
parameters fade to their tracked value in 
system default time.

Cue 2 
(incoming)

Example 3
Update cue 2 (is fading in)
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To edit cues during fades

: 

 Select fixtures and edit values, CUE #, UPDATE.

OR 

 CUE #, Select fixtures and edit values, STORE.

 Select fixtures and edit values, CUE #, UPDATE, ENTER.

 2.4  Releasing parameter time for Enter syntax 

The procedure used to release parameter fade times has been improved.

To release parameter fade time (Enter syntax)

1  Select the cue.

2  Select the fixtures.

3  Select a parameter. 

More than one parameter can be selected and entire parameter banks can be selected via 
INTENS, POS, COLOR, BEAM, IMAGE, SHAPE.

4  Press TIME.

5  Tap TIME IN or DELAY IN or both.

6  Press DELETE.

7  Press UPDATE.

8  Press ENTER.

The fade times, for the selected parameters, are deleted.

3   Media Server

 3.1  Arkaos

To connect Arkaos to Vector

1   Change the Arkaos media server subnet to match Vector's subnet. 

Cue 1 
(outgoing)

Chan 1 @ FL 
Chan 2 @ FL Editor:

Chan 3 @ 80
The editor is released in system time, but the 
updated value stays where it is until the fade is 
complete.Cue 2 

(incoming)
Chan 1 @ 50 
Chan 2 @ 50

Updating fade times (Action syntax: CUE #, TIME #, UPDATE) (Enter syntax: CUE #, UPDATE, 
ENTER) during a fade does not change the time for the fade in progress. The new fade time is 
used the next time.

What happens when updating cues while they are fading in or out?
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If Vector IP is 91.xx.xx.xx, then the Arkaos IP must also begin with 91.

To configure Arkaos

These instructions are for Arkaos version 3.6.5.

1  Change the Arkaos computer workgroup to COMPULITE.

Go to Control Panel `  double click System `Select the Computer Name tab `  Click 
Change`  Type COMPULITE in the Workgroup Name field. Click OK twice and close the 
Control Panel.

2  Restart the Arkaos computer if the workgroup name or IP address was changed.

3  Run the Arkaos application - .

4  On Arkaos open the Edit menu, select Preferences, then select DMX Setup.Choose 
Preferences.

ATTENTION! If DMX Setup does not appear in Preferences (on Arkaos), Arkaos is 
either in demo mode or you do not have a DMX Key registration.

5  From the shortcut menu, choose DMX Setup.

6  Configure according to Figure 13.

Figure 13: Arkaos DMX setup
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Figure 14: Arkaos Art-Net setup

To patch Arkaos devices on Vector

1  Open the Vector Patch Manager.

2  Import the Arkaos devices according to the Arkaos configuration (Maxi, Full, or Tiny). 

3  Create and patch Arkaos devices according to the number of layers configured in the 
Arkaos media server. 

ATTENTION!  To download thumbnails media server devices require exact names!
IF ARKAOS IS RUNNING ON WINDOWS! Make sure that the Arkaos device names 
are identical to the Arkaos computer name. Example: If the Arkaos computer name is 
Arkaos-00123, the devices must be named Arkaos-00123_1, Arkaos-00123_2, etc.

IF ARKAOS IS RUNNING ON MACINTOSH! The name of the Arkaos device must be 
identical to the IP address of the Arkaos computer. If Arkaos computer IP is 90.2.6.8 
the devices names must be 90.2.6.8_1, 90.2.6.8_2, 90.2.6.8_3, etc.

4  Save and exit the Patch Manager.

 3.2  Hippotizer Version 3

To connect Hippotizer V3 to Vector

1   Change the Hippotizer V3 subnet to match Vector's subnet. 

If Vector IP is 91.xx.xx.xx, then the Hippotizer V3 IP must also begin with 91.

To configure Hippotizer V3

These instructions are for Hippotizer version 3.0.12

1  Change the workgroup for the Hippotizer media server to COMPULITE. Go to Control Panel 
`  double click System `Select the Computer Name tab `  Click Change`  Type COMPU-
LITE in the Workgroup Name field. Click OK twice and close the Control Panel.

2  Restart the Hippotizer computer if the workgroup name or IP address was changed.

3   On HippoNet Overview, open the Engine Settings to select the mode.

4  Run the Hippotizer Engine -  and then the Zookeeper - .
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Figure 15: Hippo V3 Setup (see the Hippotizer user’s guide)

5  On HippoNet Overview, open DMX Component Settings to set DMX and Art-Net 
configuration.

6  Check DMX On.

7  Uncheck Update.

8  Double click an Art-net universe to change the Art-Net configuration.

Figure 16: Hippotizer V3 DMX setup (see the Hippotizer user’s guide)

ATTENTION! To connect with Vector, the Hippotizer media server must have a DMX 
component and an Hmap2 Server Component. In HippoNet Overview, check if these 
components are present. If they do not appear, add them to Hippotizer.
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To patch Hippotizer V3

1  Open the Vector Patch Manager.

2  Import, create, and patch Hippotizer devices. 
 

3  Save and exit the Patch Manager.

ATTENTION! 
To download thumbnails media server devices require exact names! Example: If the 
Hippotizer name is Hippov3-00123, the fixture layers must be named Hippov3-00123_1, 
Hippov3-00123_2, etc.
If media files have been added to Hippotizer V3, it is necessary to restart the Hippotizer 
software to download the new thumbnails.

 3.3  Catalyst

Vector supports Catalyst media servers from Catalyst version 4.0.

To connect Catalyst to Vector

1  Change the Catalyst media server subnet to match Vector's subnet. 

If Vector IP is 91.xx.xx.xx, then the Catalyst IP must also begin with 91.

Device Mode Number of devices to create and patch

Single 1 x Hippotizer Master V3
8 x Hippotizer Layer V3
1 x HippoTimeLineControl V3

Dual 1 x Hippotizer Master V3
4 x Hippotizer Layer V3
1 x Hippotizer Master V3
4 x Hippotizer Layer V3
1 x HippoTimeLineControl V3

Pan 1 x Hippotizer Master V3
1 x Hippo Pan Master V3
8 x Hippotizer Layer V3

IMPORTANT!   The DMX address for the Master must always be before the 
DMX address of the layers. Example: Master is DMX 1 and the layers start at 
DMX 46.
In each mode, set DMX addresses according to the order that the devices 
appear in this table.
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Figure 17: Catalyst Mac Network Settings dialog box (see the Catalyst user’s guide)

To verify the connection between Vector and Catalyst

1  Make sure the Catalyst computer is running.

2  On Vector, browse to http://[Catalyst_IP]:8080/catws/files.html. 

Example: browse to http://91.0.0.5:8080/catws/files.html - where 91.0.0.5 is the Catalyst 
computer IP.

You should see an HTML page with all the installed media thumbnails. 

3  Then browse to http://[Catalyst_IP]:8080/catws/Images/000_002.jpg. 

You should see the thumbnail for file 2 in folder 0. This verifies that the connection is OK 
and the thumbnails are accessible.

Now the media picker for the file and the folder parameters are available.

To patch Catalyst 

1  Patch the Catalyst layers in the Catalyst computer. 

Consult the Catalyst user’s guide for details.

2  Open the Vector Patch Manager.

3  Import the Catalyst v4.cvd device files located in the High End folder.

4  Create and patch Catalyst fixtures.

5  In the Name field enter the Catalyst computer IP address.

ATTENTION! 
To download thumbnails media server devices require exact names! Example: If Catalyst 
computer IP address is 2.0.0.5, the layer names must be 2.0.0.5_1, 2.0.0.5_2, 2.0.0.5_3, 
etc. Note that Vector automatically appends _* to the layers.

6  Save and exit the Patch Manager.
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4   MIDI

 4.1  MIDI tables

MIDI tables have been expanded. Of special interest are MIDI commands that trigger Vector 
console macros. Triggering Vector macros with one MIDI note allows you to operate a long and 
complex command strings without complicated and time-consuming MIDI programming.

Example: Trigger a macro that loads a QList to a playback device and operate the playback.

For the complete MIDI tables, consult the Vector Reference Guide, Appendix 2 Automated 
Playback.

 4.2  MSC

MIDI Show Control functionality has been improved and now it is fully functionally.

� Between Vector consoles macros 1 through 255 are available.

� Between a Vector console and a 4D or Sabre console 1 through 128 are available.

� Basic master playback control: Go, Hold, Timed Go, Resume.

MIDI notes for triggering console macros

Command Note On # Command Note Off #

MACRO 101  96 Macro 911 21

MACRO 102  97 Macro 912 22

MACRO 103  98 Macro 913 23

MACRO 104  99 Macro 914 24

MACRO 105  100 Macro 915 25

MACRO 106  101 Macro 916 26

Macro 901 115 Macro 917 27

Macro 902 116 Macro 918 28

Macro 903 117 Macro 919 29

Macro 904 118 Macro 911 21

Macro 905 119 Macro 920 33

Macro 906 120

Macro 907 121

Macro 908 122

Macro 909 123

Macro 910 124
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5   Patch

 5.1  DMX input patch
New procedure to clear the DMX input patch.

To clear the DMX input patch

1  Press DIM.

2  Select the dimmer number on the keypad.

Range selections are also valid.

 Or

To clear the entire DMX input patch, skip this step and continue with step 3.

3  Tap INPUT PATCH.

4  Tap CLEAR SELECTED/ALL.

The selection is cleared from the patch.

If there was no selection the entire DMX input patch is cleared.

5  For Enter syntax - Press ENTER.

 5.2  Matrix

You can select cells on the matrix and drag and drop fixtures to map them to the selected cells.

Note:  The cells are populated from left to right and from row 1 down.

To map fixtures to selected matrix cells. 

1  Tap N to put the Workspace tree in navigation mode;

2  Select the matrix from the Matrix List.

The matrix is displayed in the main patch pane.

3  Tap S to switch to selection mode.

4  Select fixtures from Matrix in the Sets node and drop them in the matrix cells. 

Figure 18: Mapping fixtures to selected cells
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 5.3  Playback input patch

Operate Vector playback devices through an external console. Allows access to all playback pages, 
including pages that are not currently active on the main console.

If your main Vector console has motorized faders, we recommend not working on the same page 
both on the main console and on the external console as you may encounter resistance on the 
motorized faders.

ATTENTION! If your console does not have the correct key (QLIST / PLAYBACK), 
please contact your local distributor.

To patch playback input 

1  Press DIM.

2  Select the DMX address.

A range can also be selected.

3  Tap INPUT PATCH TO.

4  Press PLAYBACK and specify the page and playback device number (#/#).

A range can also be selected.

 Or

Press PLAYBACK and specify the playback device number (#). 

The playback device(s) on the active page is selected. 

5  Press STORE.

OR 

1  Press DIM.

2  Tap INPUT PATCH TO.

3  Press the Select key for a playback device. 

4  Press STORE.

To release playback input patch

1  Press DIM.

2  Select the DMX address.

A range can also be selected.

3  Tap INPUT PATCH TO.

4  Press PLAYBACK and specify the page and playback device number (#/#).

5  Press RELEASE.

 Or
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On the Editor tool bar, tap CLEAR ALL.

OR 

1  Press DIM.

2  Tap INPUT PATCH TO.

3  Press the Select key for a playback device. 

4  Press RELEASE.

 Or

On the Editor tool bar, tap CLEAR ALL.

To patch playback input 

1  Press DIM.

2  Select the DMX address.

A range can be selected.

3  Tap INPUT PATCH TO.

4  Press PB and specify the page and playback device number (#/#).

A range can also be selected.

 Or

Press PLAYBACK and specify the playback device number (#). 

The playback device(s) on the active page is selected. 

5  Press ENTER.

OR 

1  Press DIM.

2  Select the DMX address.

3  Tap INPUT PATCH TO.

4  Press the Select key for a playback device. 

5  Press ENTER.

To release playback input patch

1  Press RELEASE.

2  Press DIM.

3  Select the DMX address.

A range can be selected.

4  Tap INPUT PATCH TO.

5  Press PB and specify the page and playback device number (#/#).

 Or
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Press PLAYBACK and specify the playback device number (#). 

The playback device(s) on the active page is selected. 

6  Press ENTER.

OR 

1  Press RELEASE.

2  Press DIM.

3  Select the DMX address.

4  Tap INPUT PATCH TO.

5  Press the Select key for a playback device. 

6  Press ENTER.

OR 

1  Press DIM.

2  Select the DMX input address.

3  Tap INPUT PATCH TO.

4  Press PB and specify the page and playback device number (#/#).

5  On the Editor tool bar, tap CLEAR ALL.

6  Press ENTER.

OR 

1  Press DIM.

2  Select the DMX input address.

3  Tap INPUT PATCH TO.

4  Press the select key for a playback device. 

5  Press RELEASE.

 Or

On the Editor tool bar, tap CLEAR ALL.

6  Press ENTER.
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6   Playback

 6.1  Flash indications

The flash level is shown in orange in the Fader Level field.

 6.2  Latch flash key

A latched flash key toggles the values in the current cue on or off. Flash keys always work in cut 
time.

The bottom key row, in the Playback Wing display, shows the latched flash keys’ indication.

Figure 19: Bottom key indication on the Playback Wing display

To latch flash keys

1  Press SETUP.

2  Press the select key for a playback.

The Playback Properties dialog box opens.

3  On the Playback Definitions tab, click the arrow to view the flash behavior options.
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Figure 20: Flash behavior options

4  Click LATCH.

5  Click CLOSE.

To operate latched flash keys

1  Press the flash key to output all parameter values in the current cue.

This turns on the dimmer also, regardless of the fader position.

2  Press again to turn off.

Values bump out.

 6.3  Master playback indication

The master playback display has green highlight and progress bars to differentiate it from the other 
playbacks.

 6.4  Playback wing displays

Each playback key has its own field. The playback key fields appear in the same order as the keys 
on the console.

Figure 21: Playback wing display

There are three options for the QList header display: 

� QList number and name

� Qlist number only

� Qlist name only.

Set headers in the Grid Properties dialog box.
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 6.5  Playback selection

Select playback devices and QKeys for global response to a control function. Selections can include 
AB, playback faders and QKeys.

Examples: 

� Select all the playback devices on page 1 and free them.

� Select all the playback devices on page 2 and give them a go command., even if the current 
page is on page 1.

� Apply Goto commands to the selected playback devices.

� Load a range of cues to the selected playback devices.

� Load a range of QLists to the selected playback devices. 

There are three ways to select playback devices:

� Directly using the Select keys, when selecting from the current page

� The console keys, where the first number is the page and the second number is the playback 
device.

� The Editor tool bar in playback selection mode.

Figure 22: Editor tool bar in playback selection mode

The Editor tool bar buttons in playback selection mode are:

The applicable playback control functions are:

� JOIN
� FREE
� ON

� .GO

� HOLD/BACK

�Q

� SOLO
� STEP

Button What it does

PLAYBACK Sets the keypad for playback device selection.

QKEY Sets the keypad for Qkey selection.

ALL PLAYBACKS Selects all playback devices (except AB).

ALL QKEYS Selects all QKeys. 

AB Selects AB.

LAST SELECTION (z) Recalls last playback selection.
Note: Another way to recall the last selection is pressing PB, z.
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� PB RELEASE

� TRIGGER is toggled on or off according to the state of the first playback device in the selec-
tion. Example: The selection is playbacks 2, 5, 7. TRIGGER is off for playbacks 2 and 7; 
playback 5 has trigger on. Pressing TRIGGER turns it on for the entire selection.

� SEQ is toggled on or off according to the state of the first playback device in the selection. 
Example: The selection is playbacks 2, 5, 7. SEQ is off for playbacks 2 and 7; playback 5 has 
trigger on. Pressing SEQ turns it on for the entire selection

� PRIO affects only the first playback device in the selection.

The selection remains available until manually cleared by:

� Selecting a fixture

� Pressing SHIFT + CE

� Pressing SHIFT+ RESET

To select and operate playbacks

1  Tap PLAYBACK on the Editor tool bar or press PB.

The Editor tool bar switches to playback selection mode.

PB is displayed in the command line.

2  All selection sequences (# J #, # + #, # - #) can be used for the current page. Use the #/# 
syntax to select playback devices on other pages.

 Or

Use the selection options on the Editor tool bar.

 Or

Press the Select key for playback devices. Pressing and holding Ctrl (on the external 
keyboard) allows you select multiple playback devices.

 Or

Select playback devices by page number and playback number. Example: (page) 2 / 5 
(playback device).

3  Press a playback control.

 6.6  Goto time

Specify time-in when fading to a selected cue on the master playback and other playback devices. 

To specify a fade time on the master playback

1  Press GOTO.

2  Select a cue number.

Important! Do NOT press CUE, just enter the cue number.

3  Press TIME.

4  Specify the fade time.

5  Press ENTER.
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The fade to the selected cue begins.

To specify a fade time on the playback devices

1  Press GOTO.

2  Select a cue number.

Important! Do NOT press CUE, just enter the cue number.

3  Press TIME.

4  Specify the fade time.

5  Press the Select key for the playback device.

The fade to the selected cue begins.

7   Show file conversion

 7.1  Sabre & 4D file names

The names of show files that were converted from Sabre and 4D consoles, specify the source of the 
converted file.

For Sabre shows, the show file number is preceded by the letter ’C’. Example: Tosca_C0010.

For 4D shows, the show file number is preceded by the letter ’V’. Example: Tosca_V0010.

8   System Settings

 8.1  Art-Net

When Art-Net is enabled, the Subnet setting defaults to 0.

 8.2  Operation mode and syntax settings

Compulite mode and Action syntax are automatically set in the Behavior tab when loading shows 
converted from Sabre or 4D. 

 8.3  System Settings tabs

The Communication tab has been replaced by three new tabs:

� DMX Protocol

� MIDI/SMPTE.

� Network
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DMX Protocols tab

Group Fields/buttons What it does Default

Accurate configuration of the VC and Art-Net output of the console helps to reduce network traffic and uses 
less system resources.

DMX-over-
Ethernet

Virtual Connectors VC’s • On - Virtual connector transmission (DMX over 
Ethernet) is enabled.

• Off - Virtual connector transmission (DMX over 
Ethernet) is disabled.

On

VC Compression • On - VC compression is enabled. 
• Off - VC compression is disabled.

Off

Art-Net Communication over Art-Net protocol enabled

Art-Net Subnet Set the Art-Net IP subnet.
Note: Generally the Art-Net IP subnet on Art-Net 
devices, such as media servers, is set to the same 
IP subnet as Vector.

DMX Input • On - The console responds to DMX512 input.
• Off - The console does not respond to DMX512 

input.

Max Transmission Rate 
(Hz)

Regulate the rate at which DMX over Ethernet is 
transmitted. The available range is 25 - 40 Hz.
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Network tab

Group Fields/buttons What it does Default

Console 
Identifiers

Network ID The network ID number appears in this field.

Console ID The console ID number appears in this field.

Multi User 
Mode

Node • On - The console or Vector Node operates as a 
node.

• Off - The console is not designated as a node.

Off

Slave • On - The console or Vector Node operates as a 
slave console.

• Off - The console is not a slave console.

Off

Master Console ID The master console through its ID number.
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MIDI/SMPTE tab

Group Fields/buttons What it does Default

MIDI MIDI • On - MIDI over Ethernet is enabled.
• Off - MIDI over Ethernet is disabled.

On

MIDI Keys • On - Vector can receive MIDI notes transmitted 
by an outside source.

• Off - Vector does not receive MIDI notes 
transmitted by an outside source.

MIDI Macro • On - Storing MIDI macros is permitted.
• Off - Storing MIDI macros is not permitted.

MIDI Channel Set the MIDI channel

MIDI Code Offset

MSC Enable/disable MSC (over Ethernet) On

MSC Device ID Set the MSC device ID. This is the (device) 
console receiving the MIDI commands.

MSC Group ID Set the MSC group ID. 

MSC Peer ID Set the MSC peer ID. This is the (device) console 
sending the MIDI commands.

Frames per Second 
(SMPTE)

Set the frames per second value for SMPTE opera-
tion.
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 8.4  Timing

Default system time is automatically entered in the Time field if the CUT button is disabled.

9   Topo

 9.1  Topo

The zoom and show/hide grid tools are always available on Topo views.

There is now an icon for stage element: .

To change stage element text

1  Tap a stage element.

The stage element is now selected and displayed within a rectangle.

2  Right click inside the selection rectangle and, from the shortcut menu, choose Properties.

The Topo Element dialog box opens.

Figure 23: A stage element and the Topo Element dialog box

3  Type a name in the Name field.

4  Tap OK.

The dialog box closes. The stage element’s name appears above it on the Topo display.

To show/hide stage element and fixture names

1  Tap a stage element.

The stage element is now selected and displayed within a rectangle.

2  Right click inside the selection rectangle and, from the shortcut menu, choose Properties.

The Topo Element dialog box opens.

3  Check Show Element Name or Show Fixture Names check boxes to show the names on the 
Topo display. 

To hide the names remove the check.



46

Vector
Operating New Features

10   Vector PC

10.11  Command line indications

If the panel is disconnected an indication is displayed in the command line.

 11.1  Hot keys

Some laptops have a graphic card that uses ALT+CRTL+F1 to toggle through screens when 
multiple screens are open. For this hotkey sequence to be available on Vector PC, disable them in 
the graphic card settings.

 11.2  Messages
Attempting to close the editor simulator panel or real time generates a warning message.

Figure 24: Disconnect warning message



Keyboard map for console keys

t

Editor section

Console key Keyboard

+ + (Plus)

- - (Minus)

J (through) * (asterisk)

Q Ctrl + R

z (dot) z (dot)

SHIFT + z Shift + z 

@ @

/ (slash) / (slash)

0 through 9 0 through 9

ACTIVE A

ACTIVE ALL Shift + A

BLIND Shift + B

SHIFT + BLIND Shift + Alt + B

CE Backspace

SHIFT + CE Shift +   Backspace

CHANNEL C

COPY Ctrl + C

CUE Q

CUT Ctrl + X

DELETE Del / Delete

DIM (mer) D

Dimmer Wheel Ctrl + < >

EDITORS Ctrl + E 

EFFECT E

ENTER ENTER 

EXAM X

FAN Ctrl + F 

FULL F

GROUP G

HIGHLIGHT H 

JOIN J

LIBRARY Ctrl + L

LOWLIGHT Shift + H 

M(acros) 101 J 106 Alt + Ctrl + F1 J F6

MACRO M 

MATRIX Alt + S

MEDIA SERVER Ctrl + M

NEXT Page up

ON (param value) Shift + O

PARK Shift + K 

PASTE Ctrl + V

PB Shift + L

PREV(ious) Page down

QLIST L

REDO Ctrl + Y

RELEASE END

SHIFT + RELEASE Shift + End

RESET ESC

SHIFT + RESET Shift + ESC

SET Shift + S

SETUP Shift + U

SHIFT SHIFT

SHIFT +TIME (time line) Shift + T

SNEAK K 

SPOT S

STAGE Ctrl + T

STORE R

STORE+ Alt + R

TEACH MACRO Shift + M 

TEXT Shift + T

Editor section

Console key Keyboard



Keyboard map for console keys

TIME T

UNDO Control + Z

UPDATE U

SCROLLWIN Scroll lock

ZERO Z

Playback keys and controls

Console key Keyboard

B.O. Alt + Ctrl + Esc 

FREE F12

SHIFT + FREE Shift + F12

ON O

PB's 1 J10 Alt + Ctrl + F1 J F10

PB PAGE DOWN Alt + Page Down 

PB PAGE UP Alt + Page Up 

PB RELEASE Ctrl + P 

SHIFT + PB RELEASE Shift + Ctrl + P 

PB/QK DISPLAY Alt + Scroll Lock 

PRIORITY Insert

RATE ~ (tilda)

SHIFT + RATE Shift + ~ (tilda)

SEQUENCE Ctrl + Q

SOLO Ctrl + O

STEP Shift + P

SUB MASTER Ctrl + B

TRIGGER Shift + G

||/` Pause

SHIFT +||/` Shift + Pause

W  X  (change direction) Ctrl + D

Editor section

Console key Keyboard

SNAP Shift + N

SHIFT + SNAP GO Shift + PageDown

SNAP GO Shift + PageUp

Playback (fader and AB) controls

PB (Fader Mode) Window key + P

Rate (Fader Mode) Window key + ~

Channel (Fader Mode) Window key + C

Param (Fader Mode) Window key + R

Select PB's 1 J 10 Alt + F1 J F10

GO PB's 1 J 10 Ctrl + F1 J F10

HOLD/BACK PB 1J 10 Ctrl + 1 J 10

Flash PB keys 1 J 10 Alt + 1 J 0

GOTO WinKey + Space 

Select QKeys Alt +Shift + F1 J F10

Qkeys playback control Shift + F1 J F10

Select AB Alt + Ctrl + F11

Go AB Ctrl + F11

Hold/Back AB Alt + F11

Master Playback controls

GO (master playback) Space

HOLD (master pb) Alt + Space

BACK (master pb) Ctrl + Space

Select A/B Alt + F11

GO A/B F7 

HOLD/BACK (A/B) F8

Playback keys and controls

Console key Keyboard
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Parameter control

Console key Keyboard

BEAM B

COLOR O

HOME Home

IMAGE V 

INTENSITY I

Lock X Alt + X

Lock Y Alt + Y

PAN WX

Parameter key 1 Ctrl + Shift + 1

Parameter key 2 Ctrl + Shift + 2

Parameter key 3 Ctrl + Shift + 3

Parameter key 4 Ctrl + Shift + 4

Parameter key 5 Ctrl + Shift + 5

Parameter wheel 1 Window key + 1 S
Window key + Q T

Parameter wheel 2 Window key + 2 S
Window key + W T

Parameter wheel 3 Window key + 3 S
Window key + E T

Parameter wheel 4 Window key + 4 S
Window key + R T

Parameter wheel 5 Window key + 5 S
Window key + T T

POSITION P

SHAPE N

TILT ST  

Display navigation

Console key Keyboard

Arrow left Shift + W

Arrow right Shift + X

Arrow up Shift + S

Arrow down Shift + T



MIDI tables
These MIDI tables are arranged according to MIDI note numbers.

MIDI Note On table 

Command Note On #

(not used) 0

DELAY (tool bar) 1

RELEASE 2

TIME 3

Macro 913 4

(not used) 5

SUB(MASTER) 6

FREE 7

CLEAR 8

REM DIM (tool bar) 9

J (thru) 10

EDITOR FADE (tool bar) 11

X  and NEXT 12

W  and PREV 13

FLASH (Fixture Test /tool bar) 14

ENTER 15

z 16

2 17

5 18

8 19

9 20

6 21

3 22

CE 23

(not used) 24

ZR 25

ON 26

FL 27

7 28

4 29

1 30

0 31

STORE 32

FAN 33

TIME LINE 34

TEXT 35

DELETE 36

LOOP (tool bar) 37

EDITOR 38

STORE+ 39

CUE 40

SPOT 41

EFFECT 42

UNDO 43

REDO 44

PASTE 45

DIMMER 46

RESET 47

CHANNEL 48

LINK (tool bar) 49

EXAM 50

STAGE 51

BLIND 52

COPY 53

SNAP GO (protect - pb faders) 54

MIDI Note On table (continued)

Command Note On #



@ 55

PB RELEASE 56

MACRO 106 57

MACRO 105 58

MACRO 104 59

MACRO 103 60

MACRO 102 61

MACRO 101 62

SETUP 63

PB/QKEY 64

(master pb) GO 65

(master pb) HOLD 66

(master pb) BACK 67

GOTO 68

SEQ (PB control) 69

SELECT AB 70

(not used) 71

P key 1
(see, Figure 1 p.53)

73

P key 2
(see, Figure 1 p.53)

74

P key 3
(see, Figure 1 p.53)

75

AB (right key) 76

AB (left key) 77

 (not used) 78

P key 4 79

PB (fader mode) 80

 PB RATE (fader mode) 81

CHANNEL (pb mode) 82

MIDI Note On table (continued)

Command Note On #

SHAPE 83

P key 4 
(see, Figure 1 p.53)

84

P key 5 
(see, Figure 1 p.53)

85

P key 6
(see, Figure 1 p.53)

86

P key 7
(see, Figure 1 p.53)

87

TEACH MACRO 88

SHIFT + / (slash) 89

 SHIFT+ RESET 90

/ (slash) 91

SHIFT + II W(Back/Hold All) 92

P key 9
(see, Figure 1 p.53)

93

PARK (SHIFT + SNEAK) 94

P key 10 
(see, Figure 1 p.53)

95

MATRIX 96

Macro 901 97

Macro 902 98

Macro 903 99

Macro 904 100

Macro 905 101

Macro 906 102

LOCK X 103

LOCK Y 104

Macro 907 105

Macro 908 106

Macro 909 107

Macro 910 108

MIDI Note On table (continued)

Command Note On #



+@ (tool bar button) 109

SET 110

Macro 911 111

Macro 912 112

PB (SHIFT + QLIST) 113

B.O. 114

SHIFT+ ACTIVE 115

Deselect (SHIFT + z) 116

COLOR 117

Macro 914 118

Macro 915 119

+ 120

Macro 916 121

Macro 917 122

Macro 918 123

Macro 919 124

Macro 920 125

RATE 126

CONTROL (tool bar) 127

MIDI Note On table (continued)

Command Note On #



Figure 1: P keys (Vector Red, Vector Blue, and Vector PC) and their MIDI Notes 

Figure 2: Playback device keys and QKeys are described in the MIDI tables by their location (Top, Middle, Bottom) 



MIDI Note Off table 

Command Note Off#

(not used) 0

CUT (SHIFT + COPY) 1

UPDATE 2

SHIFT + FREE (Free All) 3

SHIFT + PB RELEAS 
(PB Release All)

4

HOME 5

INTENSITY 6

BEAM 7

Bottom key PB 10 off 8

SELECT (playback 1) 9

SELECT (playback 2) 10

SELECT (playback 3) 11

SELECT (playback 4) 12

SELECT (playback 5) 13

SELECT (playback 6) 14

SELECT (playback 7) 15

SELECT (playback 8) 16

SELECT (playback 9) 17

SELECT (playback 10) 18

SELECT QKey 1 19

SELECT QKey 2 20

SELECT QKey 3 21

SELECT QKey 4 22

SELECT QKey 5 23

SELECT QKey 6) 24

SELECT (QKey 7) 25

SELECT (QKey 8) 26

SELECT (QKey 9) 27

SELECT (QKey 10) 28

SCROLL WIN 29

S(PB page up) 30

T(PB page down) 31

HIGHLIGHT 32

LOWLIGHT 33

GROUP 34

QLIST 35

ACTIVE 36

Top key PB 4 37

Top key PB 5 38

Top key PB 6 39

Top key PB 7 40

Top key PB 8 41

Top key PB 9 42

MOUSE 43

(not used) 44

Bottom QKey 2 45

Bottom QKey 3 46

Bottom QKey 4 47

Bottom QKey 5 48

Bottom Q key 6 49

S(STEP UP) (tool bar) 50

T(STEP DOWN) (tool bar) 51

Top key PB10 52

Bottom QKey 7 52

Bottom QKey 8 54

IMAGE 55

(not used) 56

Bottom QKey 1 57

MIDI Note Off table (continued)

Command Note Off#



Bottom QKey 9 58

Bottom QKey 10 59

Top key PB1 60

Top key PB2 61

Top key PB3 62

Middle key PB1 63

Middle key PB2 64

Middle key PB3 65

Middle key PB4 66

Middle key PB5 67

Middle key PB6 68

Middle key PB7 69

Middle key PB8 70

Middle key PB 9 71

Middle key PB 10 72

Bottom key PB 1 73

Bottom key PB 2 74

Bottom key PB 3 75

Bottom key PB 4 76

Bottom key PB5 77

Bottom key PB 6 78

Bottom key PB 7 79

Bottom key PB 8 80

Bottom key PB 9 81

Bottom key PB 10 82

Bottom key PB 1off 83

Bottom key PB 2 off 84

Bottom key PB 3 off 85

Bottom key PB 4 off 86

MIDI Note Off table (continued)

Command Note Off#

Bottom key PB 5 off 87

Bottom key PB 6 off 88

Bottom key PB 7 off 89

MACRO 90

Bottom key PB 8 off 91

Bottom key PB 9 off 92

SELECT PB 1off 93

SELECT PB 2 off 94

SELECT PB 3 off 95

SELECT PB 4 off 96

SELECT PB 5 off 97

- @ (tool bar button) 98

SELECT PB 6 off 99

SELECT PB 7 off 100

SELECT PB 8 off 101

SELECT PB 9 off 102

SNAP GO 103

SELECT PB 10 off 104

SELECT QKey 1 off 105

SELECT QKey 2 off 106

SELECT QKey 3 off 107

SELECT QKey 4 off 108

SELECT QKey 5 off 109

SELECT QKey 6 off 110

SELECT QKey 7 off 111

(not used) 112

SOLO 113

LIB 114

POSITION 115

MIDI Note Off table (continued)

Command Note Off#



LIB (tool bar) or
SHIFT +LIB

116

PB PARAM (fader mode) 117

SELECT QKey 8 off 118

SELECT QKey 9 off 119

SELECT QKey 10 off 120

SNEAK 121

(not used) 122

SNAP 123

- (minus) 124

(not used) 125

SHIFT + SNAP GO 126

(not used) 127

MIDI Note Off table (continued)

Command Note Off#

MIDI Control Change table 

Command Control 
change

(not used) 0

Bottom QKey 1 off 1

Bottom QKey 2 off 2

Bottom QKey 3 off 3

Bottom QKey 4 off 4

Bottom QKey 5 off 5

Bottom QKey 6 off 6

Bottom QKey 7 off 7

Bottom QKey 8 off 8

Bottom QKey 9 off 9

Bottom QKey 10 off 10

Top key PB1 off 11

Top key PB2 off 12

Top key PB3 off 13

Top key PB4 off 14

Top key PB5 off 15

Top key PB6 off 16

Top key PB7 off 17

Top key PB8 off 18

Top key PB9off 19

Top key PB10 off 20

Middle key PB1 off 21

Middle key PB2 off 22

Middle key PB3 off 23

Middle key PB4 off 24

Middle key PB5 off 25

Middle key PB6 off 26

Middle key PB7 off 27

Middle key PB8 off 28



Middle key PB9 off 29

Middle key PB10 off 30

MOVE 31

SHIFT + GO (PB 
control) 

32

GO (PB control) 33

ON (PB control) 34

PB RELEASE off 35

PB controls OFF (except 
PB RELEASE) 

36

PRIO 37

JOIN 38

STEP 39

Q (PB control) 40

 II W  (PB control) 41

SHIFT + BLIND 42

MEDIA SERVER 43

MIDI Control Change table (continued)

Command Control 
change

MIDI Note ON for triggering CONSOLE MACROS 

Command Control change

MACRO 101 62

MACRO 102 61

MACRO 103 60

MACRO 104 59

MACRO 105 58

MACRO 106 57

Macro 901 97

Macro 902 98

Macro 903 99

Macro 904 100

Macro 905 101

Macro 906 102

Macro 907 105

Macro 908 106

Macro 909 107

Macro 910 108

Macro 911 111

Macro 912 112

Macro 913 4

Macro 914 118

Macro 915 119

Macro 916 121

Macro 917 122

Macro 918 123

Macro 919 124

Macro 920 125

For more information about.



MIDI Notes for triggering 
PLAYBACK CONTROLS

Command

FREE MIDI On 7

SUB(MASTER) MIDI On 6

PB RELEASE MIDI On 56

SEQ MIDI On 69

TRIGGER MIDI On 72

AB (right key) MIDI On 76

AB (left key) MIDI On 77

SHIFT + II W(Hold All) MIDI On 92

SHIFT + FREE MIDI Off 3

SHIFT + PB RELEAS MIDI Off 4

SHIFT + GO Control Change 22

GO Control Change 33

ON Control Change 34

SHIFT + PB RELEAS off Control Change 35

PB controls OFF (except 
PB RELEASE) 

Control Change 36

PRIO Control Change 37

JOIN Control Change 38

STEP Control Change 39

Q Control Change 40

 II W Control Change 41

For more information about.

MIDI Notes for triggering 
MASTER PLAYBACK CONTROLS

Command

GO MIDI On 65

HOLD MIDI On 66

BACK MIDI On 67

For more information about.
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